Matrox RT.X2
User Guide
June 16, 2009
Contents

Chapter 1
Introducing Matrox RT.X2
   Welcome to Matrox RT.X2...............................................................2
   About this manual ............................................................................2
   Style conventions...................................................................................2
   How video formats are expressed .......................................................3
   Other documentation...........................................................................3

Chapter 2
Calibrating Your DVI Monitor for Video
   Overview ..........................................................................................6
   Loading and displaying color bars ...................................................6
   Calibrating your DVI monitor ............................................................8

Chapter 3
Working with .mxf, .mp4, and .avi Files
   Working with native .mxf files in Adobe Premiere Pro
   and After Effects........................................................................... 12
   Steps for using .mxf files in your projects .........................................12
   Working with native XDCAM EX (.mp4) files in
   Adobe Premiere Pro......................................................................... 13
   Displaying information for clips in Windows Explorer .................... 14
   Thumbnails preview ............................................................................. 14
   Additional file details in Windows XP ................................................... 14
   Creating Matrox EZ-MXF files for playback with
   VFW applications............................................................................. 15
   Panasonic P2 folder structure............................................................. 16
   Creating Matrox EZ-HDV AVI files for playback of
   large HDV clips with VFW applications............................................17
   Converting a 32-bit .tga sequence to an .avi file with alpha ........... 18

Chapter 4
Defining Your Adobe Premiere Pro Settings
   A note about running other programs with Adobe Premiere Pro..22
   Don’t use the Windows Vista Aero color scheme .............................22
Setting your system’s volume levels ......................................................... 22
  For Windows Vista.................................................................................. 22
  For Windows XP .................................................................................. 23
Creating a new Matrox project ............................................................... 24
Defining your player settings.................................................................. 25
Displaying warnings in Adobe Premiere Pro’s Events panel ................. 25
Mixing interlaced and progressive clips in a sequence ..................... 25
Mixing SD and HD clips in a sequence .............................................. 26
Defining your sequence settings ............................................................ 27
  Specifying your general settings ......................................................... 27
  Specifying your video output settings ................................................. 31
  Selecting your DV-1394 output settings ............................................. 33
  Defining your video preview settings .................................................. 34
Defining your capture settings ............................................................... 35
  Specifying your video capture settings .............................................. 35
  Specifying your audio capture settings .............................................. 37
  Notes about capturing to Matrox .m2v files ....................................... 41
Capturing HDV material on Matrox RT.X2 SD ...................................... 42
Exporting to a Matrox .avi file .............................................................. 43
Selecting your MPEG-2 I-frame settings ............................................. 47
Selecting your MPEG-2 IBP settings ................................................... 49
Setting up Matrox DV/HDV device control ......................................... 51
Exporting your sequence to tape ........................................................ 52
  Preparing your tapes for recording .................................................... 52
  Avoiding missing frames when exporting to DV tape ....................... 52
  Exporting to DV tape using DV-1394 device control ....................... 53
Creating an SD project in 16:9 format ............................................... 54

Chapter 5
Setting Up Realtime Effects with Adobe Premiere Pro
Available effects .................................................................................. 56
How to apply a Matrox video effect in Adobe Premiere Pro.............. 57
How to apply a Matrox video transition in Adobe Premiere Pro ... 57
Transforming your clip ........................................................................ 58
Using the transform controls ...............................................................58
Transforming a clip in the Program Monitor ......................................60
Cropping your clip ........................................................................ 61
Using Select Crop ................................................................................62
Applying a mask to your effect ......................................................63
Using Select Mask ...............................................................................64
Creating a primary color correction...............................................65
Using Split View ...................................................................................67
Working with Split View in the Program Monitor ............................67
Using RGB curves ............................................................................69
Adjusting tonal range .......................................................................71
Using the color balance graph .......................................................72
Performing an auto balance ...............................................................75
Matching colors between two clips .............................................76
Using the luma mapping graph .....................................................78
Creating a secondary color correction ........................................80
Using the selective key graph ...........................................................85
Creating a color pass effect .............................................................90
Creating a 3D DVE effect .............................................................. 91
Creating a 4-corner pin effect ..........................................................94
Creating a blur/soft focus effect .....................................................96
Overview of the chroma key effects ..............................................97
Creating a chroma key or chroma key shadow effect ..................98
Using the chroma key graph to modify key colors and perform an auto key .................................................................101
Creating a cube effect ......................................................................104
Creating a crystallize effect ...........................................................107
Creating a garbage matte effect ....................................................109
Creating an impressionist effect ...................................................111
Creating a lens flare effect .............................................................114
Overview of the luma key effect ....................................................116
Creating a luma key effect .............................................................117
Using the luma key graph ..............................................................118
Contents

Creating a mask effect .................................................................120
Creating a mask blur effect ..........................................................122
Creating a mask mosaic effect ....................................................124
Creating a move & scale effect ....................................................126
Creating an old movie effect ........................................................128
Creating a page curl effect ..........................................................132
Creating a pan & scan effect ........................................................134
Creating a ripple effect ...............................................................136
Creating a shadow effect ............................................................138
Creating a shine effect ...............................................................140
Creating a sphere effect .............................................................144
Creating a surface finish effect ..................................................146
Creating a track matte effect .....................................................149
Creating a twirl effect ...............................................................151
Creating a wipe transition .........................................................152
Using the Matrox chroma clamper effect ....................................154
Selecting your speed control method ..........................................154
About Adobe Premiere Pro’s fixed effects ....................................154
Matrox RT.X2 realtime guidelines ................................................155
Supported graphics formats ........................................................156
Limitations ..................................................................................156

Chapter 6
Using Matrox RT.X2 with Video for Windows Programs
Overview .....................................................................................158
Using VFW programs without the RT.X2 hardware ......................158
Before you start rendering ........................................................159
Selecting color space conversion options ....................................160
Rendering material to a Matrox VFW .avi file ...............................162
Configuring the Matrox MPEG-2 I-frame codecs .........................163
Exporting to a Matrox VFW .avi file using Adobe Premiere Pro ...165
Chapter 7
Using the Matrox WYSIWYG Plug-ins

Overview ...................................................................................... 168
Configuring the Matrox WYSIWYG Control Panel ......................... 168
Required steps to use the WYSIWYG plug-ins ............................ 170
  Adobe After Effects ........................................................................ 170
  Adobe Photoshop ........................................................................... 170
  Autodesk 3ds Max ......................................................................... 170
  Autodesk Combustion .................................................................... 170
  eyeon Fusion ................................................................................ 170
  NewTek LightWave 3D .................................................................. 171

Chapter 8
Monitoring Your Matrox RT.X2 System

Using X.info to display RT.X2 information .................................... 174
  Displaying system information ...................................................... 174
  Displaying hardware information .................................................. 176
  Monitoring your RT.X2 card’s operating temperatures .................... 177
  Enabling and disabling the Matrox hardware-accelerated effects
    in Adobe Premiere Pro .............................................................. 177
  Error notification .......................................................................... 177

Appendix A
Understanding Standard and Advanced Pulldown

Overview ...................................................................................... 180
Standard 2:3 pulldown ..................................................................... 180
  Matrox RT.X2 implementation of standard reverse pulldown ........... 181
Advanced 2:3:3:2 pulldown ............................................................ 181
  Matrox RT.X2 implementation of advanced reverse pulldown .......... 182

Appendix B
Matrox RT.X2 Workflows

Overview ...................................................................................... 184
Working with SD “24P” material ...................................................... 184
  486p @ 23.98 fps workflow example ............................................. 185
Working with HD sequences ......................................................... 186
Contents

1440x1080i/p workflow example .......................................................... 187
720p workflow example ..................................................................... 188
Capturing HDV and SD material to edit in SD on Matrox RT.X2 ... 189
Capturing HDV and SD material on Matrox RT.X2 SD ................. 190
Using the Matrox MPEG-2 I-frame HD codec .............................. 191
MPEG-2 I-frame HD codec workflow example for offline editing .... 191
MPEG-2 I-frame HD codec workflow example for online editing .... 193
Using Matrox RT.X2 to edit Matrox Axio offline HD projects ....... 194
Supported video compression formats ............................................. 195
Supported master output formats ................................................... 196

Appendix C
Matrox RT.X2 Customer Support
Getting the most support ............................................................... 198
Registration ................................................................................... 198
Keep up to date with our website .................................................. 198
Contacting us ............................................................................. 198

Appendix D
Matrox RT.X2 Glossary
Glossary of terms ........................................................................ 200

Index .............................................................................................. 213
1

Introducing Matrox RT.X2

This chapter provides an overview of Matrox RT.X2, and describes the available Matrox RT.X2 documentation.
Welcome to Matrox RT.X2

Matrox RT.X2 products let you get maximum productivity from Adobe Premiere Pro, and are ideal for corporate communicators, event videographers, project studios, educational facilities, and digital filmmakers. Matrox RT.X2 SD is for users who want to deliver in SD only, while Matrox RT.X2 and RT.X2 LE give you the flexibility to edit, view, and output HDV and SD material. For details on all the Matrox RT.X2 products, see the Matrox Video website at www.matrox.com/video.

About this manual

This manual explains how to use Matrox RT.X2 with the provided Matrox software, including how to use your RT.X2 system with Adobe Premiere Pro.

Note Throughout the Matrox RT.X2 documentation, the term “RT.X2” refers to RT.X2, RT.X2 LE, and RT.X2 SD, unless indicated otherwise.

Style conventions

The following style conventions are used in this manual:

• When an operation is different between Windows Vista and Windows XP, the operating system is displayed in brackets after the operation. For example, right-click Computer (Vista) or My Computer (XP).

• The names of files, directory paths, and manuals appear in italics. For example:
  – The data is stored in the sample.wav file.
  – The file is located in your C:\Windows\System directory.
  – Please refer to your Matrox RT.X2 Installation Manual.

• Menus and commands that you need to choose are displayed in the form Menu > Command. For example, File > Save means click File in the menu bar, then click Save in the menu that appears.

• The names of keys are displayed in small capital bold letters, such as the CTRL key.

• A plus (+) sign is used to indicate combinations of keys and/or mouse operations. For example:
  – CTRL+C means to hold down the CTRL key while pressing the C key.
  – SHIFT+click means to hold down the SHIFT key while you click an item with the mouse.
How video formats are expressed
With the exception of NTSC and PAL, all SD and HD video formats are expressed in the Matrox RT.X2 documentation and dialog boxes as follows:

VRp or i @ n fps

Where:

- **VR** is the vertical resolution. For 1440×1080 video, however, both the horizontal and vertical resolutions are specified.
- **p** or **i** represents either progressive or interlaced video.
- **@ n fps** is the frame rate in frames per second.

Here are some examples:

- **486p @ 23.98 fps** Represents 720×486 progressive video at 23.98 frames per second.
- **720p @ 59.94 fps** Represents 1280×720 progressive video at 59.94 frames per second.
- **1440x1080i @ 29.97 fps** Represents 1440×1080 interlaced video at 29.97 frames per second. This format is used for HDV 1080i material.
- **1080i @ 29.97 fps** Represents full-size 1920×1080 interlaced video at 29.97 frames per second.

Other documentation
In addition to this user guide, the following Matrox RT.X2 documents are available:

- **Matrox RT.X2 Quick Installation Guide** Provides brief installation instructions to help you quickly set up your Matrox RT.X2 system.
- **Matrox RT.X2 Installation Manual** Provides detailed instructions for installing your Matrox RT.X2 hardware and software, including how to connect your external devices to the RT.X2 breakout box.
- **Matrox RT.X2 Release Notes** Provides any important last-minute information and known issues.
Your notes
Calibrating Your DVI Monitor for Video

This chapter explains how to calibrate your Matrox RT.X2 DVI monitor to display SD and HD video.
Overview

Note This chapter does not apply to RT.X2 LE or RT.X2 SD.
Matrox RT.X2 turns your DVI monitor into a true-color video display for use with SD and HD video. Controls for hue, chroma, contrast, brightness, and blue-only let you adjust and control your DVI monitor exactly as you would a broadcast HD/SD video monitor.

Important RT.X2’s DVI output supports 1:1 pixel mapping for accurate monitoring of SD and HD video. However, your DVI monitor must support a display resolution of 1920×1200 to preview all HD formats, and an aspect ratio of 1:1 (“dot-by-dot” mode) for 1:1 pixel mapping.

DVI monitor calibration requires you to:
1 Load and display NTSC, PAL, or HD color bars on your DVI monitor.
2 Calibrate your DVI monitor using RT.X2’s proc amp controls.

Loading and displaying color bars
Color bars are used to calibrate your DVI monitor. These instructions describe how to load Matrox RT.X2 HD and SD color bars using the Matrox RT.X2 DVI Monitor Calibration program. However, you can also load and output color bars using Adobe Premiere Pro or any program that is supported by the Matrox WYSIWYG plug-ins. For details on the supported programs and configuring your Matrox WYSIWYG output settings, see Chapter 7, “Using the Matrox WYSIWYG Plug-ins.”

To load and display color bars using the Matrox RT.X2 DVI Monitor Calibration program:
1 Ensure that your DVI monitor is connected to the DVI output on your RT.X2 card (see your Matrox RT.X2 Installation Manual), turn the DVI monitor on, and allow it to warm up for about 20 or 30 minutes.
2 Right-click the icon on your Windows taskbar, and choose Matrox RT.X2 DVI Monitor Calibration.

Note If you don’t see the icon, choose Start > All Programs > Matrox Mx.tools > Matrox WYSIWYG Control Panel.
3 Click **Load Graphic**.

4 Depending on the video standard for which you want to calibrate your DVI monitor, select a Matrox NTSC, PAL, or HD color bars graphic, and then click **Open**.

   **Note** The color bars are usually located at `C:\Program Files\Matrox Mx.tools\Monitor Calibration Files`.

5 Right-click the **Monitor** icon on your Windows taskbar, and configure your Matrox WYSIWYG output settings as follows:

   - **Enable WYSIWYG Output** must be selected.
   - **Project Format** Select the format that matches the Matrox color bars graphic that you selected. For example, if you’re using the *Calibration color bars HD 1080.mgf* graphic, you can select any of the **1080** options.
   - **Output Format** Make sure the format matches what you chose for the project format.
   - **Preview Type** Select **Video**.
   - **Scaling** Select **Original Size**.

   **Note** Make sure that your DVI monitor’s aspect ratio is set to 1:1 ("dot-by-dot" mode).

For more information about using the WYSIWYG Control Panel, see “Configuring the Matrox WYSIWYG Control Panel” on page **168**.

6 With the color bars visible on your DVI monitor, calibrate your DVI monitor as explained in the next section.
Calibrating your DVI monitor

Use the RT.X2 proc amp controls in the Matrox RT.X2 DVI Monitor Calibration dialog box to adjust and control your DVI monitor’s color temperatures for accurate color grading and monitoring of SD and HD video.

1. Load and display color bars on your DVI monitor as explained in the previous section.

2. If the Matrox RT.X2 DVI Monitor Calibration dialog box is not presently open, right-click the icon on your Windows taskbar, and choose Matrox RT.X2 DVI Monitor Calibration.

3. Click Load Factory Default, and ensure that the Blue only option is cleared.

4. Drag the Chroma slider all the way to the left so that the color bars are shades of black and white.

5. Set the proper black level by adjusting the Brightness control and looking at the three pluge bars (see Figure 1 on page 10). The middle and left pluge bars should be black and blend into one another, with no visible dividing line between them, and the right pluge bar should be a barely-visible dark gray bar as shown below:

Chapter 2, Calibrating Your DVI Monitor for Video
Calibrating your DVI monitor

**Note** The room lighting may affect your perception of this setting. Therefore, you may need to readjust the **Brightness** setting if the room lighting changes.

6 To set the proper white level, move the **Contrast** slider all the way up, and then back down until the white bar (see Figure 1 on page 10) just begins to change. The correct setting is the point just before the white bar goes from pure white to showing a hint of gray. You’re now ready to calibrate the colors.

7 Set **Chroma** to its midpoint setting of 1.00.

8 Select **Blue only** to remove the red and green elements from the color bars. The color bars should now be alternating bars of gray and black (see Figure 2 on page 10).

**Note** You can also use the **Blue only** option to check for noise in a video clip.

9 Adjust the **Hue** control until the two middle gray bars are the same shade as their sub-bars (see Figure 2 on page 10).

10 Adjust the **Chroma** control until the two outer gray bars are the same shade as their sub-bars (see Figure 2 on page 10). The four gray bars and their sub-bars should be of equal intensity, and the three black bars and their sub-bars should be completely black.

11 Clear the **Blue only** option.

12 If you’re satisfied with the proc amp settings and you want to save them as your default settings, click **Save as Default**. You can load the default settings at any time by clicking **Load Default**. This does not affect the factory default settings, which are set in the hardware, and can be loaded by clicking **Load Factory Default**.

13 Click **OK** to apply your settings and close the Matrox RT.X2 DVI Monitor Calibration dialog box.
Figure 1: Color Bars

Figure 2: Calibrated color bars in blue-only mode

Chapter 2, Calibrating Your DVI Monitor for Video
This chapter shows you how to work with .mxf, .mp4, and .avi files on Matrox RT.X2.
Working with native .mxf files in Adobe Premiere Pro and After Effects

Note Matrox RT.X2 SD does not support working with .mxf files.

Matrox RT.X2 supports the MXF file format, which allows you to use .mxf files that are created with the Panasonic P2 camera (in SD and 720p formats) directly in Adobe Premiere Pro and After Effects without having to convert the files to the traditional AVI file format.

Important When using a Panasonic P2 camera to shoot material at 486p @ 23.98 fps for use with Matrox RT.X2, you must set the camera to Advanced mode (486/24pA).

Steps for using .mxf files in your projects

1. Connect your Panasonic P2 device to your Matrox RT.X2 computer as per your device’s instructions.

   Note If you have a PCMCIA card reader in your computer, you can use it to load your P2 memory card for use with Matrox RT.X2. However, the device must show up in Windows as a drive.

2. You can either edit directly from the P2 device or from the computer’s hard drive. If you choose to edit your .mxf clips from the computer, copy the Panasonic P2 folder structure to your computer’s hard drive. For information regarding the Panasonic P2 folder structure, see “Panasonic P2 folder structure” on page 16.

3. Open your Matrox project in Adobe Premiere Pro and import the native .mxf files into the Project panel like any other file. To help you select your shots you can enable thumbnail view, and add details for your .mxf files in Windows Explorer, or Premiere Pro’s Import or Get Properties dialog box. For more information on displaying .mxf file information, see “Displaying information for clips in Windows Explorer” on page 14.

4. Add the .mxf files from the Project panel to your Premiere Pro sequence, apply effects, and mix the .mxf files with other clips as you see fit.

5. Add Adobe After Effects compositing with a simple copy and paste or import the .mxf files into After Effects and edit them as you see fit.

   Note Matrox RT.X2 does not support exporting to an .mxf file.
Working with native XDCAM EX (.mp4) files in Adobe Premiere Pro

**Note** Matrox RT.X2 SD does not support XDCAM EX files.
Matrox RT.X2 supports realtime playback of Sony XDCAM EX 1080i/p and 720p .mp4 files in Adobe Premiere Pro. Both 1080i/p HQ-mode (1920×1080) and 1080i/p SP-mode (1440×1080) clips are supported in your 1080i/p sequences, and will be automatically scaled to your sequence’s frame size as needed. For example, when you add XDCAM EX 1080i @ 29.97 fps HQ-mode (1920×1080) clips to a 1440×1080i @ 29.97 fps sequence, the clips are automatically downscaled to 1440×1080. Realtime downscaling of XDCAM EX 1080i/p SP-mode clips in SD sequences is also supported as explained in “Mixing SD and HD clips in a sequence” on page 26.

**Note** Instead of importing XDCAM EX clips directly to your Adobe Premiere Pro projects, you should copy the clips from your XDCAM EX device to your computer’s hard drive.
Displaying information for clips in Windows Explorer

Matrox RT.X2 extends the functionality of Windows Explorer by allowing you to easily view and manage your .mxf and .avi files by providing thumbnail previews (Vista and XP) and additional file details (XP only).

Note You can view thumbnails and additional details for .mxf and .avi files in any application where you can choose the thumbnails or details view, such as Adobe Premiere Pro’s Import dialog box.

Thumbnails preview
Matrox RT.X2 allows you to view thumbnails of .mxf and .avi files in Windows Explorer. The thumbnail will display the first frame of the clip. Without Matrox RT.X2, only the default Windows icon would appear. In a folder containing .mxf or .avi files, enable the thumbnails view as follows:

- In Windows Vista, choose Views > Tiles or any of the icon options, except Small Icons.

Note Make sure that Always show icons, never thumbnails is cleared in Organize > Folder and Search Options > View.

- In Windows XP, choose View > Thumbnails.

Additional file details in Windows XP
On a Windows XP system, Matrox RT.X2 lets you add additional details for .mxf and .avi files in Windows Explorer.

To add clip details in Windows Explorer:

1 Start Windows Explorer, and ensure that the details view is selected for the appropriate folder by choosing View > Details.
2 Choose View > Choose Details.

3 In the Choose Details dialog box, select the check boxes corresponding to the desired “Matrox” or “Matrox P2” details. Detail names followed by “Matrox P2” are specific to Panasonic P2 files (for example, User Clip Name, Shooter, Shooting Location, and Scene No.).

4 Click OK.

5 To apply the change to all folders, choose Tools > Folder Options > View > Apply to All Folders.

Creating Matrox EZ-MXF files for playback with VFW applications

Note The Matrox EZ-MXF utility is not available on RT.X2 SD because Matrox RT.X2 SD does not support .mxf files.

Many animation, compositing, and motion graphics applications used by video editors read Video for Windows (VFW) .avi files, but these applications are not designed to read .mxf files. The Matrox EZ-MXF utility creates a very small reference .avi file, along with the associated mono .wav files, from an .mxf file without modifying the contents of your original .mxf file or its metadata. Your VFW application plays the created .avi and .wav files, which reference the original .mxf file.

Remarks

• Windows Media Player does not support .mxf files. You can therefore use the Matrox EZ-MXF utility to create reference .avi and .wav files for your .mxf files that you want to play back using Windows Media Player.
For .mxf files that have a frame size of 1440×1080, the created reference .avi files will have a frame size of 1920×1080 and a 1.333 pixel aspect ratio. To display these .avi files correctly in Adobe After Effects or Adobe Premiere Pro, you’ll need to use the Interpret Footage command to change the pixel aspect ratio to 1.0.

You can configure Matrox EZ-MXF to create only video files, only audio files, or both types of files. By default, Matrox EZ-MXF is set to create both video and audio files.

To create Matrox EZ-MXF files:

1. In Windows Explorer, right-click the desired .mxf file (or selected files), and choose Matrox EZ-MXF AVI > Configure.

2. In the Configure Matrox EZ-MXF AVI dialog box, specify the type of files you want to create (video and/or audio), and click OK.

   **Note** The file type settings will remain in effect until you change them.

3. Right-click the desired .mxf file (or selected files), and choose Matrox EZ-MXF AVI > Create. The reference .avi and .wav files are created as per the folder structure for Panasonic P2 as explained in the next section.

   **Important** Once the Matrox EZ-MXF files are created, do not change the location or name of the referenced .mxf files or your VFW program won’t be able to locate your .mxf material. If this occurs, Matrox RT.X2 will display an appropriate error message.

Panasonic P2 folder structure

Panasonic P2 files are organized in a specific folder structure as follows:

---

Chapter 3, Working with .mxf, .mp4, and .avi Files
When you select an .mxf file in the VIDEO folder, Matrox EZ-MXF looks for any associated audio .mxf files in the AUDIO folder, and creates the reference .avi and associated .wav files in the VIDEO folder. For example, if you select the file 00001A.mxf from the VIDEO folder, the reference .avi file (00001A.avi) and all associated audio files, such as 00001A00.Mono.wav and 00001A01.Mono.wav, will be created in the VIDEO folder. For more information on the P2 naming convention and folder structure, see your Panasonic P2 documentation.

**Note** If you select an audio .mxf file from the AUDIO folder, only the mono .wav file will be created, and it will be in the AUDIO folder.

### Creating Matrox EZ-HDV AVI files for playback of large HDV clips with VFW applications

The file size limit for playing back HDV .avi files in VFW applications is 2 GB. For example, when you play back a large HDV .avi file in Adobe After Effects, the clip stops playing at the 2-GB point. To overcome this limitation, you can use the Matrox EZ-HDV AVI utility to create small .avi files, and the associated mono .wav files, that reference your large HDV clips. These reference HDV .avi and .wav files will play back completely in your VFW application.

Matrox EZ-HDV AVI supports HDV .avi files only. It does not support other types of .avi files, such as MPEG-2 I-frame 1440×1080i/p .avi files.

**Note** For HDV clips that have a frame size of 1440×1080, the created reference HDV .avi files will have a frame size of 1920×1080 and a 1.333 pixel aspect ratio. To display these files correctly in Adobe After Effects or Adobe Premiere Pro, you’ll need to use the **Interpret Footage** command to change the pixel aspect ratio to 1.0.

You can configure Matrox EZ-HDV AVI to create only video files, only audio files, or both types of files. By default, Matrox EZ-HDV AVI is set to create both video and audio files.
To create Matrox EZ-HDV AVI files:

1. In Windows Explorer, right-click the desired HDV .avi file (or selected files), and choose Matrox EZ-HDV AVI > Configure.

2. In the Configure Matrox EZ-HDV AVI dialog box, specify the type of files you want to create (video and/or audio), and click OK. The created reference files will be named Filename_Ref.avi, Filename_Ref.Mono1.wav, and Filename_Ref.Mono2.wav. For example, if you’re creating both video and audio files for a file named Demo.avi, your reference files will be named Demo_Ref.avi, Demo_Ref.Mono1.wav, and Demo_Ref.Mono2.wav (only mono reference .wav files can be created for stereo HDV clips).

   **Note** The file type settings will remain in effect until you change them.

3. Right-click the desired HDV .avi file (or selected files), and choose Matrox EZ-HDV AVI > Create. Your reference .avi and .wav files will be created in the same folder as your source .avi files.

   **Important** Once the Matrox EZ-HDV AVI files are created, do not change the location or name of the referenced HDV .avi files or your VFW program won’t be able to locate your original HDV clips. If this occurs, Matrox RT.X2 will display an appropriate error message.

Converting a 32-bit .tga sequence to an .avi file with alpha

Matrox RT.X2 allows you to create a single .avi file with alpha from a 32-bit .tga sequence. The created .avi file will contain the alpha-key information, which means that when you place the file on the timeline in Adobe Premiere Pro, the clip will be automatically keyed. Having only one file simplifies management and makes it easier to include the composition in your final edit.

**Note** You can convert 32-bit uncompressed or RLE-compressed .tga files to an .avi file with alpha.

When selecting only one .tga file, the program automatically detects other files with the same base name in the same folder (for example, demo001.tga, demo002.tga, etc.), and uses these files to create the .avi file. When multiple .tga

Chapter 3, Working with .mxf, .mp4, and .avi Files
files are selected, only the selected files will be taken to build the .avi file. The .avi file will be created with the following naming convention:

*Base Name_Compressor_Output Format.avi*

For example, if the base name for your converted .tga sequence is `demo`, the compressor is **Matrox MPEG-2 I-frame + Alpha**, and the output format is **NTSC 4:3**, the created .avi file will be named `demo_MPEG-2_I-frame_NTSC_4_3.avi`.

You can create HD and SD .avi files with alpha in Matrox MPEG-2 I-frame format. On Matrox RT.X2 SD, however, only the SD files are supported.

**To create an .avi file with alpha from a .tga sequence:**

1. In Windows Explorer, right-click the selected .tga file(s), choose **Matrox AVI + Alpha > Select Format**, and then click the desired .avi output video format, such as **1440x1080i @ 29.97 fps**.

   **Note**  Formats that are not supported by your Matrox RT.X2 hardware are identified with an asterisk (*) in the list. If you create an .avi file using an unsupported format, it will not play back in real time on your Matrox RT.X2 system.

2. Right-click the selected .tga file(s), and choose **Matrox AVI + Alpha > Configure**.

   **Note**  Once set, the output format and configuration settings apply to all subsequent .tga sequences that you convert to .avi files. However, if you select a 1440x1080i/p output format, the compressor for the .tga to .avi conversion will automatically be set to **Matrox MPEG-2 I-frame HD + Alpha**.

3. From the **Compressor** list, select the compression format you want for your .avi file.

Converting a 32-bit .tga sequence to an .avi file with alpha
Note Although the Matrox uncompressed formats are available, you cannot play back uncompressed clips in real time on your Matrox RT.X2 system.

- Matrox MPEG-2 I-frame + Alpha Renders video to MPEG-2 intra-frame format with alpha using the 4:2:2 Profile @ Main Level at a selected data rate (SD resolution only).

- Matrox MPEG-2 I-frame HD + Alpha Renders video to MPEG-2 intra-frame format with alpha using the 4:2:2 Profile @ High Level at a selected data rate (HD resolution only).

4 Click the Configure button to specify various options for the MPEG-2 I-frame compression. The configuration options are the same as when you capture and render video using Adobe Premiere Pro (see “Selecting your MPEG-2 I-frame settings” on page 47).

5 Under Destination Folder, either select Same folder as TGA, or click Browse to specify where the .avi file will be created. Select Overwrite existing file if you want to overwrite any .avi file with the same name in the specified folder.

6 Right-click the selected .tga file(s), and choose Matrox AVI + Alpha > Convert to AVI.
Chapter 4

Defining Your Adobe Premiere Pro Settings

This chapter explains how to define various settings for using Matrox RT.X2 with Adobe Premiere Pro. This includes creating a new Matrox project, and specifying your sequence and export settings.
A note about running other programs with Adobe Premiere Pro

For the best performance, you shouldn’t run any other programs at the same time as Adobe Premiere Pro. If you choose to do so, however, make sure that you start Adobe Premiere Pro and open your Matrox RT.X2 project before starting the other programs. Otherwise, Adobe Premiere Pro may fail to start. If this happens, quit all programs and then restart Adobe Premiere Pro.

Don’t use the Windows Vista Aero color scheme

For the best performance on a Windows Vista system, it’s recommended that you don’t use the Windows Aero color scheme in your Control Panel’s Appearance Settings. The Windows Aero color scheme requires additional GPU processing, and may affect your system’s realtime performance. For details on how to change your system’s color scheme, see your Microsoft Windows Vista documentation.

Setting your system’s volume levels

To properly capture and play back audio in Adobe Premiere Pro, make sure you’ve set appropriate recording and playback volume levels for your system as follows:

For Windows Vista

1. Right-click the speaker icon on the Windows taskbar and choose PlaybackDevices.

Tip If you don’t see the speaker icon, right-click the Windows taskbar and choose Properties, click the Notification Area tab, select Volume, and click OK.

2. From the list of available devices, double-click the device that you want to use with your Matrox RT.X2 system.

3. Click the Levels tab, and for each of the controls (Line-in, Microphone, etc.) make sure the volume slider is at an appropriate level, such as at midpoint. As well, make sure that each control is not muted.

Note If you have an active audio stream connected to an input on your audio card via the RT.X2 breakout box, you must mute the input to avoid hearing the audio when you’re not working in Premiere Pro.

4. Click OK, and click the Recording tab.

5. From the list of available devices, double-click the device (input) that you want to use as the audio source, such as Line-in, with your Matrox RT.X2 system.
6 Click the **Levels** tab, and make sure the volume slider is at an appropriate level, such as at midpoint.

7 Repeat steps 5 and 6 for every audio input source that you intend to use with your Matrox RT.X2 system. For example, if you intend on recording audio from a microphone, set the volume levels for the **Microphone** input.

8 Click OK.

9 Click OK to close the dialog box.

### For Windows XP

1 Double-click the speaker icon on the Windows taskbar.

**Tip** If you don’t see the speaker icon on your Windows taskbar, run **Sounds and Audio Devices** from the Windows Control Panel, select **Place volume icon in the taskbar**, then click OK.

2 Choose **Options > Properties**.

3 From the **Mixer device** list, make sure that the audio device you want to use with your Matrox RT.X2 system is selected.

4 Select the **Playback** option, then select all check boxes in the list. Click OK.

5 For each of the controls (**Line-in**, **Wave**, etc.), make sure the **Volume** sliders are at an appropriate level, such as at half-level. As well, clear all the **Mute** check boxes.

**Note** If you have an active audio stream connected to an input on your audio card via the RT.X2 breakout box, you must mute the input to avoid hearing the audio when you’re not working in Premiere Pro.

6 Choose **Options > Properties**.

7 Select the **Recording** option, then select all check boxes in the list. Click OK.

8 For each of the controls (**Line-in**, **Microphone**, etc.), make sure the **Volume** sliders are at an appropriate level, such as at half-level. As well, if available, clear all the **Mute** check boxes.

9 Close the dialog box.
Creating a new Matrox project

Creating a new Matrox project involves specifying the location of your scratch disks and selecting a Matrox sequence preset. For more information about using the Matrox sequence presets for working with different types of sequences, see Appendix B, “Matrox RT.X2 Workflows.”

To create a new Matrox project:

1. Start Adobe Premiere Pro and click the New Project icon. The New Project dialog box appears. You can leave all the settings on the General page at the default settings. For details on changing these settings, see your Adobe Premiere Pro documentation.

2. Click the Scratch Disks tab, and use the Browse button to select an appropriate A/V drive for each scratch disk type. When specifying the location of your scratch disks, make sure you follow the recommendations in your Adobe Premiere Pro documentation. For example, store your video and audio files on a separate hard drive dedicated to your media assets.

   Tip: Specifying the same scratch disk settings for all your projects will help shorten the amount of time it takes to open new or existing projects.

3. From the Location list, select where you want to save your project.

4. In the Name box, specify a name for your project.

5. Click OK to save your settings. The New Sequence dialog box opens on the Sequence Presets page.

6. Under Available Presets, select the preset that matches the type of sequence you want to create from the appropriate Matrox folder. For example, if you want to create an NTSC sequence and work in a standard 4:3 editing environment, expand the 720x486 and NTSC folders under Matrox - SD, and then select the Standard preset.

Remarks

- Matrox RT.X2 SD supports creating SD sequences only. Therefore, the Matrox HD presets are not available on RT.X2 SD.

- If you’ll be capturing HDV material, select the appropriate Matrox HD preset. For example, if your footage was shot in Sony 1080/60i format, expand the 1440x1080 folder under Matrox - HD and select the 1440x1080i @ 29.97 fps preset. If your footage was shot in Sony 1080/50i format, select the 1440x1080i @ 25 fps preset. On RT.X2 SD, you can capture HDV material in an SD sequence as explained in “Capturing HDV material on Matrox RT.X2 SD” on page 42.

7. In the Sequence Name box, specify a name for your sequence.

8. Click OK to apply the settings.
Defining your player settings

By default, each monitor in Adobe Premiere Pro (Source Monitor, Program Monitor, Trim Monitor, etc.) uses the Adobe Player to play material. However, in order to also preview the video simultaneously on your video monitor when working with Matrox RT.X2, your player settings need to be set to use the Matrox Player. To do this, choose Edit > Preferences > Player Settings and choose Matrox Player as the default player.

Note: You can also use the Matrox Player to preview video played back from the timeline on your video monitor when working in Adobe Encore CS4. To set the default project player to Matrox Player in Adobe Encore CS4, go to the Advanced page of the Project Settings dialog box.

Displaying warnings in Adobe Premiere Pro’s Events panel

Matrox RT.X2 uses Adobe Premiere Pro’s Events panel to issue certain error messages and warnings. To display these, choose Window > Events. For more information about using the Events panel, see your Adobe Premiere Pro documentation.

Mixing interlaced and progressive clips in a sequence

When editing on Matrox RT.X2, you can mix interlaced and progressive clips in the same sequence, as long as the clips have the same frame size and frame rate. Both the interlaced and progressive clips will play back in real time. For example, when working in an NTSC sequence you can import NTSC clips as well as 486p @ 29.97 fps clips, and 1440×1080p @ 29.97 fps clips to which you’ve applied realtime scaling as explained in “Mixing SD and HD clips in a sequence” on page 26.

You should be aware, however, that when you apply effects to clips that have a scanning mode (progressive or interlaced) that doesn’t match your sequence, some undesirable artifacts may appear in your clips.
Mixing SD and HD clips in a sequence

Matrox RT.X2 supports realtime playback of SD clips in an HD sequence, and HD clips in an SD sequence. To do this, however, the clips must be scaled to the frame size of your sequence. If you want the scaling to be performed when you add the clips to your sequence, choose Edit > Preferences > General and select Default scale to frame size. This option does not affect clips that have already been placed in your sequence. To scale individual clips in a sequence, right-click the clip in the Timeline panel and choose Scale to Frame Size.

Because you can also mix interlaced and progressive clips that have the same frame size and frame rate in a sequence, when you apply realtime scaling to a clip it will play back in real time even if the clip’s scanning mode (interlaced or progressive) doesn’t match your sequence.

Depending on the video format of your sequence, realtime scaling of clips is supported as shown in the following table:

<table>
<thead>
<tr>
<th>Sequence video format</th>
<th>Supported realtime scaling of clips</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>Downscale 1440×1080i/p @ 29.97 fps</td>
</tr>
<tr>
<td>PAL</td>
<td>Downscale 1440×1080i/p @ 25 fps</td>
</tr>
<tr>
<td>486p @ 23.98 fps</td>
<td>Downscale 1440×1080p @ 23.98 fps</td>
</tr>
<tr>
<td>486p @ 29.97 fps</td>
<td>Downscale 1440×1080i/p @ 29.97 fps</td>
</tr>
<tr>
<td>576p @ 25 fps</td>
<td>Downscale 1440×1080i/p @ 25 fps</td>
</tr>
<tr>
<td>1440×1080i @ 25 fps</td>
<td>Upscale PAL and 576p @ 25 fps</td>
</tr>
<tr>
<td>1440×1080i @ 29.97 fps</td>
<td>Upscale NTSC and 486p @ 29.97 fps</td>
</tr>
<tr>
<td>1440×1080p @ 23.98 fps</td>
<td>Upscale 486p @ 23.98 fps</td>
</tr>
<tr>
<td>1440×1080p @ 25 fps</td>
<td>Upscale PAL and 576p @ 25 fps</td>
</tr>
<tr>
<td>1440×1080p @ 29.97 fps</td>
<td>Upscale NTSC and 486p @ 29.97 fps</td>
</tr>
</tbody>
</table>

Remarks

Realtime scaling is not supported for the following:

- 720p clips in an SD sequence, and SD clips in a 720p sequence.
- Matrox offline HD clips.
- Matrox .avi files with alpha.
- Sony XDCAM EX 1080p @ 23.98 fps SP-mode (1440×1080).mp4 files in an SD sequence.
- Sony XDCAM EX 1080i/p HQ-mode (1920×1080).mp4 files in an SD sequence.
Defining your sequence settings

The Matrox Playback Settings dialog box has several pages that you can use to specify various settings for editing in Adobe Premiere Pro on Matrox RT.X2. When you select a Matrox sequence preset, a Matrox editing mode is automatically set for your sequence, and many settings are optimized for editing on Matrox RT.X2.

**Important** The general and DV-1394 output settings in the Matrox Playback Settings dialog box apply to your entire project. The video output settings, however, are specific to your sequence. Any video output settings you specify for a particular video format will be applied the next time you create a new Matrox sequence in that same format. If you change any of the video output settings, the new settings will be applied to all previously created sequences that have that video format in your project. For example, if you create a new NTSC sequence, the settings you apply for that new NTSC sequence will also be applied to any previously created NTSC sequences in your project.

Specifying your general settings

To specify your general sequence settings on Matrox RT.X2:

1. Choose **Sequence > Sequence Settings** and click the **Playback Settings** button.
2. Click the **General** tab.

![Matrox Playback Settings dialog box](image)
3. Under **Scrubbing Mode**, select **Frame, 1st Field**, or **2nd Field** to indicate whether you want to display frames or only one field when you scrub a sequence in the **Timeline** panel. For example, you may want to scrub the first or second field to eliminate the flickering that can be seen in your picture when you pause while scrubbing interlaced video. Scrubbing fields can also be used to check for any dropped fields that may have occurred in your video during a telecine process.

**Note** If you choose to scrub fields when working with progressive scan video, you won’t normally see a difference between scrubbing the first or second field.

4. Under **Video Luma Level**, select the type of processing that you want to be applied to luminance levels in your video when rendering and previewing video in a sequence:

   - **Broadcast**  Processes video using the standard legal range of luminance levels for broadcast video. Any super black or super white luminance levels (that is, levels that fall below the standard black level or exceed the standard white level) are clipped.
   - **Post Production**  Processes video for post production. Any super black or super white luminance levels in your video are retained.

5. Under **Error Reporting**, select **Report dropped frames on playback** if you want to be warned each time frames are dropped when you play back video from the **Timeline** panel. Otherwise, clear this option.

**Note** Once playback of the sequence has stopped, a red bar will appear over segments of the sequence that have dropped frames (even if you don’t choose to report dropped frames).

6. Under **Premiere Pro Accelerated Effects**, you can select various options for your realtime/accelerated Premiere Pro effects. For example, you can choose to disable certain features and specify how you want your Motion effects to be processed. For details, see “**Selecting options for accelerated Premiere Pro effects**” on page 30.

7. Under **Realtime Indicator Threshold**, drag the slider to set the threshold at which Matrox RT.X2 determines that a segment in the **Timeline** panel is realtime. Drag to the left to set a lower (safer) threshold, or to the right to set a higher (more aggressive) threshold. For example, if you find that Matrox RT.X2 does not identify any segments as being non-realtime (that is, with a red bar) and you have dropped frames when you export your sequence to tape, you can set a safer threshold to force more segments to require rendering and avoid having dropped frames. Alternately, if you find that some segments are identified with a red bar but they don’t have dropped frames, you can set a more aggressive threshold.

Chapter 4, Defining Your Adobe Premiere Pro Settings
Defining your sequence settings

8 Under **Audio Conform/Waveform File Creation**, indicate whether or not you want audio conform and .pek (waveform) files to be created when you import clips to your project:

- **Create audio conform and PEK files**  Creates both audio conform and .pek files.
- **Create PEK files**  Creates only the .pek files (audio conform files won’t be created).

You can clear either one or both of these options to indicate that you don’t want audio conform and/or .pek files to be created for clips imported into your project (files may still be created for certain types of clips). This provides faster editing of your project immediately after importing clips because resources aren’t being used for the file generation. However, because Premiere Pro needs the .pek files to draw the audio waveforms for your clips, you won’t see the waveforms in the **Timeline** panel.

**Remarks**

- For any change to these options to take effect, you’ll need to restart Premiere Pro and open your project again.
- Depending on the content of your project, choosing not to create audio conform files may cause dropped frames.
- If you choose to create only audio .pek files and then you later select **Create audio conform and PEK files**, the audio conform files may not be created for all your clips, even though Premiere Pro will display a message that audio conforming is being performed. To solve this issue you’ll need to save your project, quit Premiere Pro, and delete all the .pek files for your project (located in the \Media Cache Files folder). The next time you start Premiere Pro and open your project, both the audio conform and .pek files will be created.

9 Under **Sequence Playback**, clear **Postroll after stop** if you don’t want any postroll when you stop the playback of a sequence. When you do this, the playback will stop at the current-time indicator, and you’ll see a slight jump in the video output when the playback stops (but the correct frame will be displayed).

10 Under **A/V Sync Adjustment**, drag the slider to adjust the A/V synchronization of clips played back in a sequence. If your audio starts later than the associated video, increase the A/V sync value. Alternately, if your audio starts before the associated video, decrease the A/V sync value. Be aware that if you decrease the value too much, you may experience audio crackling.

11 Under **Memory Usage**, select **Optimize memory usage** to reduce the amount of system memory that Matrox RT.X2 allocates to work with your project. Although this optimizes memory usage, the changes in memory

---

**Defining your sequence settings**
management could affect realtime performance depending on the content of your project. If you experience dropped frames, try clearing this option to see if the performance improves.

12 Under **Matrox RT.X2 Splash Screen**, select **Disable splash screen display** if you don’t want the Matrox RT.X2 splash screen to be displayed on your computer and video monitors when you first open your project after starting Premiere Pro.

13 Under **Adobe Media Encoder**, select **Disable accelerated export** if you want to disable accelerated exports using Adobe Media Encoder. You’ll need to do this if you want to use a “+ Alpha” Matrox VFW codec to render to a Matrox .avi file that includes alpha. You should also select this option if your system becomes unstable during accelerated exports of Matrox sequences using Adobe Media Encoder.

14 Click **OK** to save your settings and return to the **Sequence Settings** dialog box.

Selecting options for accelerated Premiere Pro effects
To select your options for processing accelerated Premiere Pro effects on Matrox RT.X2:

1 Choose **Sequence > Sequence Settings** and click the **Playback Settings** button.
2 Click the **General** tab.

![Premiere Pro Accelerated Effects](image)

3 Under **Premiere Pro Accelerated Effects**, select the options you want:
   - **Disable accelerated scaling to frame size** Select this if you want to disable the realtime playback of clips that are scaled to your sequences’s frame size as explained in “Mixing SD and HD clips in a sequence” on page 26. When you apply a DVE or other effect that resizes a realtime scaled clip, the full-screen image is resized, including any letterbox or pillarbox black bars. By disabling the accelerated scaling to frame size, any black bars in your scaled clips will become transparent, but your scaled clips will require rendering.
   - **Disable accelerated transitions** Select this if you’d like to disable the realtime/accelerated playback of Premiere Pro transitions that support this...
feature. Because Matrox RT.X2 emulates Premiere Pro’s non-realtime version of these transitions, if you don’t like the emulation you can disable the accelerated transitions to revert to Premiere Pro’s non-realtime version that requires rendering.

– **Accelerate Motion using**  Select this if you’d like realtime/accelerated playback of Premiere Pro Motion effects. You can then select one of the following to determine how you want the Motion effects to be processed:

  - **Matrox move & scale**  Maps the Motion effects to the Matrox CPU-based move & scale effect, which gives the best results if you only want to create picture-in-picture effects without rotation. If you apply rotation when you set up a Motion effect, it will require rendering.

  - **Matrox 3D DVE**  Maps the Motion effects to the Matrox hardware-accelerated 3D DVE effect, which supports rotation. The picture, however, won’t be as sharp as when you map the Motion effects to the Matrox move & scale effect. You can map to the Matrox 3D DVE effect only if you have a display card that supports the Matrox hardware-accelerated effects. For more information, see “Enabling and disabling the Matrox hardware-accelerated effects in Adobe Premiere Pro” on page 177.

4 Click **OK** to save your settings and return to the **Sequence Settings** dialog box.

### Specifying your video output settings

You can specify various settings to configure your video output signals from the RT.X2 breakout box.

#### To specify your video output settings:

1 Choose **Sequence > Sequence Settings** and click the **Playback Settings** button.

2 Click the **Video Output** tab.
3 Under **Master Output Format**, select the video format you want for all video outputs from the RT.X2 breakout box. Depending on the video format of your sequence, you may not be able to change the master output format.

4 If the **Aspect Ratio Conversion** list is available, such as when the video output for an HD sequence is downconverted to NTSC or PAL, select one of the following settings for the video output:
   - **16x9 Letterbox** Outputs the widescreen 16:9 picture in letterbox mode by adding black bars at the top and bottom of the picture for display on a standard 4:3 television screen.
   - **Anamorphic** Outputs the widescreen 16:9 picture as horizontally compressed 4:3 video, which retains the picture’s full vertical resolution for display on a widescreen television. To display the video with the correct proportions on an NTSC or PAL monitor, select the 16:9 display setting on the monitor.

5 If the **Pulldown Method** list is available, select the pulldown method you want to be applied to your output video (**Standard 2:3** or **Advanced 2:3:3:2**). You should select **Advanced 2:3:3:2** only if you’ll be recording to a DV-1394 device that supports this pulldown method. Depending on the frame rate of your sequence and the current master output format, a pulldown method may automatically be selected.

6 Under **Analog Setup (NTSC)**, select the setup level you want for your NTSC analog video:
   - **0 IRE** Applies a setup level of 0 IRE. You should select this option only when working with a commercial DV-1394 device that uses the Japanese analog NTSC setup of 0 IRE. For example, if the video appears too bright when you play back DV clips on your NTSC monitor, you can change the setup to 0 IRE to output your DV clips at the correct brightness.
   - **7.5 IRE** Applies the standard NTSC setup level of 7.5 IRE.

7 Under **Analog Output Type**, select the type of analog video output you want. If you’re outputting SD analog video, you can select **Component** or **Composite & S-Video**. If you’re outputting HD analog video, the analog output type will be set to **Component**.

8 Select **Allow Super White** to allow the highest luminance level of your video output to exceed the standard maximum white level. Select **Allow Super Black** to allow the lowest luminance level of your video output to fall below the standard black level.

   **Note** Super white and super black should not be allowed when producing your final video production for broadcast.

9 Click **OK** to save your settings and return to the **Sequence Settings** dialog box.

---

**Chapter 4, Defining Your Adobe Premiere Pro Settings**
Selecting your DV-1394 output settings
You can choose to output a sequence from the Timeline panel over the 1394 interface to perform an export to DV tape, and select the format you want for your DV-1394 output.

Note These settings are not needed to export to an HDV device, and the DV-1394 Output page won’t be available if you’re working with a 1440×1080i/p sequence.

To select your DV-1394 output settings:
1 Choose Sequence > Sequence Settings and click the Playback Settings button.
2 Click the DV-1394 Output tab.
3 Select Enable 1394 output for export to tape if you want your sequence to be output over the 1394 interface when you perform an export to tape (that is, when you choose File > Export > Export to Tape). This lets you record your sequence to the DV-1394 device connected to your RT.X2 system.

Important Because this option requires additional system resources, you may find that when this option is selected some effects that were previously realtime will drop frames and require rendering (you’ll see a red bar over these segments in your sequence). Therefore, you should select this option only when you want to export your sequence to DV tape. When you perform the export to tape, Adobe Premiere Pro will render the segments identified by the red bar.

4 From the Output Format list, select the format you want for the DV-1394 output. For example, to record to a standard DV device, select Matrox DV/DVCAM.
5 Click OK to save your settings and return to the Sequence Settings dialog box.
Chapter 4, Defining Your Adobe Premiere Pro Settings

Defining your video preview settings
When you select a Matrox sequence preset, such as Matrox NTSC standard, an appropriate Matrox preview file format is automatically set with the Matrox MPEG-2 I-frame codec for previewing your video on Matrox RT.X2.

You can select a different Matrox codec if you want your video previews to be rendered using a different compression format. For details on configuring your MPEG-2 I-frame settings, see “Selecting your MPEG-2 I-frame settings” on page 47.

Note The Preview File Format must match the video format of your sequence. For example, if you’re working with a Matrox NTSC standard sequence, the Preview File Format must be set to NTSC Standard.
For details on specifying additional settings for your video previews, see your Adobe Premiere Pro documentation.
Defining your capture settings

The Matrox Capture Settings dialog box has pages that you can use to specify your settings for capturing video and audio in Adobe Premiere Pro on Matrox RT.X2.

Remarks

- When you specify your capture settings on Matrox RT.X2, VU meters will be displayed to let you monitor your audio input levels. For more information, see “Monitoring audio levels for capture” on page 40.
- Although Matrox RT.X2 SD supports only SD sequences, you can capture HDV material in an SD sequence using Adobe Premiere Pro’s HDV capture feature (instead of Matrox’s capture feature) as explained in “Capturing HDV material on Matrox RT.X2 SD” on page 42.

Specifying your video capture settings

Matrox RT.X2 lets you capture your video to various formats depending on the video format of your sequence. For example, if you’re working with an SD sequence (such as NTSC), you can capture to a DV format, such as DVCPRO, to create .avi files for use in your Premiere Pro projects.

When working with an SD sequence, you can also choose to capture video to an .m2v file for DVD authoring using Adobe Encore. For details about specific limitations when capturing to Matrox .m2v files, see “Notes about capturing to Matrox .m2v files” on page 41.

To specify your settings for capturing video in Adobe Premiere Pro on Matrox RT.X2:

1. Choose Project > Project Settings > General.
2. From the Capture Format list, select Matrox AVI to capture to an .avi file, or Matrox M2V to capture to an .m2v file (for SD sequences only).
3. Click the Configure button, then click the Video Capture Settings tab.

4. Under Input Device, select one of the following devices:
– RT.X2, RT.X2 LE, or RT.X2 SD to capture material from an analog source connected to your RT.X2 breakout box.

**Note**  Analog input is not supported for 486p @ 23.98 fps and 29.97 fps, 576p @ 25 fps, 1440×1080p, and 720p sequences.

– **DV-1394** to capture material from a DV-1394 device connected to your RT.X2 breakout box.

5 If you selected the RT.X2 breakout box as your input device, from the **Input Source** list, select the type of input you want to capture (Component, Composite, or S-Video). This will be set to Component when capturing analog video for an HD sequence (not supported on RT.X2 SD).

**Remarks**

– If you selected DV-1394 as your input device, the name of the DV-1394 device connected to your breakout box will appear in the **Input Source** box.

– If Matrox RT.X2 can’t detect your source device when you start a capture, you’ll receive an error message. Either black video will be captured or the capture won’t be able to start until a valid input signal is present. In either case, you must make sure that your source device is switched on and properly connected to the breakout box to properly capture the video.

– Matrox RT.X2 sets the **Input Format** to NTSC or PAL for an SD sequence. If you’re working with a 1440×1080i sequence, your analog source video must be full-size 1080i (1920×1080), but it will be captured to 1440×1080i format.

6 From the **Input Aspect Ratio** list, select the aspect ratio of your source video (4:3 or 16:9). For example, to capture video that was recorded using the standard TV screen format, select 4:3. To capture video that was recorded using the widescreen 16:9 format, select 16:9. If you’re defining capture settings for an HD sequence, the **Input Aspect Ratio** will be set to 16:9.

7 Under **Capture Format**, select your desired capture format from the list. If you’re capturing to an .avi file from a DV-1394 device, video will be captured to native DV or HDV format (the **Capture Format** will be set to **Native DV/HDV**). If you’re capturing to an .m2v file, the **Capture Format** will be set to **Matrox MPEG-2 IBP**.

**Note**  The capture formats that are available in the **Capture Format** list depend on the video format of your sequence. For more information, see “Supported video compression formats” on page 195.

– **Matrox DV/DVCAM**  Captures video to DV or DVCAM format.

– **Matrox DVCPRO**  Captures video to DVCPRO format.
Defining your capture settings

- **Matrox MPEG-2 I-frame**  Captures video to MPEG-2 intra-frame format using the 4:2:2 Profile @ Main Level at a selected data rate (SD resolution only). For the best results when capturing video clips on which you’ll be applying chroma key effects, you should use this codec instead of a DV codec.

- **Matrox MPEG-2 I-frame HD**  Captures video to MPEG-2 intra-frame format using the 4:2:2 Profile @ High Level at a selected data rate (HD resolution only). This is the only capture format available to capture analog video for a 1440×1080i sequence.

8 If you’re capturing to a Matrox MPEG-2 format, click the **Configure** button to configure your MPEG-2 settings. For details on the available settings, see “Selecting your MPEG-2 I-frame settings” on page 47, or “Selecting your MPEG-2 IBP settings” on page 49. Once you’ve configured your settings, click **OK** to return to the Matrox Capture Settings dialog box.

9 Select **Use Automatic Gain Control (AGC)** if you want the gain of your composite or S-Video input signal to be adjusted automatically to compensate for very bright or dark images. This improves the brightness or contrast of your picture.

10 Click **OK** to save your settings and return to the Project Settings dialog box.

Specifying your audio capture settings

You can specify various audio capture settings, such as to specify your input source and the type of audio files (either stereo **.wav** or mono **.wav**) that you want to create when capturing audio on Matrox RT.X2.

**Remarks**

- When you capture to an **.avi** file on Matrox RT.X2, the clip’s video and audio are saved to the **.avi** file, and the clip’s audio is also saved to one or more separate **.wav** files. You could choose to edit the separate **.wav** files using audio post-processing software, such as Adobe Soundbooth.

- When you capture to an **.m2v** file on Matrox RT.X2, the clip’s associated audio is always saved to one or more separate stereo **.wav** files.

To specify your settings for capturing audio in Adobe Premiere Pro on Matrox RT.X2:

1 Choose **Project > Project Settings > General**.

2 From the **Capture Format** list, select **Matrox AVI** to capture to an **.avi** file, or **Matrox M2V** to capture to an **.m2v** file (for SD sequences only).
3 Click the **Configure** button, then click the **Audio Capture Settings** tab:

![Audio Capture Settings](image)

4 If you selected the RT.X2 breakout box as your video input device (see “Specifying your video capture settings” on page 35), you must also select the source from which you want to capture audio. Your audio source must match the audio input where you connected the cable labeled TO AUDIO CARD IN from your RT.X2 breakout box as explained in your *Matrox RT.X2 Installation Manual*. For example, if you plugged the TO AUDIO CARD IN connector into the Line-In jack (or corresponding jack) on your sound card, select **Line-In** from the **Input Source** list.

**Remarks**

- If all available audio inputs don’t appear in the **Input Source** list, select **List all audio inputs**. If your audio input connection does not appear in the list, you must unplug the TO AUDIO CARD IN connector and connect it to an audio input on your sound card that appears in the list.

- If your analog audio source appears with an * beside it in the list, your sound card does not have matching audio inputs and outputs. In this case, choose the audio source with an * that matches your audio input, make sure that your source is playing back audio, and click **Advanced Settings**. In the provided dialog box, select an analog audio passthrough. If you can hear audio, then you’ve selected the correct analog audio source and passthrough. If you can’t hear audio, try selecting a different analog audio source and/or passthrough.

- The **Capture Format** (bit-depth) for your captured audio files is set to **16-bit**.

5 If you don’t want the VU meters to be displayed each time you configure your Matrox RT.X2 capture settings or open the **Capture** panel to start a capture, clear **Show VU meters**. This option is selected by default. For

Chapter 4, Defining Your Adobe Premiere Pro Settings
Defining your capture settings

39
defails on using the VU meters, see “Monitoring audio levels for capture” on page 40.

6 Under Capture Files, indicate whether you want to capture to stereo or mono audio files, and select which channels you want to save to separate .wav files.

- From the File Type list, select Stereo to save your captured audio to stereo .wav files, or Mono to save your captured audio to mono .wav files. If you're capturing an .m2v clip, the File Type will be set to Stereo.

- From the Filename lists, select which stereo pairs or mono channels you want to save to your .wav files. When capturing from a DV-1394 device, you can capture up to two stereo files or up to four mono files. Select None if you don’t want a particular .wav file to be created. When Matrox RT.X2 saves each .wav file, it assigns a Stereo.wav or Mono.wav suffix to the base name you gave for the associated video file. For example, if you've named your video file MyFile.avi, the associated stereo audio files would be named MyFile.Stereo1.wav, MyFile.Stereo2.wav, etc.

Remarks

- The channels that you choose to save to the first stereo.wav file or first two mono.wav files will be embedded in the associated .avi file. When you import your .avi file to the Project panel, the clip’s separate .wav files will also be imported, and the embedded audio in the .avi file will be ignored. The clip’s .avi file and first associated .wav file, however, will appear as a single Movie clip in your project. The embedded audio in the .avi file will be used only if the .avi file does not have any associated .wav files.

Therefore, if you perform audio post processing on your .avi files, make sure you delete the associated .wav files so that only the embedded audio in the .avi files will be used in your project.

- When performing an audio-only capture, Matrox RT.X2 supports capture of only one stereo pair. Your first stereo or first two mono channels will be saved to a single stereo .wav file (any other channels will be ignored). When RT.X2 saves the .wav file of an audio-only capture, it does not assign the Stereo.wav suffix to the filename.

7 Click OK to save your settings and return to the Project Settings dialog box.
Monitoring audio levels for capture

If you select Show VU meters on the Audio Capture Settings page, each time you configure your Matrox RT.X2 capture settings or open the Capture panel to start a capture in Adobe Premiere Pro, VU meters will be displayed to let you monitor the levels of your currently selected audio input source.

As you play your audio source, the color of the input level is green at or below –12 dBFS, yellow between –12 and –6 dBFS, and red above –6 dBFS. The clipping detectors will “light up” (become red) whenever audio clipping occurs. The peak level indicators are thin lines that show the highest level recently reached. These indicators will show the peak level for about two seconds or until a higher peak level is reached.

If needed, adjust the audio level on your source device to keep the average input level between –30 and –10 dBFS. You can also use Windows Volume Control to adjust your audio input levels as explained in “Setting your system’s volume levels” on page 22.
Notes about capturing to Matrox .m2v files

When capturing to Matrox .m2v files, keep the following points in mind:

- Automatic scene detection (Scene Detect) is not supported, but batch capture is supported.
- Batch capture to Matrox .m2v files is not frame accurate.
- An associated .xmp metadata file is created for all captured and logged (offline) .m2v clips. These files are created in your specified video capture folder, and contain time code and other information that you provided for your .m2v clips, such as tape name, description, and scene. You can open the .xmp files in Adobe Bridge. Take care not to delete the .xmp files and always keep them with their associated .m2v files. Otherwise, you won’t be able to batch capture logged .m2v clips, and the time code information won’t appear for your .m2v clips in the Project panel.
- Matrox .m2v files are not supported in real time in your Matrox projects because they are to be used for DVD authoring with Adobe Encore.

However, if you do want to use your Matrox .m2v clips in Adobe Premiere Pro, be aware of the following issues:

- The associated .wav files for your .m2v clips are not automatically imported to the Project panel.
- When performing a batch capture of .m2v clips, the captured video and audio clips won’t be automatically imported to the Project panel. Because you won’t be able to link the logged (offline) clips to the captured files on disk, you’ll have to import the batch captured .m2v clips manually. As well, if you recapture clips using batch capture, captured video clips will be imported automatically only if you choose to delete the original media files from disk.
- When you place a Matrox .m2v clip on a video track, an empty associated .wav clip will be placed on an audio track beneath it. To get rid of this clip, select it in the sequence and choose Clip > Unlink. Once you’ve unlinked the .wav from the .m2v, you can select the .wav clip on the audio track and delete it.
- It’s recommended that you don’t add handles (extra frames) to your captured .m2v clips. If you do, the handles will be appropriately trimmed from the video when you add the clip to your sequence, but the handles won’t be trimmed from the associated audio.
Capturing HDV material on Matrox RT.X2 SD

On Matrox RT.X2 SD, you can capture native HDV 1080i/p (1440×1080i/p) material over the 1394 interface in an SD sequence using Adobe Premiere Pro’s HDV capture feature. Depending on the video format of your sequence, you can capture:

- HDV 1080i/p @ 29.97 fps material in an NTSC or 486p @ 29.97 fps sequence.
- HDV 1080i/p @ 25 fps material in a PAL or 576p @ 25 fps sequence.
- HDV 1080p @ 23.98 fps material in a 486p @ 23.98 fps sequence.

Your HDV clips will be downscaled when you scale the clips to your sequence’s frame size for realtime playback as explained in “Mixing SD and HD clips in a sequence” on page 26.

To capture HDV 1080i/p material on Matrox RT.X2 SD:

1. Make sure that your HDV device is properly connected to the 1394 port on your Matrox RT.X2 breakout box.
2. Choose Project > Project Settings > General.
3. From the Capture Format list, select HDV and click OK.
4. Choose Edit > Preferences > Device Control.
5. From the Devices list, select DV/HDV Device Control.
6. Click Options and make sure that your device control options are correctly set as explained in your Adobe Premiere Pro documentation.
7. Click OK to save your settings.
8. Capture your HDV clips as explained in your Adobe Premiere Pro documentation.
Exporting to a Matrox .avi file

Several software codecs are included with Adobe Premiere Pro so that you can export your video to different formats. Your Matrox RT.X2 system adds several Matrox codecs to the ones included with Premiere Pro. Because the Matrox codecs use your RT.X2 hardware to accelerate rendering, they can export video much faster than when you use a software codec.

**Note** Hardware acceleration is also supported when exporting a Matrox sequence to Adobe native formats using Adobe Media Encoder, such as to export to MPEG-2 format for DVD or Blu-ray Disc. For details on exporting to Adobe native formats, see your Adobe Premiere Pro documentation.

The supported formats for accelerated export to a Matrox .avi file depend on your sequence video format as follows:

<table>
<thead>
<tr>
<th>Sequence video format</th>
<th>Supported export format(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>NTSC</td>
</tr>
<tr>
<td>PAL</td>
<td>PAL</td>
</tr>
<tr>
<td>486p @ 23.98 fps</td>
<td>486p @ 23.98 fps or NTSC</td>
</tr>
<tr>
<td>486p @ 29.97 fps</td>
<td>486p @ 29.97 fps or NTSC</td>
</tr>
<tr>
<td>576p @ 25 fps</td>
<td>576p @ 25 fps or PAL</td>
</tr>
<tr>
<td>720p @ 23.98 fps</td>
<td>720p @ 23.98 fps, 720p @ 59.94 fps, 486p @ 23.98 fps, or NTSC</td>
</tr>
<tr>
<td>720p @ 25 fps</td>
<td>720p @ 25 fps, 720p @ 50 fps, 576p @ 25 fps, or PAL</td>
</tr>
<tr>
<td>720p @ 29.97 fps</td>
<td>720p @ 29.97 fps, 720p @ 59.94 fps, 486p @ 29.97 fps, or NTSC</td>
</tr>
<tr>
<td>720p @ 50 fps</td>
<td>720p @ 50 fps or PAL</td>
</tr>
<tr>
<td>720p @ 59.94 fps</td>
<td>720p @ 59.94 fps or NTSC</td>
</tr>
<tr>
<td>1440×1080i @ 25 fps</td>
<td>1440×1080i @ 25 fps or PAL</td>
</tr>
<tr>
<td>1440×1080i @ 29.97 fps</td>
<td>1440×1080i @ 29.97 fps or NTSC</td>
</tr>
<tr>
<td>1440×1080p @ 23.98 fps</td>
<td>1440×1080p @ 23.98 fps, 1440×1080i @ 29.97 fps, 486p @ 23.98 fps, or NTSC</td>
</tr>
<tr>
<td>1440×1080p @ 25 fps</td>
<td>1440×1080p @ 25 fps, 576p @ 25 fps, or PAL</td>
</tr>
<tr>
<td>1440×1080p @ 29.97 fps</td>
<td>1440×1080p @ 29.97 fps, 486p @ 29.97 fps, or NTSC</td>
</tr>
</tbody>
</table>

For example, if you have an NTSC sequence, you must export to NTSC format by selecting a Matrox NTSC preset. If you have a 1440×1080i @ 29.97 fps sequence, you can select a 1440×1080i @ 29.97 fps preset to export to HD format, or you can select an NTSC preset to downconvert the HD video to NTSC (this includes appropriate color space conversion from HD to SD). RT.X2 SD supports exporting to SD format only.

**Exporting to a Matrox .avi file**
To export your sequence to a Matrox .avi file:

1. Unless you want to export your entire sequence, position the work area bar over the section of the sequence you want to export.

2. Choose File > Export > Media. This opens the Export Settings dialog box.

   **Important** In order to have access to all the settings in the Export Settings dialog box, make sure you enable “Advanced Mode” by clicking the Advanced Mode/Simple Mode button.

3. From the Format list, select Matrox AVI.

4. From the Preset list, select the video format you want for your exported file.

5. Select Export Video and Export Audio if you want to export both video and audio.

   **Note** Exported audio will be embedded in your .avi file and also saved as one or more separate .wav files in the same folder as your .avi file. Matrox RT.X2 does not support audio-only exports to a .avi file.

6. Click the Video tab. Under Codec, an appropriate Matrox codec is automatically set based on the Preset selected in step 4. Depending on the

---

Chapter 4, Defining Your Adobe Premiere Pro Settings
video format to which you’re exporting, you can change the codec if you want.

- **Matrox DV/DVCAM** Renders video to DV or DVCAM format.
- **Matrox DVCPRO** Renders video to DVCPRO format.
- **Matrox MPEG-2 I-frame** Renders video to MPEG-2 intra-frame format using the 4:2:2 Profile @ Main Level at a selected data rate (SD resolution only).
- **Matrox MPEG-2 I-frame HD** Renders video to MPEG-2 intra-frame format using the 4:2:2 Profile @ High Level at a selected data rate (HD resolution only).

7 If you’re exporting to a Matrox MPEG-2 I-frame format, click the **Configure** button to select your MPEG-2 I-frame settings (see “Selecting your MPEG-2 I-frame settings” on page 47).

8 If you are using an SD codec for your export, choose the appropriate **Pixel Aspect Ratio** (for an HD codec, **16:9** will be automatically selected).
- **4:3** For SD material that uses the standard TV screen format. If you’re downconverting HD video to SD format, the video will be exported in letterbox mode.

Exporting to a Matrox .avi file
— **16:9** For SD material that uses the widescreen 16:9 format. If you're downconverting HD video to SD, the video will be exported as anamorphic (horizontally compressed 4:3) video.

9 Select **Recompress** if you're exporting using the same compression format, frame size, and frame rate as the source material in your sequence, but using a different data rate or scanning mode (interlaced or progressive). For example, you’ll need to select **Recompress** if your sequence is NTSC MPEG-2 I-frame at 50 Mb/sec and you want to export to an NTSC MPEG-2 I-frame 20 Mb/sec file.

**Note** In most cases, it’s recommended that you do not select **Recompress**. This retains the quality of your video. It also optimizes the speed of the export because realtime video segments that have no effects will be copied directly to disk without recompression, assuming that the compression and video format of your video clips matches the format to which you’re exporting.

10 Click the **Matrox Export** tab.

11 Select the range you want to export.
   - **Entire sequence** Exports your entire sequence.
   - **Work area** Exports the material defined by the work area bar.

12 Click the **Export to Matrox AVI** button.

13 In the **Save As** dialog box, specify a name and location for your export.

14 Click **Save** to start your export.
Selecting your MPEG-2 I-frame settings

When you select the Matrox MPEG-2 I-frame or Matrox MPEG-2 I-frame HD format to render or capture video using Adobe Premiere Pro, you can specify various settings for the MPEG-2 I-frame compression.

To select your MPEG-2 I-frame settings:

1. Click the Configure button. This displays a dialog box similar to the following:

![Matrox MPEG-2 I-frame HD Settings dialog box]

2. Drag the Data Rate slider until your desired data rate is displayed. The higher the data rate you select, the better the video quality will be. The range of available data rates depends on whether you’re using the Matrox MPEG-2 I-frame HD or SD format.

   **Important** Depending on the capabilities of your system, you may drop frames if you select a data rate higher than about 90 Mb/sec.

3. To apply advanced settings to your MPEG-2 I-frame file, click the Advanced button.

   **Note** The default advanced settings should provide good results for most applications. We recommend that you change these settings only when needed for special purposes.

4. Under Rounding Type, select one of the following:
   - MPEG-2 Rounds the AC coefficients up to the nearest whole number when calculating the quantization coefficient.
   - Matrox Custom Truncates the AC coefficients to the lowest whole number when calculating the quantization coefficient. In some cases, this setting may yield less artifacts in graphics.

5. Under DC Precision, select the bit-depth precision of the DC intra block.
**Note**  The higher the DC precision value that’s used to capture or render your video, the more likely that the DC content will be increased at the expense of the AC content in the encoded stream. This may result in lowering the overall quality of the compressed stream at a specified data rate.

6 Under **Zig Zag Type**, select one of the following:

- **Regular**  Sets the regular (default) zig zag scanning pattern of the AC coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure 7-2) specification documentation.

- **Alternate**  Sets an alternate zig zag scanning pattern of the AC coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure 7-3) specification documentation. Use this setting when capturing or rendering video at a high data rate (that is, at a data rate of about 25 Mb/sec for SD video, or 90 Mb/sec or higher for HD video).

7 Select the **Force Frame-based DCT** setting to render macroblocks as frames rather than as fields. In some cases, graphics will yield less artifacts if this option is selected.

8 Click **OK** to save your settings.
Selecting your MPEG-2 IBP settings

When capturing video to a Matrox .m2v file using Adobe Premiere Pro, the capture format is set to Matrox MPEG-2 IBP. You can specify various settings for the MPEG-2 IBP compression.

To select your MPEG-2 IBP settings:

1. Click the Configure button. This displays a dialog box similar to the following:

2. Under Data Rate (Mb/sec), you can select the encoding type and data rate for the MPEG-2 IBP compression.

   - **Encoding type** From this list, select one of the following:
     - **Constant bit rate (CBR)** Video is compressed at your selected target data rate, which is useful when you need to limit or predict the size of your .m2v file. However, if your video is very complex (such as scenes with many colors or sharp edges), you’ll need to select a high data rate to avoid having frames of very blocky video in your file.
Variable bit rate (VBR)  Video is compressed at varying data rates based on the complexity of the video. The target data rate you select is used as the average data rate for the compression.

- **Min.**, **Target**, and **Max.** sliders  Use these sliders to select your desired data rate. The higher the target data rate you select, the better the video quality will be. Only the **Target** slider will be available if you selected **Constant bit rate (CBR)**. If you selected **Variable bit rate (VBR)**, all three sliders will be available so that you can set the minimum, target, and maximum data rates for the video compression.

**Note** Adobe Encore requires CBR-encoded .m2v files longer than about two minutes to be transcoded. VBR-encoded .m2v files do not require transcoding in Adobe Encore.

3 Under **GOP Structure**, you can customize the GOP structure for the MPEG-2 IBP compression as follows:

- **GOP length**  Determines the number of frames in the GOP (Group of Pictures).

- **Subgroup length**  Determines the subgroup length of B-frames and P-frames in the GOP, after the initial I-frame. For example, a subgroup of 3 appears as “BBP,” and a subgroup of 2 appears as “BP.” The available subgroup lengths depend on your selected GOP length.

4 Under **Profile**, the **4:2:0** profile is selected, which uses 4:2:0 luminance/chrominance sampling and is suitable for broadcast transmission and distribution on DVD.

5 Under **Motion Estimation**, drag the slider to adjust the quality of the motion estimation used for the video compression. The default setting gives good results for most video. However, if you have a lot of fast motion in your video, such as fast-paced sports footage, you can get better results by dragging the slider to the right (towards **Slow/High quality**). This improves the quality of the motion estimation, but decreases the speed of the video compression. Alternately, if you have mostly slow-paced video, you may want to drag the slider to the left (towards **Fast/Low quality**) to decrease the quality of the motion estimation and speed up the video compression.

6 Click **OK** to save your settings.
Setting up Matrox DV/HDV device control

Matrox DV/HDV device control lets you control DV-1394 devices when capturing or exporting material to tape in Adobe Premiere Pro.

Note To capture HDV material on Matrox RT.X2 SD, you must use Adobe Premiere Pro’s DV/HDV device control as explained in “Capturing HDV material on Matrox RT.X2 SD” on page 42.

To set up Matrox DV/HDV device control:

1. Choose Edit > Preferences > Device Control.
2. From the Devices list, select Matrox DV/HDV Device Control.
3. Click Options and make sure that your device control options are correctly set as explained in your Adobe Premiere Pro documentation (the options are the same as those provided for Adobe Premiere Pro’s DV/HDV device control).
4. Click OK to save your settings.

You can now use device control when capturing or exporting material over the 1394 interface (make sure that your device is set to Remote or VTR mode). For details on how to capture material in Adobe Premiere Pro, see your Adobe Premiere Pro documentation. For information about exporting material to tape using device control, see the next section.
Exporting your sequence to tape
Your Matrox RT.X2 system lets you export your Adobe Premiere Pro sequence to tape using DV-1394 or RS-422 device control. You can use Matrox DV/HDV device control to control DV-1394 devices. For RS-422 devices, you can use Adobe Premiere Pro’s serial device control as explained in your Adobe Premiere Pro documentation.

Preparing your tapes for recording
To use device control, the tape on which you’ll be recording your material must contain continuous and consecutive time code. You can stripe your entire tape with time code by recording black video for the duration of the tape.

Note The format of your DV tape must match the format you’re recording. For example, if you set your DV-1394 device to record in DV/DVCAM format, your tape must be striped entirely in DV/DVCAM format. Mixed format tapes are not supported.

Avoiding missing frames when exporting to DV tape
When performing an export to tape on some DV-1394 devices, a delay may occur between the time the device starts recording and the time that Adobe Premiere Pro starts to play back your sequence. This may result in the first video frames of your sequence not being recorded to tape. To ensure that your export to DV tape does not miss any frames, you can delay the playback of the sequence that you are exporting.

To do this, you will need to do a test export with your DV-1394 device to determine the number of frames that are missing from the start of your sequence on the DV tape. In the Adobe Premiere Pro Export To Tape dialog box, select Delay Movie Start by and enter the number of frames you’ve determined are missing from your sequence multiplied by 4 (to convert the value to quarter frames). If needed, adjust this amount until you obtain a frame-accurate or near frame-accurate export to tape.

Note If your exported video is frame-accurate, but you’re missing audio at the start of your sequence on the DV tape, simply add a few frames of black and silence at the start of the sequence. If you do this, you may not need to use Delay Movie Start by.
Exporting to DV tape using DV-1394 device control

You can use Matrox DV/HDV device control when exporting your Adobe Premiere Pro sequence to a DV-1394 device. DV-1394 export to HDV, however, is supported only for 1440×1080i/p, and 720p @ 25 fps and 29.97 fps sequences.

To export your sequence to tape over the 1394 interface:

1. Open the project and activate the sequence you want to export to tape.
2. Make sure your DV-1394 device is properly connected and turned on.
3. Unless you’re exporting to an HDV device, make sure that you’ve enabled the DV-1394 output for export to tape and selected a DV-1394 output format as explained in “Selecting your DV-1394 output settings” on page 33.

Note If you’re exporting to an HDV device, Premiere Pro will detect that you’re using an HDV device when you perform the export to tape and the video will be exported in native HDV format. (Matrox RT.X2 SD does not support exporting to an HDV device.)

4. If you’re using a camcorder, switch it to VTR mode.
5. Load a striped recordable tape into your DV-1394 device.
6. Make sure that you’ve set up Matrox DV/HDV device control as explained in “Setting up Matrox DV/HDV device control” on page 51.
7. Choose File > Export > Export to Tape.

For information about exporting your sequence to tape using Adobe Premiere Pro, see your Adobe Premiere Pro documentation.
Creating an SD project in 16:9 format

When editing on Matrox RT.X2, you can choose to work with SD source video that’s been recorded in either the 4:3 standard TV screen format, or the widescreen 16:9 format.

To create an SD project in 16:9 format on Matrox RT.X2, do the following:

1 Record your video onto tape with your camera set to the widescreen 16:9 format. The video will be recorded as horizontally compressed 4:3 (anamorphic) video.

2 Start Adobe Premiere Pro and create a new Matrox project using the appropriate Matrox widescreen preset, such as NTSC widescreen, for your sequence (see “Creating a new Matrox project” on page 24). This ensures that the effects you create on Matrox RT.X2 will be displayed with the correct proportions when viewed in 16:9 format.

3 Capture your video clips as you normally would. Select the 16:9 display option on your NTSC or PAL video monitor to “unsquish” the video and play it back in widescreen format without distortion.

4 If you create animations, titles, or graphics for your project using a program that lets you set the pixel aspect ratio, use the appropriate setting for 16:9 display:
   - For NTSC or 486p video, set the pixel aspect ratio to 1.185.
   - For PAL or 576p video, set the pixel aspect ratio to 1.422.

   If you can’t set the pixel aspect ratio, create your image at 864×486 for NTSC or 486p video, or at 1024×576 for PAL or 576p video. After you’ve created your image, resize only its width to 720. When you resize the image, your text or graphic will appear elongated on your computer screen.

5 Edit your project as you would a standard 4:3 project.

   Note Be aware that if your video monitor is displaying in 4:3 format, certain effects may appear elongated because of the horizontal scaling. Setting your monitor to 16:9 will display the effects with the correct proportions.

6 Record your finished project onto tape. Remember that you’ll need a monitor capable of displaying material in 16:9 format to properly view your master tape.
Chapter 5

Setting Up Realtime Effects with Adobe Premiere Pro

This chapter explains how to set up realtime effects using the Matrox realtime plug-in for Adobe Premiere Pro.
Available effects

The Matrox realtime plug-in for Adobe Premiere Pro lets you:

- Set up spectacular realtime Matrox effects and transitions. The plug-in includes color corrections, chroma keys, luma keys, 3D DVEs, page curls, shadows, and many more effects.

  **Note** Certain effects will be available only if you have a display card that supports the Matrox hardware-accelerated effects. For more information, see “Enabling and disabling the Matrox hardware-accelerated effects in Adobe Premiere Pro” on page 177.

- Change various effect settings, and add or modify keyframes to customize your effects.
- Transform and crop your realtime effects.
- Create realtime graphics overlays using single-frame graphics files with an alpha-key channel.
- Set up certain Adobe Premiere Pro effects in real time, including fades (Video Opacity), DVEs (Motion), Black & White, Timecode, and Garbage Matte effects.
- Apply realtime speed changes to video clips.
- Set up many Adobe Premiere Pro transitions in real time when using SD video, or accelerate many Adobe Premiere Pro transitions when using HD video.
- Use and modify clips that have Matrox Flex CPU effects applied to them interchangeably between Adobe Premiere Pro and Adobe After Effects. For example, you can apply a Matrox color correction to your clip in Adobe Premiere Pro and import that clip into Adobe After Effects and vice versa. The effect will remain intact, and can be modified in both applications.

**Realtime** means that you can play back and record your effects onto tape without having to render them. This gives you creative freedom to experiment with different effects and change your mind as often as you want. You’ll instantly see the changes you make on your video monitor. Effects in Adobe Premiere Pro other than those listed above are not realtime, and therefore require rendering. For guidelines on setting up your realtime effects, see “Matrox RT.X2 realtime guidelines” on page 155.

When you install Matrox Mx.tools, all the Matrox effects are added to Adobe Premiere Pro, and the Matrox Flex CPU effects are added to Adobe After Effects. You set up Matrox effects in your productions the same way as other effects included with your Adobe software. For example, you apply a Matrox transition to your clips in Adobe Premiere Pro just as you would any other type of...
For instructions on how to apply effects to your productions in Adobe Premiere Pro or Adobe After Effects, refer to your Adobe documentation.

**Important** To use the Matrox realtime plug-in for Adobe Premiere Pro, you must have defined your Adobe Premiere Pro settings for use with your Matrox RT.X2 system, as explained in Chapter 4, “Defining Your Adobe Premiere Pro Settings.”

### How to apply a Matrox video effect in Adobe Premiere Pro

The Matrox realtime plug-in for Adobe Premiere Pro allows you to apply many realtime video effects to your clips. To apply a Matrox video effect to a clip, drag the desired effect from the Effects panel onto the clip in the Timeline panel.

By default, the Matrox video effects are found in the Matrox bin under Video Effects.

**Tips**

- You can also apply preconfigured Matrox video effects found in the Matrox Effect Presets bin under Presets.
- If you can’t see the Effects panel, choose Window > Effects. If you can’t see the Effect Controls panel, choose Window > Effect Controls.

### How to apply a Matrox video transition in Adobe Premiere Pro

In Adobe Premiere Pro, the Matrox wipe transitions are found in the Matrox bin under Video Transitions in the Effects panel.

There are numerous methods to create transitions in Premiere Pro. Use the method that works best for you to apply your Matrox wipes. For information on applying transitions, see your Adobe Premiere Pro documentation.
Transforming your clip

Many of the Matrox effects allow you to adjust the scale, position, and rotation of a clip by applying various transform settings. You can adjust the transform settings in two ways:

- Use the transform controls in the Effect Controls panel to adjust the settings you want.
- Work directly in Adobe Premiere Pro’s Program Monitor using your mouse. For example, click the desired transform button (Position, Scale, Rotation, or Rotation Center Offset), then click and drag within the Program Monitor to make your adjustments. To do this, you’ll need to activate the transform controls for use in the Program Monitor. For more information, see “Transforming a clip in the Program Monitor” on page 60.

**Note** If you are working with the Matrox crystallize, shadow, mask, mask blur, mask mosaic, or shine effect, the transform settings will apply only to your mask or shadow and not the entire clip.

Using the transform controls

To apply various transform settings to your clip using the transform controls in the Effect Controls panel, click the triangle next to the Transform property to expand it:

You can enter the values you want in the text boxes or drag the appropriate sliders.

- **(X, Y, Z) Position** Use these controls to position your clip on the x (horizontal), y (vertical), and z (depth) axes. Values of (0,0,0) pixels align the center of your clip with the center of the screen, and positions are measured from this point. You can enter positive or negative pixel values to move your clip right or left (x), up or down (y), and forward or backward (z).

Chapter 5, Setting Up Realtime Effects with Adobe Premiere Pro
• **(X, Y) Scale**  Use these controls to make your clip smaller or larger. Full-screen size is represented as 100%. You can shrink your clip to 0% or enlarge it to 1000%. Note, however, that by enlarging your clip, the resolution may become blurry. You can adjust the size controls individually, or if you select **Fixed Aspect Ratio**, you only need to adjust the x axis. Adjusting the percentage on the x and y axes changes your clip’s width and height, respectively.

  **Note**  Some effects, like Matrox surface finish, include a **Z Scale** property that allows you to adjust the depth of the effect.

• **(X, Y, Z) Rotation**  Use these controls to set the number of times the clip spins. Each rotation of 360° produces one spin on the selected axis. You can have positive or negative rotation from -360° to 360°.

• **(X, Y, Z) Rotation Center Offset**  Use the **Rotation Center Offset** controls to set the pivot point, or center of rotation, of your clip on the x (horizontal), y (vertical), and z (depth) axes. When **Rotation** settings are applied, your clip spins around this point. You can use positive or negative pixel values to offset your clip on each axis.

In the illustrations below, notice how different **Offset** values can affect the rotation of the cube.

![Figure 1: Offset at 0,0,0](image1.png)

![Figure 2: Offset at 100,0,0](image2.png)

In Figure 1, the **Offset** values are (0,0,0), so the center of rotation for the cube is where the x, y, and z axes meet. In Figure 2, the **Offset** value for the x axis is set to 100, thus moving the cube and the pivot point to the right, so when the cube is rotated, it has a wider arc when spinning around the axes.
Transforming a clip in the Program Monitor
You can use your left mouse button to resize, position, and rotate your clip directly in the Program Monitor. Effects that support transforming a clip in the Program Monitor have the Transform icon to left of the effect name in the Effects Controls panel.

Note When working with some effects, the Transform icon lets you manipulate your clip directly in the Program Monitor to set up your effect instead of adjusting transform settings as explained in this section.

To activate the transform controls in the Program Monitor, click the Transform icon or the name of the Matrox effect in the Effect Controls panel. The direct manipulation mode buttons will appear in the upper left corner of the Program Monitor:

Select the transform setting you want to adjust by clicking the appropriate button (Position, Scale, Rotation, or Rotation Center Offset). Precision Mode is available only in the Program Monitor and allows you to make precise adjustments with the currently selected transform setting.

The following table shows the available mouse controls for working in the Program Monitor.

<table>
<thead>
<tr>
<th>Action</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left mouse button</td>
<td>Adjusts x and y axes</td>
</tr>
<tr>
<td>SHIFT+left mouse button, drag left or right</td>
<td>Adjusts x axis only</td>
</tr>
<tr>
<td>SHIFT+left mouse button, drag up or down</td>
<td>Adjusts y axis only</td>
</tr>
<tr>
<td>CTRL+left mouse button, drag up or down</td>
<td>Adjusts z axis only</td>
</tr>
</tbody>
</table>

For example, if you want to alter the position of your clip on the y axis only, first click the Position button, then press and hold SHIFT while dragging the mouse up or down in the Program Monitor.
Cropping your clip

Many of the Matrox effects allow you to apply crop settings to your clip. To apply crop settings, click the triangle next to **Crop** to expand the property list.

**Note**  If you’re applying a Matrox effect that doesn’t provide the **Crop** property, you can apply realtime cropping to your clip using Adobe Premiere Pro’s crop effect (available in the Video Effects bin under Transform). The Premiere Pro crop effect will remain realtime unless you enable the **Zoom** option. For more information about using Premiere Pro’s crop effect, see your Adobe Premiere Pro documentation.

The controls under **Crop** let you crop any edge of your clip. You can enter the values you want in the text boxes or drag the appropriate sliders (**Left**, **Right**, **Top**, **Bottom**).

- **Crop Left** Crops the left edge of your clip.
- **Crop Right** Crops the right edge of your clip.
- **Crop Top** Crops the top edge of your clip.
- **Crop Bottom** Crops the bottom edge of your clip.
- **Select Crop** Displays a dialog box in which you can apply your crop settings. For details, see “Using Select Crop” on page 62.
- **Stretch to original size** Select this to stretch the cropped area to the original size of your clip. For the Matrox cube effect, this option is not available because the cropped area is automatically stretched to fit the original size.
Using Select Crop

To apply crop settings to your clip using the Select Crop dialog box, click the triangle next to the Select property to expand it, then click the Select Crop button:

Note  When working with the Matrox cube effect, Select Crop is available only for the primary source.

The Select Crop dialog box allows you to crop your clip in two ways:

- Click and drag directly in the Select Crop window to create the rectangular cropping area.

  To resize your cropping area, drag any side of the rectangle. For example, drag the right side of the rectangle to crop the right edge of your clip. To resize the entire cropping area at once, drag one of the corners (the corner that’s diagonally opposite the corner you are moving will remain stationary).

- Use the Left, Right, Top, and Bottom controls to crop any edge by a given number of pixels. You can enter values in the text boxes or drag the sliders to resize your crop area. For example, drag the Left slider to crop the left edge of your clip.
Applying a mask to your effect

Many of the Matrox effects allow you to add a mask to define the area where you want to apply your effect. For example, you may want to apply a color correction to only one area of your clip and leave the rest of the clip untouched.

Adding a mask to the chroma or luma key effect and selecting Transparent Outside Mask lets you disable keying in the area outside the mask so that only the underlying image appears outside the mask. For example, you can define a mask area where you want the keying to be performed, and show only your underlying image outside the mask. This is useful if you’re having problems keying on an area at the edges of your foreground image.

To adjust the mask properties:
Click the triangle next to Mask to expand the property list.

The properties under Mask let you control the area on the clip where you want to apply the mask. You can enter the values you want in the text boxes or drag the appropriate sliders (Left, Right, Top, and Bottom).

- **Left** Adjusts the left edge of your mask.
- **Right** Adjusts the right edge of your mask.
- **Top** Adjusts the top edge of your mask.
- **Bottom** Adjusts the bottom edge of your mask.
- **Select Mask** Displays a dialog box in which you can apply your mask settings (see “Using Select Mask” on page 64).
- **Invert** Inverts the mask so that your effect is applied outside the mask, instead of within the mask.
Using Select Mask
To apply a mask to your Matrox effect using the Select Mask dialog box, click the triangle next to the Select property to expand it, then click the Select Mask button:

The Select Mask dialog box allows you to apply a mask in two ways:

- Click and drag directly in the Select Mask window to create the rectangular area where you wish to apply the mask.
  
  You can resize the mask area by dragging any side of the rectangle. For example, dragging the right side of the rectangle adjusts the right edge of the mask area. To resize the entire mask area at once, drag one of the corners (the corner that’s diagonally opposite the corner you are moving will remain stationary).

- Use the Left, Right, Top, and Bottom controls to adjust any edge of your mask by a given number of pixels. You can enter values in the text boxes or drag the sliders to resize your mask area. For example, drag the Left slider to adjust the left edge of your mask area.

Chapter 5, Setting Up Realtime Effects with Adobe Premiere Pro
Creating a primary color correction

Color correction is important for all productions, whether you want to achieve continuity when cutting between shots, ensure broadcast safe levels, or establish and emphasize a “look.” Matrox color correction provides basic proc amp control, three-way color correction complete with master, shadows, midtones, and highlights control, and input and output level control. You can also easily match colors with a reference shot. For more information about color matching, see “Matching colors between two clips” on page 76.

Tip Adobe Premiere Pro includes a workspace setup that is optimized for working with clips and effects to facilitate color correction. To prepare your workspace for color correction, choose Window > Workspace > Color Correction.

To set up a Matrox primary color correction:
Click the triangle next to Matrox Color Correction (Primary) or Matrox Color Correction (Primary - Advanced) to expand the property list.

Note The RGB Curves and Tonal Range settings are available only with the advanced versions of the Matrox primary and secondary color correction effects. Because the advanced versions of these effects require additional system resources, you should apply them only if you want to use the RGB Curves or Tonal Range settings.

- Enable Split View Select this option to split your clip into two sections in the Program Monitor and on your video monitor. One section will display your clip as you adjust the color correction controls, and the other section of
the clip will remain unchanged. For more information, see “Using Split View” on page 67.

Important This option is for preview only. You should clear it before you render your clip, otherwise the split will appear in your video output.

- **Proc Amps** The processing amplifier (proc amp) controls allow you to adjust different aspects of your clip:
  - **Hue** Adjusts the tint of the colors in the image.
  - **Saturation** Adjusts the saturation (vividness) of the image’s colors.
  - **Contrast** Adjusts the difference in luminance between the lightest and darkest areas of the image.
  - **Brightness** Adjusts the level of black in the image.

- **RGB Curves** Lets you use curves to adjust the red, green, and blue color channels of your clip individually, or use a master curve to adjust all color channels simultaneously. For more information, see “Using RGB curves” on page 69.

- **Color Balance** These controls let you adjust the mixture of colors in your clip.
  - **Tonal Range** Allows you to fine-tune the tonal ranges of your clip by reducing the range of pixels included for shadows, midtones, or highlights. For more information, see “Adjusting tonal range” on page 71.
  - **Graphical** Allows you to see a graphical representation of your changes when you adjust the color balance settings. You can also modify most of the color balance settings directly within the graph. For more information, see “Using the color balance graph” on page 72.
  - **Numerical** Lets you adjust your color balance settings numerically by entering values in the text boxes, or by dragging the corresponding sliders. You can adjust the **Hue, Saturation, and Luminance** for each tonal range.
    - **Master (Hue, Saturation, and Luminance)** Affects all areas of your clip from the lightest white to the darkest black.
    - **Shadows (Hue, Saturation, and Luminance)** Affects the darkest areas of your clip.
    - **Midtones (Hue, Saturation, and Luminance)** Affects the areas with tones between the darkest and lightest areas of your clip.
    - **Highlights (Hue, Saturation, and Luminance)** Affects the lightest areas of your clip.

- **Luma Mapping**
  - **Graphical** Allows you to see a graphical representation of your changes when you adjust the luma mapping settings. You can also modify the
Creating a primary color correction luminance of your clip directly within the graph. For more information, see “Using the luma mapping graph” on page 78.

- **Numerical**  Lets you adjust the luma mapping settings numerically by entering values in the text boxes, or by dragging the corresponding sliders.

  - **Input Levels (Black and White)** These controls let you fine-tune your clip’s brightness and contrast by changing the luminance value that represents black, white, or gray. Doing so expands or compresses the range of luminance levels in your clip, which increases or decreases your clip’s tonal range.

    For example, by increasing the black value, you set black in your clip to a higher luminance value, which compresses the luminance range and darkens your clip proportionally.

  - **Output Levels (Black and White)** These controls let you map the values under **Input Levels** to any level of black and white. You can reduce contrast in your clip, or reverse the luminosity of your clip by setting black to a higher value than white.

  - **Gamma** Use this to adjust the midtones in your clip without adjusting black or white.

  - **Mask** Allows you to apply a mask to your effect. For more information, see “Applying a mask to your effect” on page 63.

**Using Split View**

The Split View option allows you to split your clip in two for preview on your Program Monitor and your video monitor. One section displays your clip as you adjust the color correction controls, while the other section of the clip remains unchanged.

There are two ways to enable Split View. You can select the **Enable Split View** option in the **Effect Controls** panel, or work directly in Adobe Premiere Pro’s Program Monitor using your mouse.

**Working with Split View in the Program Monitor**

To activate the Split View controls in the Program Monitor, click the Transform icon ( ) beside the name of the Matrox color correction effect in the **Effect Controls** panel. The Split View button will appear in the upper left corner of the Program Monitor:

![Split View button](image)

Enable Split View by clicking the Split View button. You can then drag the handles on the corners of the split rectangle to define the area you want to split. You can also drag the split rectangle to move it to a specific region of your clip.
The area within the split view rectangle will display any color correction you make, while the area outside remains unchanged.

In the following example, the split view rectangle has been moved to display the color correction in the area surrounding part of the Chinese character on the wall:

Remarks

- The Split View option is for preview only. You should disable it before rendering your material, otherwise the split will appear in your video output.

- If you are working in Adobe After Effects, you should enable Live Update mode so that any movement of the split rectangle is reflected in the Composition panel as it occurs.

- If you enable Split View and create a mask outside the split view rectangle, you will not be able to see it. The mask will only be visible when you move the split view rectangle directly over it. If you invert a mask that is not in the split view rectangle area, the whole clip will be inverted since the mask is ignored.
Using RGB curves

**Note**  The RGB Curves settings are available only with the advanced versions of the Matrox primary and secondary color correction effects.

With RGB curves, you can individually adjust the red, green, and blue color channels across the entire tonal range of your clip, or adjust all three color channels simultaneously with a master curve. RGB curves allow you to achieve color effects that would be difficult, if not impossible, to achieve using the Color Balance settings, and also give you a high degree of control over the color channels in each tonal range. For example, you can easily add a red, green, or blue tint to your clip, or use the master curve as a way to adjust the brightness and contrast of your clip.

Each curve is displayed on a grid with the horizontal axis representing the input or current pixel value, and the vertical axis representing the output value of the pixel after the curve adjustment is applied. By default, a curve starts as a straight line with two end points, one at the bottom left of the grid (shadows), and the other at the top right of the grid (highlights). Before any adjustments are made, each point on the curve has the same input and output value.
Click the R, G, or B button to select the curve corresponding to the color channel you want to adjust, or click the Master button for the master curve, and then drag the curve to obtain your desired effect. For example, click the R button and drag the top right end point towards the top left of the grid to increase the slope of the curve and add red to the clip. Drag that same point towards the bottom right of the grid to decrease the slope of the curve and remove red from the clip. Clicking the Enable button will show/hide any adjustments you have made to the RGB channels at any time (you do not need to click Enable to start adjusting the curves).

**Tip** For increased precision, hold down the ALT key while you drag the curve, or the CRTL key to change your cursor into a crosshair that will help you align your curve to the grid.

You can add up to 14 control points to each curve in addition to the two default end points. These control points act as anchors that allow you to lock your curve so adjustments can be applied only to specific tonal ranges. Click on a curve to add control points, and hold the SHIFT key while clicking a control point to delete it (end points cannot be deleted). Adjusting the points in the top right area of the grid affects highlights, the middle area affects midtones, and the bottom left area affects shadows. For example, the following S-shaped master curve adds contrast in the midtones range, without creating any completely black or white areas.
If you want to reset the Master, R, G, or B curve to its default setting at any time, click the appropriate Reset button.

**Tip** By applying a mask to your clip, you can adjust the RGB channels for that specific area of your clip, or invert the mask to isolate that same area from being affected by your RGB adjustments.

**Adjusting tonal range**

**Note** The Tonal Range settings are available only with the advanced versions of the Matrox primary and secondary color correction effects.

Using the tonal range curves allows you to fine-tune the range of pixels that are affected when you make a color correction to the shadows, midtones, or highlights of your clip using the color balance graph. For more information, see “Using the color balance graph” on page 72.

The histogram shows the distribution of pixels in each tonal range of your clip. In the following example, the histogram represents a clip with a high amount of shadows (left), a lesser amount of midtones (middle), and an even lesser amount of highlights (right).

Click the Shadows, Midtones, or Highlights button to select the curve corresponding to the tonal range you want to adjust, and then drag the curve as desired to reduce the number of pixels to be included in each tonal range.

**Note** You cannot increase the number of pixels in a tonal range. For example, you can’t extend the shadows curve into the highlights range.

Creating a primary color correction
Using the color balance graph

The color balance graph allows you to modify the **Color Balance** settings for each tonal range directly within the color maps. You can also perform an auto balance or a color match using the buttons beneath the color maps. For more information, see “Performing an auto balance” on page 75 and “Matching colors between two clips” on page 76. Depending on which color map you use, you can adjust your clip globally, or only the shadows, midtones, or highlights.

You can drag the handle in the center of any color map to adjust the color balance (**Hue** and **Saturation**) for a specific tonal range, such as to adjust the color balance globally throughout your clip using the **Master** color map, or adjust the color balance of only the shadows using the **Shadows** color map. Drag the handle toward a color you want to increase in your clip, or away from a color you
want to decrease. For example, if you move the handle towards red, you also decrease cyan by the same amount, as shown in the following diagram:

![Color Wheel Diagram]

Tip For increased precision, hold down the ALT key while you drag the handle. If you want to reset the color balance (Hue and Saturation) setting, click the Reset Color Balance button under the color map you are using.

To adjust the luminance for a tonal range, drag the corresponding luminance slider under the appropriate color map. For example, if you want to adjust the
luminance for only the shadows, drag the luminance slider under the **Shadows** color map.
Performing an auto balance
Before matching colors, you can perform an auto balance on your target clip to automatically apply a color shift to your clip to compensate for different lighting conditions. To do this, click the Auto Balance button under the corresponding color map and use the eyedropper to select the area you want to correct in your clip. For example, to balance your clip’s highlights, click the Auto Balance button under the Highlights color map, and click (or click and drag) on the lightest area of your clip. The auto balance is performed immediately.

Note To perform an auto white balance, click the Auto White Balance button under the Master color map, and click (or click and drag) on a white or light gray area of your clip.
Matching colors between two clips

You can perform a color match to match colors between two clips (such as skin tone, sky, etc.). The color match lets you select colors from a reference clip to match to your target clip. You can affect the colors globally (**Master**), or just the **Shadows**, **Midtones**, or **Highlights**.

You can select the colors for your reference color and match color by either clicking the Color Picker button or the eyedropper.

The eyedropper can be used in two ways:

- Click the eyedropper button and click on the desired color in your clip.
- Click the eyedropper button and click and drag anywhere on your clip to create a rectangular area containing the color you want to select. The selected color will be an average of the pixel information contained within the rectangle.

**To perform a color match:**

1. Prepare your workspace for color correction by choosing **Window > Workspace > Color Correction**.
2. Open your target clip (clip that contains the colors you want to correct) in the Source Monitor.
3. Apply the **Matrox Color Correction** effect to your target clip on the timeline.
4. Use the controls under the Reference Monitor to move to a frame in your reference clip that contains the colors you want to match.
5. Use the controls under the Source Monitor to go to the frame in your target clip that contains the colors you want to match to your reference clip.
6 Select a reference color from your reference clip by using the Reference Color eyedropper under the color map you want to affect (Master, Shadows, Midtones, or Highlights).

For example, to match a very dark color in your reference clip to your target clip, click the Reference Color eyedropper under the Shadows color map, and click (or click and drag) on the desired color in your reference clip.

7 Select a match color from your target clip in the Source Monitor window by using the Match Color eyedropper under the corresponding color map (Master, Shadows, Midtones, or Highlights).

Creating a primary color correction
Using the luma mapping graph

To modify your luma mapping values directly in the graph, click the triangle next to the Luma Mapping Graphical property to expand it:

- **Map**  This is the default view when you first expand the Graphical property. You can drag the handles in the graph to adjust the Input and Output levels for black and white, as well as the Gamma.

![Graph Diagram]

<table>
<thead>
<tr>
<th></th>
<th>Input Black Level</th>
<th>Input White Level</th>
<th>Output Black Level</th>
<th>Output White Level</th>
<th>Gamma</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
• **Plot**  Click this button to plot the luminance values in the current frame of your clip to the histogram (the plot will reflect any color correction changes you’ve made). Each luminance value present in your image appears as a vertical line in the histogram. A longer line indicates a higher amount of pixels in your image of that line’s luminance value. You can drag the handles in the graph to adjust the **Input** and **Output** levels for black and white, as well as the **Gamma**.

![Plot diagram]

<table>
<thead>
<tr>
<th>Input Black Level</th>
<th>Input White Level</th>
<th>Output Black Level</th>
<th>Output White Level</th>
<th>Gamma</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Input Black Level" /></td>
<td><img src="image2" alt="Input White Level" /></td>
<td><img src="image3" alt="Output Black Level" /></td>
<td><img src="image4" alt="Output White Level" /></td>
<td><img src="image5" alt="Gamma" /></td>
</tr>
</tbody>
</table>

• **Auto Black**  Click this to define the darkest pixels in your clip as black. The intermediate luminance values are proportionally redistributed.

• **Auto White**  Click this to define the lightest pixels in your clip as white. The intermediate luminance values are proportionally redistributed.

**Note**  If you want to restore the default luminance values at any time, click the **Restore Default Values** button.

![Restore Default Values button]

Creating a primary color correction
Creating a secondary color correction

Matrox secondary color correction offers all the properties found in Matrox primary color correction, with the added capability of limiting the color correction to a specific range of pixels using the selective key properties. For example, secondary color correction can be used to change the color of a dress, deepen the background sky color, or to achieve an effect where only one object or person remains in color while the rest of the image becomes black and white. For details on how to isolate a color and make the rest of the clip black and white, see “Creating a color pass effect” on page 90.

Tip  Adobe Premiere Pro includes a workspace setup that is optimized for working with clips and effects to facilitate color correction. To prepare your workspace for color correction, choose Window > Workspace > Color Correction.

To set up a Matrox secondary color correction:
Click the triangle next to Matrox Color Correction (Secondary) or Matrox Color Correction (Secondary - Advanced) to expand the property list.

Note  The RGB Curves and Tonal Range settings are available only with the advanced versions of the Matrox primary and secondary color correction effects. Because the advanced versions of these effects require additional system resources, you should apply them only if you want to use the RGB Curves or Tonal Range settings.
• **Enable Split View**  Select this option to split your clip into two sections in the Program Monitor and on your video monitor. One section will display your clip as you adjust the color correction controls, and the other section of the clip will remain unchanged. For more information, see “Using Split View” on page 67.

• **Proc Amps**  The processing amplifier (proc amp) controls allow you to adjust different aspects of your clip:
  - **Hue**  Adjusts the tint of the colors in the image.
  - **Saturation**  Adjusts the saturation (vividness) of the image’s colors.
  - **Contrast**  Adjusts the difference in luminance between the lightest and darkest areas of the image.
  - **Brightness**  Adjusts the level of black in the image.

• **RGB Curves**  Lets you use curves to adjust the red, green, and blue color channels of your clip individually, or use a master curve to adjust all color channels simultaneously. For more information, see “Using RGB curves” on page 69.

• **Color Balance**  These controls let you adjust the mixture of colors in your clip.
  - **Tonal Range**  Allows you to fine-tune the tonal ranges of your clip by reducing the range of pixels included for shadows, midtones, or highlights. For more information, see “Adjusting tonal range” on page 71.
  - **Graphical**  Allows you to see a graphical representation of your changes when you adjust the color balance settings. You can also adjust and modify most of the color balance settings directly within the graph. For more information, see “Using the color balance graph” on page 72.
  - **Numerical**  Lets you adjust your color balance settings numerically by entering values in the text boxes, or by dragging the corresponding sliders. You can adjust the **Hue**, **Saturation**, and **Luminance** for each tonal range.
    - **Master (Hue, Saturation, and Luminance)**  Affects all areas of your clip from the lightest white to the darkest black.
    - **Shadows (Hue, Saturation, and Luminance)**  Affects the darkest areas of your clip.
    - **Midtones (Hue, Saturation, and Luminance)**  Affects the areas with tones between the darkest and lightest areas of your clip.
    - **Highlights (Hue, Saturation, and Luminance)**  Affects the lightest areas of your clip.

• **Luma Mapping**
  - **Graphical**  Allows you to see a graphical representation of your changes when you adjust the luma mapping settings. You can also modify the

Creating a secondary color correction
luminance of your clip directly within the graph. For more information, see “Using the luma mapping graph” on page 78.

- **Numerical**  
  Lets you adjust your luma mapping settings numerically by entering values in the text boxes, or by dragging the corresponding sliders.
  
  - **Input Levels (Black and White)**  
    These controls let you fine-tune your clip’s brightness and contrast by changing the luminance value that represents black, white, or gray. Doing so expands or compresses the range of luminance levels in your clip, which increases or decreases your clip’s tonal range.
    
    For example, by increasing the black value, you set black in your clip to a higher luminance value, which compresses the luminance range and darkens your clip proportionally.

  - **Output Levels (Black and White)**  
    These controls let you map the values under **Input Levels** to any level of black and white. You can reduce contrast in your clip, or reverse the luminosity of your clip by setting black to a higher value than white.

  - **Gamma**  
    Use this to adjust the midtones in your clip without adjusting black or white.

- **Mask**  
  Allows you to apply a mask to your effect. For more information, see “Applying a mask to your effect” on page 63.

- **Selective Key**  
  The selective key settings allow you to apply the color correction effect to a specific range of pixels in your clip. Performing a selective key is similar to performing a chroma or luma key, however, with a selective key you are applying color correction to the keyed area instead of transparency. For example, if you use the selective key properties to select red as your **Hue** color, the color correction will be applied to the red regions in your clip. You can enable each keyer (**Hue**, **Saturation**, and **Luma**) individually, or enable all three at the same time to get the desired results.
  
  - **Graphical**  
    Allows you to see a graphical representation of your changes when you adjust the selective key **Numerical** settings. You can also modify the settings directly within the graph and perform an auto key. For more information, see “Using the selective key graph” on page 85.

- **Numerical**  
  Lets you adjust your key settings numerically by entering values in the text boxes, or by dragging the corresponding sliders.
  
  - **Hue Key**  
    This type of key lets you select areas to be keyed (affected by the color correction) based on their hue.
    
    - **Enable**  
      Select this to enable the **Hue Key** properties and hue key indicator in the selective key graph.
    
    - **Hue**  
      Use this to rotate the indicator around the perimeter of the color spectrum so that you can select different hues (colors) on which to key.
Creating a secondary color correction

- **Aperture** Use this to widen or narrow the aperture of the indicator to increase or decrease the range of colors on which you want to key.

- **Softness** Sets the amount of softness applied to the range of colors specified in the aperture region.

- **Saturation Key** This lets you select colors to be keyed (affected by the color correction) based on their saturation value. Pale colors have a low saturation value, while vivid colors have a high saturation value.
  - **Enable** Select this to enable the Saturation Key properties and saturation key indicator in the selective key graph.
  - **Low Clip** Use this to select the lower saturation values to be keyed.
  - **Low Gain** Use this to set the range of saturation values you want to be partially affected based on the value set by the Low Clip control. As you increase the Low Gain setting, more pixels are partially affected by the color correction. If you decrease the Low Gain control, less pixels are partially affected. A Low Gain setting of 100 provides the widest range for maximum color correction. Alternately, a gain setting of 0 creates a key where saturation values are either completely affected or left untouched. You can think of the Low Gain control as defining an “Affected to Untouched” range for keying the pale colors in your image.
  - **High Gain** This control is similar to the Low Gain setting, except you use it to set the range of higher saturation values you want to be partially affected based on the value set by the High Clip control. As you increase the High Gain setting, less pixels are partially affected by the color correction. If you decrease the High Gain setting, more pixels are partially affected. You can think of the High Gain control as defining an “Untouched to Affected” range for keying the vivid colors of your image.
  - **High Clip** This control is similar to Low Gain, except you use it to select the higher saturation values to be keyed.

  **Note** The values you can select using the Low Clip and Low Gain controls are dependent on the High Clip and High Gain controls, and vice versa. This prevents the low and high controls from keying on the same values.

- **Luma Key** This type of key lets you select areas to be keyed (affected by the color correction) based on their luminance value.
  - **Enable** Select this to enable the Luma Key properties and luma key indicator in the selective key graph.
  - **Low Clip** Use this to select the lower (darker) luminance values to be keyed. A Low Clip setting of 0 represents black, and a setting of...
255 represents white. Intermediate settings represent different shades of gray, from very dark to very light gray.

- **Low Gain**  Use this to set the range of luminance values you want to be partially affected based on the value set by the Low Clip control. As you increase the Low Gain setting, more luminance values become partially affected by the color correction.

  A Low Gain setting of 100 provides the widest range for maximum color correction. Alternately, a gain setting of 0 creates a key where the luminance values are either completely affected or left untouched. You can think of the Low Gain control as defining an “Affected to Untouched” range for keying the dark areas of your image.

- **High Gain**  This control is similar to Low Gain, except you use it to set the range of luminance values you want to be partially affected based on the value set by the High Clip control. You can think of the High Gain control as defining an “Untouched to Affected” range for keying the lighter areas of your image.

- **High Clip**  This control is similar to Low Clip, except you use it to select the higher (brighter) luminance values to be keyed.

  **Note**  The values you can select using the Low Clip and Low Gain controls are dependent on the High Clip and High Gain controls, and vice versa. This prevents the low and high controls from keying on the same luminance values.

- **Invert Key**  Select this to invert the key selection, giving you the opposite result of what you originally selected.

- **Show Key as Output**  Select this to display the matte used to define your selective key region. This enables you to further refine your key. Areas that are completely affected by the color correction are white, untouched areas are black, and gray areas are partially affected.

- **Expand Outside Mask**  Applies the color correction settings outside the mask area. This setting is especially useful when setting up a color pass effect where you have several objects of the same color but want to retain the color for only one object. For more information, see “Creating a color pass effect” on page 90.
Using the selective key graph

The selective key graph allows you to modify your selective key settings (Hue Key, Saturation Key, and Luma Key) directly in the graph. You can also perform an auto key.

- **Map**  This is the default view when you first expand the graphical property. You can drag the handles to move the indicator to different regions in the graph to adjust the Hue Key, Saturation Key, and Luma Key settings.

![Map View](image)

In order to see the indicator and handles, you have to enable the key setting you want to use. For example, if you want to adjust the Hue Key properties, you need to click the Hue button in the selective key graph or select the Enable option in the Hue Key numerical properties. In the following graph, the Hue properties have been enabled.

![Hue Properties Enabled](image)

- **Plot**  Click this button to plot the colors and luminance values that are present in the current frame of your clip. You can drag the handles to move the indicator to different regions in the graph to adjust the Hue Key, Saturation Key, and Luma Key properties. The luma plot histogram shows

Creating a secondary color correction
each luminance value present in your image as a vertical line. A longer line indicates a higher amount of pixels in your image of that line’s luminance value.

- **Hue** Click this button to enable or disable the Hue Key properties (Hue, Aperture and Softness). When enabled you will be able to see the Hue Key indicator and handles to modify the Hue Key properties in the selective key graph.

- **Sat** Click this button to enable or disable the Saturation Key properties (Low Clip, Low Gain, High Gain, and High Clip). When enabled you will

Chapter 5, Setting Up Realtime Effects with Adobe Premiere Pro
be able to see the **Sat Key** indicator and handles to modify the **Saturation Key** properties in the selective key graph.

**Tip** For both the **Saturation Key** and **Luma Key** properties, you can lock and move all the handles at the same time in the selective key graph by pressing **SHIFT** and then dragging any handle. If you press **CTRL**, you can lock and move either the **Low Clip** and **Low Gain** handles or **High Gain** and **High Clip** handles.

**Tip** For both the **Saturation Key** and **Luma Key** properties, you can lock and move all the handles at the same time in the selective key graph by pressing **SHIFT** and then dragging any handle. If you press **CTRL**, you can lock and move either the **Low Clip** and **Low Gain** handles or **High Gain** and **High Clip** handles.

Creating a secondary color correction
Note If you want to reset the hue, saturation, and luma key properties to the default settings at any time, click the appropriate Reset button.

- **Show Key** Click this button to display the matte used to define your selective key region. This enables you to further refine your key. Areas that are completely affected by the color correction are white, untouched areas are black, and gray areas are partially affected.

- **Auto Key** Click this button to automatically key on the most common color at the current frame (except gray). Selecting Auto Key affects values for the Hue Key, Saturation Key, and the Luma key properties. Alternately, you can use the auto key eyedropper to select a color on which you want to key.

  - The auto key eyedropper can be used in two ways:
    - Click the eyedropper button and click on a color on which you want to key.
    - Click the eyedropper button and click and drag anywhere on your clip to create a rectangular area containing the color on which you want to key. The selected color will be an average of the pixel information contained within the rectangle.

  You can further refine your auto key color by using the plus and minus eyedroppers.

For example, if you selected light red as your auto key color and would like a dark red color in your clip to be included in the auto key, you can use the plus eyedropper to select that dark red in your clip. To remove colors from your auto key, use the minus eyedropper.

Note The Show Key mode and any color correction applied will be temporarily deactivated in the Program Monitor when using an eyedropper.
Creating a secondary color correction

This allows you to see the original colors of your clip before any modifications were made.

- **Indicator**  Click this button to turn the indicator lines on or off.
- **Handles**  Click this button to turn the handles for the indicator lines on or off.
Creating a color pass effect

You can use the Matrox secondary color correction to create a color pass effect to convert your clip to black and white, with the exception of one specified color. This can be useful if you want to isolate a single color to make it prominent.

In the following example, the pink color of the girl’s shirt has been retained, while the rest of the clip has been converted to black and white:

To perform a color pass effect:
1. Click the Auto Key eyedropper in the selective key graph and click and drag anywhere on your clip to create a rectangular area containing the color you want to isolate.
2. Under Proc Amps, set the Saturation to 0.
3. Select Invert Key.

If you have more than one object of the same color but you want to isolate only one of those objects, you can apply a mask and use the Expand Outside Mask option to isolate the area that contains the color you want to remain intact. For example, if you have a clip that has two roses that are the same red and you would like only one of them to remain red, you can do the following.

To perform a color pass effect using the Expand Outside Mask option:
1. Click the auto key eyedropper in the selective key graph and click and drag anywhere on your clip to create a rectangular area containing the color you want to isolate.
2. Under Proc Amps set the Saturation to 0.
3. Select Invert Key.
4. Apply a mask surrounding the colored object you want to remain intact (see “Applying a mask to your effect” on page 63).
5. Select Expand Outside Mask.
Creating a 3D DVE effect

The Matrox 3D DVE effect lets you position your clips anywhere in 3D space while adding soft edges and rounded borders with color gradients in real time.

Note If you want to create a picture-in-picture effect, the move & scale effect will provide a sharper picture (see “Creating a move & scale effect” on page 126). To apply rotation to your effect, you must use the 3D DVE effect.

To set up a Matrox 3D DVE effect:
Click the triangle next to Matrox 3D DVE to expand the property list.

- Transform Use these properties to apply or change various transform settings, such as the position, scale, and rotation settings of your clip. For more information, see “Transforming your clip” on page 58.
- Border Settings Allow you to create a border or soft edge on your clip.
  - Border Outside Softness Lets you adjust the softness of the edge of your clip or outside edge of your border. The higher the softness value, the less sharp the edge becomes. If your clip is skewed, you may get more desirable results using the Border Outside Skewed Softness control.
  - Border Outside Skewed Softness If you altered your clip so that the perspective is skewed, you should use this option to apply softness to the edges of your clip.

Creating a 3D DVE effect
Border Type  Allows you to select the type of border you want (None, Flat, Gradient, or Alpha Edge). Click the triangle on the right to expand the list of border types.

Click here to select your border type

Note  The Alpha Edge border type is for use with alpha-keyed graphics only.

- Border Width  Use this control to adjust the border along the X and Y axes simultaneously. The higher the value, the wider your border becomes. If you clear Fixed Aspect Ratio, you can adjust each axis individually.
- X Border Width  Use this control to adjust the border along the X axis. The higher the value, the wider your border becomes.
- Y Border Width  Use this control to adjust the border along the Y axis. The higher the value, the wider your border becomes.
- Border Inside Softness  Sets the border softness on the inside edge of your border. The higher the softness value, the less sharp the edge or border becomes.
- Border Outside Color  Use the color picker or eyedropper to select the color you want for your border, or the outside edge of your border if you selected Gradient as your border type.
- Border Outside Transparency  Sets the transparency of your border, or outside edge of your border if you selected Gradient as your border type. Levels range from opaque (0) to fully transparent (100).

Note  The next two properties (Border Inside Color and Border Inside Transparency) are available only if you selected Gradient as your border type.

- Border Inside Color  Use the color picker or eyedropper to set the inside color of your border, which will create a gradient between this color and the outside color of your border.
- Border Inside Transparency  Sets the transparency of the inside color of your border.
- Round Corner Size  Allows you to round the corners on the edges of your border.
- Corner Point Offset  Allows you to move the position of the corner points of your border so that you can create various shapes for your 3D DVE. Negative values bring the corner points towards the center of the clip, while positive values move the corner points outward.
• **Crop**  Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.

• **Enhance Sharpness**  Lets you adjust the sharpness of your clip.
Creating a 4-corner pin effect

The Matrox 4-corner pin effect lets you anchor each corner of a video or graphics clip onto points in an underlying clip, even if the underlying clip is angled or skewed. You could use this effect, for example, to overlay a video clip onto an underlying clip of a television screen.

To set up a Matrox 4-corner pin effect:
Click the triangle next to Matrox 4-corner Pin to expand the property list.

- **Top Left** and **Top Right Corner**  Use these controls to horizontally and vertically position the top left and right corners of your clip.
- **Bottom Left** and **Bottom Right Corner**  Use these controls to horizontally and vertically position the bottom left and right corners of your clip.

Tip  You can easily position each corner of your clip directly in the Program Monitor. To do this, click the Transform icon ( ) beside Matrox 4-corner Pin in the Effect Controls panel. A cursor will appear at each corner of your clip in the Program Monitor. Drag these cursors to position the corners of your clip.

- **Edge Softness**  Lets you apply softness to the edges of your clip. If your clip is skewed, you may get more desirable results using the Skewed Edge Softness control.
- **Skewed Edge Softness**  If you altered your clip so that the perspective is skewed, you should use this option to apply softness to the edges of your clip.

Important  Skewed Edge Softness is not supported on clips where any corner is positioned beyond the boundaries of another corner. In order for the Skewed Edge Softness to work correctly, your clip should be a flat plane with four visible corners.

- **Crop**  Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.
• **Preview Settings** You can select the following options for previewing your effect:
  
  -- **Show Cursors** Displays a diamond-shaped cursor at each corner of your clip on your video monitor only. These cursors can help you precisely determine where each corner is located. Each corner has a different colored cursor as follows:
    - Top Left: Red
    - Top Right: Green
    - Bottom Left: Blue
    - Bottom Right: Orange
  
  -- **Show Color Frame Only** Displays a semi-transparent shape that represents the clip to which you are applying the 4-corner pin effect. This is useful if you're positioning an alpha-keyed title, for example, and you need to see the edges of the clip.
  
  -- **Color** To select a different color for the color frame, use the color picker button or the eyedropper.

  **Tip** The **Show Color Frame Only** option is provided as a viewing aid while setting up your 4-corner pin effect. However, you can choose to leave it selected to create a unique lighting effect, such as to create a flashlight beam.

• **Enhance Sharpness** Lets you adjust the sharpness of your clip.
Creating a blur/soft focus effect

The Matrox blur/soft focus effect lets you create unique effects and simulate camera defocus.

To set up a Matrox blur/soft focus effect:

Click the triangle next to Matrox Blur/Soft Focus to expand the property list.

- **Blur Amount**  Use this to change the amount of blurring in your clip.
- **Source Blend Factor**  Use this to superimpose the original image on top of your clip after you’ve applied blurring. A value of zero will show only the blur result, and a value of 100 will show only the original image. Anything in between will result in a blending of the blurring with the original image, therefore creating a soft focus effect.
- **Lock Colors**  Select this option to proportionally increase or decrease the red, green, and blue color gain. For example, any adjustments you make to the **Red Color Gain** will be used for the green and blue color gain as well.
- **Red Color Gain**  Lets you increase or decrease the red present in your image.
- **Green Color Gain**  Lets you increase or decrease the green present in your image.
- **Blue Color Gain**  Lets you increase or decrease the blue present in your image.
- **Crop**  Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.

Note: If you are working in HD, the blur/soft focus effect may require rendering based on certain setting combinations.

Chapter 5, Setting Up Realtime Effects with Adobe Premiere Pro
Overview of the chroma key effects

You can use the Matrox realtime plug-in to apply a chroma key or chroma key shadow effect to make certain areas of a foreground image transparent based on a color in that image, so that an underlying image can show through.

In the following example of a chroma key effect, our foreground image is a video clip of a woman sitting in front of a green backdrop, and our underlying image is a video clip of a sand dune:

By chroma keying on the particular shade of green in the backdrop of the foreground image, the backdrop area becomes transparent and the corresponding area of the underlying image shows through in the composite image as follows:

Important The chroma key shadow effect includes controls for fine-tuning shadows in your effect. It is best to use the chroma key shadow effect when you are performing a chroma key without any additional effects. If you want to apply additional effects to your chroma key, you will get more desirable results by using the chroma key effect without shadow controls. For example, if you want to apply a DVE to your chroma key, you should use the chroma key effect and not the chroma key shadow effect.

Overview of the chroma key effects
Creating a chroma key or chroma key shadow effect

To set up a Matrox chroma key or chroma key shadow effect, click the triangle next to Matrox Chroma Key/Matrox Chroma Key Shadow to expand the property list:

- **Graphical**  Provides a graphical representation of the chroma key controls that you can use to select your key colors, and also lets you perform an auto key.
  - **Map**  Lets you select your key colors within a circular graph that contains a color spectrum.
  - **Plot**  Displays a plot of the colors present in your clip so that you can select the particular colors on which you want to key.
  - **Show Key**  Click this button to display the matte used to create your key effect. This enables you to further refine your key. For example, when you display the matte, your key color (such as green) appears as black, and opaque areas appear as white. If you notice some white spots that you want to key, you can adjust the key controls until the undesired white spots disappear.
Creating a chroma key or chroma key shadow effect

– **Auto Key**  Click this button to automatically key on the most common color at the current frame in your clip (except gray).

For details on selecting key colors within the graph or performing an auto key, see “Using the chroma key graph to modify key colors and perform an auto key” on page 101.

**Note**  You must expand the **Graphical** property in order to see the indicator when adjusting the chroma key controls.

- **Hue**  Use this to rotate the indicator around the perimeter of the color spectrum so that you can select different hues (colors) on which to key.

- **Aperture**  Use this to widen or narrow the aperture of the indicator to increase or decrease the range of colors on which you want to key.

- **Saturation**  Use this to select colors that have a particular saturation value. Pale colors have a low saturation value and are located at or near the center of the spectrum. Vivid colors have a high saturation value and are located at or near the perimeter of the spectrum. Because pale colors have low saturation, you’ll find them more difficult to key on than the vivid colors.

- **Saturation Threshold**  Use this to proportionally increase or decrease the region outside of your saturation range. This controls how closely the **Saturation** value must match the key color before a region becomes transparent.

For example, after applying a chroma key effect to a foreground image that includes dark areas or shadows that you want to preserve in your effect, you may find that these areas have become semi-transparent. By adjusting the **Saturation Threshold**, you can eliminate the key color from these dark areas, so that they’ll become completely opaque.

- **Softness**  Use this to soften the edges of your key by blending parts of your foreground image with your underlying image. This makes certain areas of your foreground image partially transparent instead of completely transparent or opaque.

- **Spill Removal**  Use this to remove the contamination (spill) that your key color may leave on or around the edges of your foreground image. Spill is usually caused by light reflecting from your solid color backdrop (key color) onto your foreground image. **Spill Removal** replaces your key color from the “spill areas” with the opposite color in the spectrum, which returns a more natural look to these areas.

- **Chroma Suppression**  Use this to remove any tint that your key color imposes on your foreground image. For example, if your solid color backdrop (key color) is green and you are using a person in your foreground image, the person’s skin may have a green tint. You can adjust the **Chroma**
Suppression to replace the green tint with the opposite color in the spectrum to return the person’s skin to a more natural-looking color.

**Note** The following properties (**Luminance** and **Shadow Suppression**) are only available in the chroma key shadow effect.

- **Luminance** Use this to adjust the luminance of your shadow. Negative values increase the brightness of the shadow, while positive values decrease the brightness.
- **Shadow Suppression** Use this to make shadows in your clips less apparent. A higher value indicates less shadow.
- **Mask** Allows you to apply a mask to your effect. For more information, see “Applying a mask to your effect” on page 63.
- **Transparent Outside Mask** Select this option to apply transparency outside the mask area. This allows you to define a mask area where you want the keying to be performed, and show only your underlying image outside the mask. For more information, see “Applying a mask to your effect” on page 63.
- **Invert Key** Select this to invert the key selection, giving you the opposite result of what you originally selected.
- **Show Key as Output** Select this to display the matte used to create your key effect. This enables you to further refine your key. For example, when you display the matte, your key color (such as green) appears as black, and opaque areas appear as white. If you notice some white spots that you want to key, you can adjust the key controls until the undesired white spots disappear.
Using the chroma key graph to modify key colors and perform an auto key

To modify your key colors directly within the chroma key graph or perform an auto key, click the triangle next to the Graphical property to expand it:

- **Map** This is the default view when you first expand the Graphical property. You can drag the handles in the color spectrum to move the indicator to different regions in the cube to adjust the **Hue**, **Aperture**, **Saturation**, and **Saturation Threshold**.

- **Plot** Click this button to plot the colors and luminance values that are present in the current frame of your clip. You can drag the handles in the chroma plot graph to move the indicator to different regions in the graph to adjust the **Hue**, **Aperture**, **Saturation**, and **Saturation Threshold**. The luma plot histogram shows each luminance value present in your image as a

Creating a chroma key or chroma key shadow effect
vertical line. A longer line indicates a higher amount of pixels in your image of that line’s luminance value.

**Note** The Plot graph will contain a luma plot histogram only if you are creating a chroma key shadow effect. You can drag the handle in the luma plot histogram to adjust the Luminance.

<table>
<thead>
<tr>
<th>1 Hue</th>
<th>2 Saturation</th>
<th>3 Saturation</th>
<th>4 Aperture</th>
<th>5 Luminance Threshold</th>
</tr>
</thead>
</table>

- **Show Key** Click this button to display the matte used to create your key effect. This enables you to further refine your key. For example, when you display the matte, your key color (such as green) appears as black, and opaque areas appear as white. If you notice some white spots that you want to key, you can adjust the key controls until the undesired white spots disappear.

- **Auto Key** Click this button to automatically key on the most common color at the current frame (except gray). Selecting Auto Key affects values for Hue, Aperture, Saturation, and Saturation Threshold. If your clip consists of a uniform key color that is evenly lighted, Auto Key will usually give you a good-quality chroma key. Alternately, you can use the eyedropper to select a color on which you want to key.

You can use the eyedropper in two ways:
- Click the eyedropper button and click on a color on which you want to key.

Chapter 5, Setting Up Realtime Effects with Adobe Premiere Pro
– Click the eyedropper button and click and drag anywhere on your clip to select a rectangular area containing colors on which you want to key.

**Note**  The Show Key mode and any chroma key applied will be temporarily deactivated in the Program Monitor when using the auto key eyedropper. This allows you to see the original colors of your clip before any modifications were made.

- **Indicator**  Click this button to turn the indicator on or off.
- **Handles**  Click this button to turn the handles for the indicator on or off.
Creating a cube effect

The Matrox cube effect lets you map video or graphics to the faces of 3D cubes. These cubes can then be rotated in 3D space to create transition effects such as those you often see during sports broadcasts.

The Matrox cube effect supports up to three video sources (one primary source that the cube effect is applied on, and up to two additional sources). If you want to use additional sources in your cube effect, the additional source clips must be placed below, and in the same segment as, the primary source. Each additional source is identified by applying the Matrox Source Identifier effect to the clip.

You must identify each additional source with a unique ID. To do this, click the triangle beside Matrox Source Identifier to expand the property list, and then select an ID number from the Identify As list, as shown below. You can then reference the ID number using the Additional Sources setting of the Matrox cube effect.

To set up a Matrox cube effect:
In the Effect Controls panel, click the triangle beside Matrox Cube to expand the property list.
- **Additional Sources**  References up to two additional sources that you identified by applying the Matrox Source Identifier effect.
  - **Source 1**  Lets you select the unique ID number that you assigned to the first additional video source.
  - **Source 2**  Lets you select the unique ID number that you assigned to the second additional video source.

- **Cube Options**
  - **Face Edge Softness**  Sets the amount of softness to apply to the cube face edges.
  - **Cube Edge Softness**  Sets the amount of softness to apply to the outside edges of the cube.
  - **Depth**  Sets the depth of the cube.
  - **Highlight Color**  Sets the color that is used for highlights.
  - **Highlight Intensity**  Sets the brightness of the highlight.
  - **Shadow Color**  Sets the color that is used for shadows.
  - **Shadow Intensity**  Sets the darkness of the shadow.
  - **RGB Cube**  Sets all six cube faces to display a predetermined RGB color (front=red, back=green, left=blue, right=yellow, top=cyan, bottom=violet). Since color shows highlight and shadow better than video, this option is useful for viewing the results when you adjust the highlight and shadow settings.
  - **Show Light Direction**  Displays a three-dimensional arrow that gives a visual representation of the light direction that you can use as a viewing aid while adjusting the light rotation. The arrow is white when the light is directed away from you, and gets progressively darker as the light direction rotates towards you. Make sure you clear this option before exporting your final sequence.
  - **X Light Rotation**  Rotates the light along the x axis.
  - **Y Light Rotation**  Rotates the light along the y axis.
  - **Z Light Rotation**  Rotates the light along the z axis.

- **Cube Faces (Front, Back, Left, Right, Top, Bottom)**  All six cube faces share the following settings:
  - **Cube Face Source**  Sets whether the corresponding cube face displays a color, the primary source that the cube effect is applied on, or one of the two extra sources as selected under Additional Sources.
  - **Crop**  Allows you to crop the edges of your source clip. For more information, see “Cropping your clip” on page 61. The crop settings are available only when the corresponding face is set to display a video source.
Important  With the Matrox cube effect, the cropped area is automatically stretched to the original size of your clip. As a result, the output may exceed the cropped area.

- **Color Source Options**  The color source options are available only when the corresponding face is set to display a color, as specified using Cube Face Source.
  - **Color**  Sets the color to apply to the corresponding face.
  - **Alpha**  Sets the opacity of the color.

- **Transform**  Use these controls to apply or change various transform settings for your cube effect, such as the position, scale, and rotation of the cube. For more information, see “Transforming your clip” on page 58.

- **Enhance Sharpness**  Lets you adjust the sharpness of your clip.
Creating a crystallize effect

The Matrox crystallize effect lets you choose from many different patterns that you can use to make your image or text appear as if it is made of crystals.

To set up a Matrox crystallize effect:

Click the triangle beside Matrox Crystallize to expand the property list.

- **Select Shape**  Click the button to the right of the current pattern to see the list of available crystal patterns.

- **Smoothness**  Sets the smoothness applied to the colors in the crystal pattern. The higher the value, the less sharp the colors become.

- **Crystal Opacity**  Sets the opacity of the crystals. Levels range from completely transparent (0) to opaque (100).

- **Crystallize Alpha Channel**  Enables alpha for the crystallize effect, so the crystals will remain visible even on the anti-aliased edges of a title or DVE. This option is enabled by default, but can be cleared if you find that the crystals make your title difficult to read.

  **Note**  Crystallize Alpha Channel is applicable only when your source clip or an effect applied to your source clip contains alpha key information. For example, if you apply the crystallize effect to a clip with no alpha key information and scale it down using Adobe’s Motion effect, the crystals will not be visible on the edges of your clip because the Motion effect is the last effect applied, and there is no alpha key information to crystallize. Whereas, if you apply a Matrox 3D DVE to the same clip and then you apply the crystallize effect, you will be able to apply and see the crystallized edges, because the Matrox 3D DVE effect contains alpha information.

- **Mask Settings**  Let you select a mask pattern and adjust the transparency settings to define the area where you want to apply your crystallize effect.
  - **Enable Mask**  Select this option to enable the mask.

*Creating a crystallize effect*
Chapter 5, Setting Up Realtime Effects with Adobe Premiere Pro

- **Select Shape**  Click the button to the right of the current pattern to see the list of available mask patterns.

- **Shape Transparency**  Sets the transparency of the shape and the area around the shape. At the default setting (0), the shape is completely opaque and the area around the shape is transparent. Dragging the slider to the left increases the transparency of the shape, which makes the crystallize effect less apparent. Dragging the slider to the right decreases the transparency of the area around the shape, which increases the amount of crystals outside the mask area.

- **Outside Transparency**  Sets the transparency level of the area outside your mask.

  **Note**  The **Outside Transparency** setting is applicable only if you’ve scaled down, moved, or rotated your mask using the transform controls so that the mask doesn’t cover the entire screen.

- **Softness**  Lets you apply the crystallize effect to the edges of your mask.

- **Invert Mask**  Select this option if you want to invert the opaque and transparent areas of your mask.

- **Apply Crop to Video Only**  Select this if you want the mask to be squeezed to fit your cropped clip. If you don’t select this option, the mask will be cropped by the same amount that you crop your clip.

- **Transform**  Use these properties to apply or change various transform settings, such as the position, scale, and rotation settings of your mask. For more information, see “Transforming your clip” on page 58.

- **Crop**  Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.
Creating a garbage matte effect

The Matrox 4-point, 8-point, and 16-point garbage matte effects let you use individual control points to determine the shape of a garbage matte applied to a clip to superimpose it onto another clip. You can use these effects to create a garbage matte for cropping unwanted objects from a foreground image in a chroma or luma key effect. For example, by applying a garbage matte to your key foreground image, you can drag up to 16 control points to crop specific areas of your clip and show only your underlying image outside the matte.

To set up a Matrox garbage matte effect:
Click the triangle next to Matrox Garbage Matte - 4 Points, Matrox Garbage Matte - 8 Points, or Matrox Garbage Matte - 16 Points to expand the property list:

- **Matte Settings** The particular control points available depend on the type of garbage matte effect that you applied (4-, 8- or 16-point). Use the provided control points to adjust the shape of your garbage matte. The values represent the horizontal and vertical positions of each control point.

  **Tip** You can easily position each control point directly in the Program Monitor. To do this, click the Transform icon ( ) beside the effect name in the Effect Controls panel. A cursor will appear at each control point in the Program Monitor. Drag these cursors to adjust the shape of your garbage matte.

- **Matte Opacity** Use this to set the opacity of your garbage matte. Levels range from completely transparent (0) to opaque (100).
• **Edge Softness**  Lets you apply softness to the edges of your garbage matte.

• **Invert Matte**  Select this option if you want to invert the opaque and transparent areas of your garbage matte.

• **Show Matte Only**  Select this to display only the matte used to create your garbage matte (displayed as a white video clip).
Creating an impressionist effect

The Matrox impressionist effect lets you choose from many different patterns that you can use to make your image appear similar to an impressionist painting.

- **Select Shape**  
  Click the button to the right of the current pattern to see the list of available impressionist patterns.

- **Brush Stroke Count**  
  - *(X&Y)* Brush Stroke Count  
    Use these to specify the number of brush strokes along the x and y axes. If you select Link X&Y, you only need to adjust the X Brush Stroke Count and the Y Brush Stroke Count will be set to the same value.

- **Rotation**  
  - Mean Rotation  
    Use this to adjust the rotation of the brush strokes. Positive values rotate the brush strokes clockwise, and negative values rotate the brush strokes counterclockwise.
  
  - Rotation Variation  
    Use this to set the maximum percentage that a brush stroke will rotate in relation to the Mean Rotation value. For example, if you set the Rotation Variation value to 5%, the brush strokes will randomly rotate between -5 and 5% of the Mean Rotation value. Some brush strokes will rotate clockwise, and some will rotate counterclockwise.

- **Size**  
  - X Mean Size  
    Specifies the size of the brush stroke along the x axis.
  
  - X Size Variation  
    Use this to set the maximum percentage that a brush stroke will grow in relation to the X Mean Size value. For example, if you
set the **X Size Variation** value to 5%, the brush strokes will randomly grow between 0 and 5% of the **X Mean Size** value.

- **Y Mean Size**  
  Specifies the size of the brush stroke along the y axis.

- **Y Size Variation**  
  Use this to set the maximum percentage that a brush stroke will grow in relation to the **Y Mean Size** value. For example, if you set the **Y Size Variation** value to 5%, each brush stroke will randomly grow between 0 and 5% of the **Y Mean Size** value.

- **Link X&Y**  
  If you select this option you only need to adjust the x size values, and the y size values will be identical.

- **Preserve Aspect Ratio**  
  Select this option to keep the shape of your brush strokes similar. For example, if your brush strokes are rectangular, adjusting the variation controls may alter their shape. Selecting this option will preserve it.

**Position**

- **X Mean Position**  
  Sets the position of the brush strokes along the x axis.

- **X Position Variation**  
  Use this to set the maximum percentage that a brush stroke will move in relation to the **X Mean Position** value. For example, if you set the **X Position Variation** value to 5%, each brush stroke will randomly move between 0 and 5% of the **X Mean Position** value.

- **Y Mean Position**  
  Sets the position of the brush strokes along the y axis.

- **Y Position Variation**  
  Use this to set the maximum percentage that a brush stroke will move in relation to the **Y Mean Position** value. For example, if you set the **Y Position Variation** value to 5%, each brush stroke will randomly move between 0 and 5% of the **Y Mean Position** value.

- **Link X&Y**  
  If you select this option you only need to adjust the x size values, and the y size values will be identical.

**Brush Opacity**

- **Mean Opacity**  
  Use this to set the opacity of the brush strokes. Levels range from completely transparent (0) to opaque (100).

- **Opacity Variation**  
  Use this to set the maximum percentage of opacity that a brush stroke will reach in relation to the **Mean Opacity**. For example, if you set the **Mean Opacity** value to 5%, the opacity for each brush stroke will be randomly set between 0 and 5% of the **Mean Opacity** value.

**Smoothness**  
Sets the smoothness applied to the colors in the brush strokes. The higher the value, the less sharp the colors become. This is useful if you want to remove artifacts that may appear when using a brightly colored image.

**Use Original Alpha**  
Select this option if you would like the brush strokes to be confined within the transparent areas in your clip. This is useful if you are using a title.
• **Blend Over Original**  Use this to blend the brush strokes with your original image. This is useful when you are using smaller brush strokes and want to reduce any semi-transparent areas around the brush strokes.

• **Texture Map Method**  Use the menu on the right to choose how your brush stroke colors will be processed.
  
  – **Preprocess**  The brush stroke colors are based on the underlying pixels of the original image. When you move the brush strokes, they retain their original color.
  
  – **Postprocess**  The brush stroke colors change with the underlying colors of the clip. For example, if your brush strokes are mostly blue and then they are moved to an area of the clip that contains red, they will turn red.

• **Random Seed**  Adjust this setting to change the placement of brush strokes in your clip. The brush strokes are randomly affected based on the value you select. For example, if you notice the brush strokes in your clip are always in the same place, you can use this setting to move them.

• **Crop**  Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.

Creating an impressionist effect
Creating a lens flare effect

The Matrox lens flare effect lets you simulate the light refractions caused by shining a bright light into the lens of a camera when taking a photo. You can choose from many different lens flare patterns.

To set up a Matrox lens flare effect:
Click the triangle beside Matrox Lens Flare to expand the property list.

- **Light Source Position**
  - **X & Y Position** Sets the position of the light source along the horizontal and vertical axes. The refractions caused by the light source will move in accordance with its position.
  - **Z Position** Sets the depth of the light source.

  **Tip** You can easily adjust the light source position directly in the Program Monitor. To do this, click the Transform icon ( ) beside Matrox Lens Flare in the Effect Controls panel. A crosshair will appear in the Program Monitor. Drag the crosshair to position the light source along the horizontal and vertical axes.

- **Center Position**
  - **X Position** Sets the position of the lens flare along the horizontal axis.
  - **Y Position** Sets the position of the lens flare along the vertical axis.

- **Select Shape** Click the button to the right of the current pattern to see the list of available lens flare patterns.

- **Global Settings**
  - **(X, Y) Scale** Use these controls to make your lens flare smaller or larger. Full-screen size is represented as 100%. You can shrink your lens flare to 0% or enlarge it to 1000%. Note, however, that by enlarging your clip, the resolution may become blurry. You can adjust the size controls individually, or if you select **Fixed Aspect Ratio**, you only need to adjust the x axis.
Adjusting the percentage on the x and y axes changes the lens flare’s width and height, respectively.

- **Intensity** Sets the opacity of the light refractions. Levels range from completely transparent (0) to opaque (100).

- **Enable Alpha** Select this option to enable alpha for the lens flare, so it will remain visible even on transparent (keyed) areas of your clip.

**Flare Settings** Adjusting these settings will change the appearance of the flare (usually the brightest spot) in the lens.

- **Size** Sets the size of the flare.

- **Intensity** Sets the opacity of the flare. Levels range from completely transparent (0) to opaque (100).

- **Color** Sets the color of the flare.

**Note** While most of the lens flare patterns contain a flare, some of them do not. If you choose a pattern without a flare, these settings aren’t applicable.

- **Crop** Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.
Overview of the luma key effect

You can use the Matrox realtime plug-in to apply a luma key to make certain areas of a foreground image transparent based on the luminance in that image, so that an underlying image can show through.

In the following example of a luma key effect, two video clips are combined to produce the effect of two cowboys riding through fire. Our foreground image is a video clip of a ring of fire against a black background, and our underlying image is a video clip of two men riding horses:

By luma keying on the particular luminance (brightness) of the black areas in the foreground clip, these areas become transparent and the corresponding areas of the underlying image show through in the composite image as follows:

Result of luma key
Creating a luma key effect

To set up a Matrox luma key effect, click the triangle next to Matrox Luma Key to expand the property list:

- **Graphical**  Allows you to see a graphical representation of your changes when you adjust the property settings. You can adjust the luma key properties directly in the graph to select the luminance values on which you want to key. For more information, see “Using the luma key graph” on page 118.

- **Transparency**  Use this control to set the transparency level of your key effect. Higher values indicate higher transparency. For example, a Transparency value of 100 makes the keyed area in your foreground image completely transparent, leaving the underlying image visible.

- **Low Clip**  Use this to select the lower (darker) luminance values to be keyed. A Low Clip setting of 0 represents black, and a setting of 255 represents white. Intermediate settings represent different shades of gray, from very dark to very light gray.

- **Low Gain**  Use this to set the range of luminance values you want to be partially transparent based on the value set by the Low Clip control. As you increase the Low Gain setting, more luminance values become partially transparent to give you a softer-edged key.

A Low Gain setting of 100 provides the widest range for maximum softness. Alternately, a gain setting of 0 creates a hard key where the luminance values are either completely transparent or opaque. You can think of the Low Gain
control as defining a “Transparent to Opaque” range for keying the dark areas of your foreground image.

- **High Clip**  This control is similar to **Low Clip**, except you use it to select the higher (brighter) luminance values to be keyed.

- **High Gain**  This control is similar to **Low Gain**, except you use it to set the range of luminance values you want to be partially transparent based on the value set by the **High Clip** control. You can think of the **High Gain** control as defining an “Opaque to Transparent” range for keying the lighter areas of your foreground image.

**Note**  The values you can select using the **Low Clip** and **Low Gain** controls are dependent on the **High Clip** and **High Gain** controls, and vice versa. This prevents the low and high controls from keying on the same luminance values.

- **Mask**  Allows you to apply a mask to your effect. For more information, see “Applying a mask to your effect” on page 63.

- **Transparent Outside Mask**  Select this option to apply transparency outside the mask area. This allows you to define a mask area where you want the keying to be performed, and show only your underlying image outside the mask. For more information, see “Applying a mask to your effect” on page 63.

- **Invert Key**  Select this to invert the key selection, giving you the opposite result of what you originally selected

- **Show Key as Output**  Select this to display the matte used to create your key effect. This enables you to further refine your key settings. For example, when you display the matte, areas of your clip that are completely transparent appear as black, and opaque areas appear as white. If you notice some white spots that you want to key, you can adjust the key controls until the undesired white spots disappear.

**Using the luma key graph**

The luma key graph contains a luminance spectrum and a luminance eyedropper. You can drag the handles in the luminance spectrum to adjust the **Transparency**, **Low Clip**, **High Clip**, **Low Gain**, and **High Gain** properties.

Chapter 5, Setting Up Realtime Effects with Adobe Premiere Pro
You can select luminance values on which to key by adjusting the **Low Clip** and **High Clip** handles, or you can use the luminance eyedropper to automatically pick the luminance value you want to key on. The eyedropper can be used in two ways:

- Click the eyedropper button and click on the color with the desired luminance value in your clip.
- Click the eyedropper button and click and drag anywhere on your clip to create a rectangular area containing the luminance values you want to select. The selected luminance will be an average of the luminance values contained within the rectangle.

**Note**  Any luma key displayed in the Program Monitor will be temporarily deactivated when using the luminance eyedropper. This allows you to see the colors of your clip before any modifications were made.

You can also adjust the softness of your key with the **Low Gain**, **High Gain**, and **Transparency** handles. All these adjustments affect the shape and size of the luminance selector as follows:

- **Plot**  Click this button to see the luminance spectrum with a plot that shows each luminance value present in your image as a vertical line in the histogram. A longer line indicates a higher amount of pixels in your image of that line’s luminance value. You can drag the handles in the luma plot spectrum to adjust the **Transparency**, **Low Clip**, **High Clip**, **Low Gain**, and **High Gain** properties. Any adjustments made affect the shape and size of the luminance selector in the **Luma Plot**.

Creating a luma key effect
Creating a mask effect

The Matrox mask effect lets you choose from dozens of soft-edged cutout shapes that you can apply to a clip to superimpose it onto another clip.

To set up a Matrox mask effect:
Click the triangle beside Matrox Mask to expand the property list.

- **Select Shape** Click the button to the right of the current pattern to see the list of available mask patterns.

- **Shape Transparency** Sets the transparency of the shape and the area around the shape. At the default setting (0), the shape is completely opaque and the area around the shape is transparent. Dragging the slider to the left increases the transparency of the shape. Dragging the slider to the right decreases the transparency of the area around the shape.

- **Outside Transparency** Sets the transparency level of the area outside your mask.

  Note  The Outside Transparency setting is applicable only if you’ve scaled down, moved, or rotated your mask using the transform controls so that the mask doesn’t cover the entire screen. When Outside Transparency is applied, the Shape Transparency sets the overall transparency of the entire clip.

- **Softness** Applies softness to the edges of your mask.

- **Invert Mask** Select this option if you want to invert the opaque and transparent areas of your mask.

  Note  For best results, set the Outside Transparency to 100% when transforming a clip that has Invert Mask applied.
• **Apply Crop to Video Only**  Select this if you want the mask to be squeezed to fit your cropped clip. If you don’t select this option, the mask will be cropped by the same amount that you crop your clip.

• **Transform**  Use these controls to apply or change various transform settings for your mask effect, such as the position, scale, and rotation of the mask. For more information, see “Transforming your clip” on page 58.

• **Crop**  Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.
Creating a mask blur effect

The Matrox mask blur effect lets you create a “region of interest” by adding a mask to your clip and applying blurring to it. You can choose from many different mask patterns.

To set up a Matrox mask blur effect:
Click the triangle beside Matrox Mask Blur to expand the property list.

- **Blur Settings**  Lets you adjust the amount of blurring in your clip.
  - **Red, Green, Blue, and Alpha Blur Amount**  Use these controls to adjust the amount of blurring to be applied to each of the color and alpha channels in your clip. For example, you can choose to apply blurring to only the red color component of your clip. The **Alpha Blur Amount** is applicable only to graphics clips that have an alpha channel.
  - **Lock Channels**  Select this to apply the same blur settings to all channels. When you adjust the setting for the **Red Blur Amount**, the same settings will be applied to the other channels.

- **Color Gain Settings**  Let you adjust the amount of color in your clip within the blurred area.
  - **Red, Green, and Blue Color Gain**  Use these controls to individually fine-tune the intensity of a particular color present in your clip. For example, you can increase the **Red** value to increase only the red color component of your clip within the blurred area.
  - **Lock Channels**  Select this to apply the same color gain settings to all channels. When you adjust the setting for the **Red Color Gain**, the same settings will be applied to the other channels.

- **Mask Settings**  Let you select the mask pattern and adjust the transparency settings for your effect.
  - **Select Shape**  Click the button to the right of the current pattern to see the list of available mask patterns.
    - **Shape Transparency**  Sets the transparency of the shape and the area around the shape. At the default setting (0), the shape is completely opaque.
and the area around the shape is transparent. Dragging the slider to the left increases the transparency of the shape, which makes the blur less apparent. Dragging the slider to the right decreases the transparency of the area around the shape, which increases the amount of blurring outside the mask area.

- **Outside Transparency**  Sets the transparency level of the area outside your mask.

  **Note** The *Outside Transparency* setting is applicable only if you’ve scaled down, moved, or rotated your mask using the transform controls so that the mask doesn’t cover the entire screen.

- **Softness**  Lets you apply blurring to the edges of your mask.

- **Invert Mask**  Select this option if you want to invert the opaque and transparent areas of your mask.

- **Apply Crop to Video Only**  Select this if you want the mask to be squeezed to fit your cropped clip. If you don’t select this option, the mask will be cropped by the same amount that you crop your clip.

- **Transform**  Use these controls to apply or change various transform settings for your mask blur effect, such as the position, scale, and rotation of the mask. For more information, see “Transforming your clip” on page 58.

- **Crop**  Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.

  **Note** If you are working in HD, the mask blur effect may require rendering depending on your sequences’s video format.
Creating a mask mosaic effect

The Matrox mask mosaic effect lets you create a “region of interest” by adding a mask to your clip and applying a mosaic effect to it. You can choose from many different mask patterns.

To set up a Matrox mask mosaic effect:
Click the triangle beside Matrox Mask Mosaic to expand the property list.

• Mosaic Settings  Let you adjust the size of the mosaic blocks and the sharpness of the color in the mosaic effect.
  – Block Width and Block Height  Use these controls to set the width and height of the mosaic blocks in your effect. If you select Fixed Aspect Ratio, you only need to adjust the block width and the height will be set to the same value.
  – Color Sharpness  Select this to sharpen the color of each mosaic block in your effect. This causes each block to take on the predominant color of that section of the underlying image (instead of the average color).

• Mask Settings  Let you select the mask pattern and adjust the transparency settings for your effect.
  – Select Shape  Click the button to the right of the current pattern to see the list of available mask patterns.

  – Shape Transparency  Sets the transparency of the shape and the area around the shape. At the default setting (0), the shape is completely opaque and the area around the shape is transparent. Dragging the slider to the left increases the transparency of the shape, which makes the mosaic effect less apparent. Dragging the slider to the right decreases the transparency of the area around the shape, which increases the amount of mosaic outside the mask area.
  – Outside Transparency  Sets the transparency level of the area outside your mask.
Note The Outside Transparency setting is applicable only if you’ve scaled down, moved, or rotated your mask using the transform controls so that the mask doesn’t cover the entire screen.

- Softness Lets you apply the mosaic effect to the edges of your mask.
- Invert Mask Select this option if you want to invert the opaque and transparent areas of your mask.
- Apply Crop to Video Only Select this if you want the mask to be squeezed to fit your cropped clip. If you don’t select this option, the mask will be cropped by the same amount that you crop your clip.
- Transform Use these controls to apply or change various transform settings for your mask mosaic effect, such as the position, scale, and rotation of the mask. For more information, see “Transforming your clip” on page 58.

- Crop Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.
Creating a move & scale effect

The Matrox move & scale effect lets you position and scale your clips anywhere in 2D space while adding soft edges in real time.

**Note**  The move & scale effect provides the sharpest picture when creating a picture-in-picture effect. However, if you want to apply rotation to your effect, you must use the 3D DVE effect as explained in “Creating a 3D DVE effect” on page 91.

**To set up a Matrox move & scale effect:**
Click the triangle next to **Matrox Move & Scale** to expand the property list.

- **2D Transform**
  - **(X, Y) Position**  Use these controls to position your clip on the x (horizontal) and y (vertical) axes. X and y values of 0.0 pixels align the center of your clip with the center of the screen, and positions are measured from this point. You can enter positive or negative pixel values to move your clip right or left (x), and up or down (y).
  
  - **(X, Y) Scale**  Use these controls to make your clip smaller or larger. Full-screen size is represented as 100%. You can shrink your clip to 0% or enlarge it to 1000%. Note, however, that by enlarging your clip, the resolution may become blurry. You can adjust the size controls individually, or if you select **Fixed Aspect Ratio**, you only need to adjust the x axis. Adjusting the percentage on the x and y axes changes your clip’s width and height, respectively.
  
  - **Anchor Point X & Y**  Sets the point of origin from which to scale your clip along the x (horizontal) and y (vertical) axes.

- **(X, Y) Edge Softness**  Lets you apply softness to the edges of your clip along the x (horizontal) and y (vertical) axes. You can adjust the softness controls individually or if you select **Fixed Aspect Ratio**, you only need to adjust the x axis. The higher the softness value, the less sharp the edges become.
– **Nonlinear Softness** Select this option to make the boundaries of the softness region less obvious. Enabling this option makes your edge softness controls produce results similar to the border softness controls in the Matrox 3D DVE effect.

- **Crop** Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.
- **Enhance Sharpness** Lets you adjust the sharpness of your clip.
Creating an old movie effect

The Matrox old movie effect lets you create an old film look on your clips by adding noise, dust, streaks, jitter, and flickers.

To set up a Matrox old movie effect:
Click the triangle beside Matrox Old Movie to expand the property list.

- Random Artifact Generator  Adjust this setting to change the placement of artifacts in your clip. The artifacts are randomly distributed based on the value you select. For example, if you notice the streaks in your clip are always in the same place, you can use this setting to move them.

- Border Settings
  - Round Corner Size  Allows you to round the corners on the edges of your clip.
  - Softness  Lets you adjust the amount of softness on the edge of your clip by dragging the slider or entering a percentage in the text box. The higher the value, the less sharp the edge will become.

- Preprocessing  These controls allow you to isolate a channel to process black and white values for your effect. For example, to adjust black and white values on the red channel only, select Red Only as your mode.
  - Enable Preprocessing  Select this option to enable preprocessing. Enabling this option will turn your clip black and white.

  **Note**  Adjusting the Color Gain and Color Addition controls will change the color of your clip. If you would like your clip to remain black and white, select Lock Colors for both the Color Gain and Color Addition.

  - Mode  Lets you select the channel you want to use for the processing. Click the triangle on the right to expand the list.
    - Red Only  Uses the red channel.
Creating an old movie effect

- **Green Only** Uses the green channel.
- **Blue Only** Uses the blue channel.
- **Alpha Only** Uses the alpha channel.
- **Luma** Uses the luminance values.
- **Oversaturated Luma** Uses the oversaturated luminance values only.

- **Noise**
  - **Noise Pattern** Allows you to select a noise pattern. Click the button on the right to see the list of available patterns.
  - **Lifetime** Sets the maximum number of frames that the noise pattern will remain immobile before moving to another random position.
  - **Opacity** Sets the opacity of the noise pattern. Levels range from completely transparent (0) to opaque (100).
  - **Color** Use this to set the noise color.

- **Dust**
  - **Dust Pattern** Allows you to select a dust pattern. Click the button on the right to see the list of available patterns.
  - **Amount** Sets the maximum number of dust particles that can be visible at any given time.
  - **Lifetime** Sets the maximum number of frames that the dust pattern will remain immobile before moving to another random position.
  - **Opacity** Sets the opacity of the dust pattern. Levels range from completely transparent (0) to opaque (100).
  - **Color** Use this to set the dust color.

- **Fixed Particle**
  - **Display Fixed Particle** Select this option if you would like one of the dust particles to remain fixed on your image.
  - **Particle Number** Use this to select the particle you want to remain fixed on your image. Each dust particle is represented by a value.
  - **X Position** Sets the position of the fixed particle along the horizontal axis.
  - **Y Position** Sets the position of the fixed particle along the vertical axis.
• Streak
  – **Streak Pattern** Allows you to select a streak pattern. Click the button on the right to see the list of available patterns.

  ![Click here to select a streak pattern](image)

  – **Amount** Sets the maximum number of streaks that can be visible at any given time.
  – **Opacity** Sets the opacity of the streak pattern. Levels range from completely transparent (0) to opaque (100).
  – **Color** Use this to set the streak color.

• Jitter
  – **Manual Control** Select this option to disable **Probability** and manually control the amount of jittering by using only the **Offset** control.
  – **Probability** Specifies how often the jitter will occur. The higher the value the more probable the jitter.
  – **Offset** Specifies how far the image jitters vertically upward.
  – **Distance Between Frames** Sets the space in between the current frame and the next frame jittering upwards. The higher the value, the more space between the two frames.

• Flicker
  – **Manual Control** Select this option to manually control when the flickering occurs by using only the **Highest Intensity** control. Enabling this option will disable all other flicker controls.
  – **Frequency** Specifies the amount of flickering that occurs. The higher the value, the more flickering you will see.
  – **Lowest Intensity** Sets the lowest level of brightness, which creates a progression from dark to bright between this level and the **Highest Intensity** level during the flicker. Lower values will start the flicker at a darker level. For example, if you want your flickering to progress from complete darkness to normal brightness, you would select 0% for the **Lowest Intensity** and 100% for the **Highest Intensity**.
  – **Highest Intensity** Sets the highest level of brightness the flicker will attain.

  **Note** If you enable **Manual Control**, you can use **Highest Intensity** to control the flickering by creating keyframes at various levels of brightness.

  – **Randomize** Specifies the amount of random flickering that will occur. For example, at 0% there will be no randomization and the flickering...
follows a rhythmic beat. The higher the value the more random the
tickering becomes.

- **Color Gain** and **Color Addition (Red, Green, Blue)** You can use the
tools under Color Gain and Color Addition to individually fine-tune the
colors of your image. To proportionally increase or decrease the red, green,
and blue values, select **Lock Colors**.
  - The Color Gain controls for **Red**, **Green**, and **Blue** let you increase or
decrease the intensity of a particular color present in your image. For
example, increasing the **Red** value increases only the red color component
of your image, without affecting the other colors.
  - **Color Addition** lets you adjust all colors in your image by a given amount
of **Red**, **Green**, or **Blue**. For example, increasing the **Red** value increases
the amount of red throughout your entire image.

- **Crop** Allows you to crop the edges of your clip. For more information, see
“Cropping your clip” on page 61.
Creating a page curl effect

The Matrox page curl effect lets you create page curls that are truly 3D with full-motion video on the reverse side, and realistic highlights. You can control the position, rotation, scaling, and zooming of the page curls in 3D space, and apply softness to the edges. You can also apply page curls on graphics to create great looking text effects.

To set up a Matrox page curl effect:
Click the triangle beside Matrox Page Curl to expand the property list.

- **Page Curl**
  - **Fold Type**  You can select Page Peel or Page Roll as your page curl type (this setting is active for the duration of your effect).
  - **Fold Angle**  Sets the angle of your page curl, in degrees. Alternately, you can set the number of spins for your page curl.
  - **Curl Radius**  Determines the tightness of your page curl. For example, a radius of 0 produces the tightest page curl, and the higher the radius, the looser the page curl.
  - **Progression**  Sets the progression of your page curl pattern at any keyframe. In order to see your page curl progress you need to apply at least two keyframes to your clip. To create a standard page curl, create a keyframe at the first frame of your clip with Progression set to 0%, and another keyframe at the last frame of your clip with Progression set to 100%. For more information about creating keyframes, see your Adobe Premiere Pro documentation.
  - **Edge Softness**  Creates a soft edge on your page curl.
– **Curl Softness**  Creates a soft edge on the section of the page that is curling.

**Note**  You will not be able to see the **Curl Softness** on your page curl if you adjust the scale or rotation settings in the transform controls.

- **Highlight**  There is a white illuminated line that highlights each page curl. The following settings allow you to manipulate this highlight.
  - **Position**  Sets the location in the page curl where the highlight appears.
  - **Intensity**  Sets the brightness of the highlight, as a percentage.

- **Shadow Intensity**  Sets the darkness of the page curl shadow, as a percentage.

- **Transform**  Allows you to apply or change various transform settings, such as to change your clip’s size, position, and rotation. For more information, see “Transfomrning your clip” on page 58.

- **Crop**  Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.

- **Enhance Sharpness**  Lets you adjust the sharpness of your clip.
Creating a pan & scan effect

The Matrox pan & scan effect lets you easily convert footage from one aspect ratio to another. Tracking on-screen action to make accurate judgements is easy because you see the entire source clip and the section of it that will become the final result.

You can use the Matrox pan & scan effect to convert your entire production to another aspect ratio. To do this you should apply the pan & scan effect to a nested sequence:

2. Make sure the new sequence has the same settings as the original sequence. For example, if you chose the Matrox NTSC Standard preset for your original sequence, choose it again for your new sequence.
3. Give your new sequence a name and click OK.
4. Drag your original sequence from the Project panel into the new sequence.
5. Apply the Matrox pan & scan effect to the new sequence.
6. Adjust the pan & scan settings as desired for your entire production.

For more information about creating nested sequences, see your Adobe Premiere Pro documentation.

To set up a Matrox pan & scan effect:
Click the triangle beside Matrox Pan & Scan to expand the property list.

- **Source Aspect Ratio** Use this to select the aspect ratio of your source clip. You can click the triangle on the right to expand the list and choose a predefined aspect ratio or use the Source Aspect Ratio slider to select a custom aspect ratio.

- **Destination Aspect Ratio** Use this to select the new aspect ratio that you want for your clip. You can click the triangle on the right to expand the list
and choose a predefined aspect ratio or use the **Destination Aspect Ratio** slider to select a custom aspect ratio.

**Note** If you are working in HD, your output will always be 16:9. Therefore, if you choose 4:3 as your **Destination Aspect Ratio**, your clip will be distorted.

- **Scale** Use this to proportionally resize (enlarge or reduce) your clip.
- **Pan Position** Lets you move the area of interest at a specific frame in your clip. When used with **Global View** (see below), you’ll see a visual representation of the selected area.
- **Enable Global View** Select this to display a rectangle around the area of interest that you’re selecting using **Pan Position**.

![Creating a pan & scan effect](image)
Creating a ripple effect

The Matrox ripple effect lets you create 3D ripple patterns that simulate a flag waving, ripples in a pond, or a dream sequence.

- **Global Settings**
  - **X Center**  Sets the center position of the ripple along the horizontal axis.
  - **Y Center**  Sets the center position of the ripple along the vertical axis.
  - **Center Ripple in Crop Region**  Select this option to move the center position of the ripple to the center of your crop region.
  - **Progression**  Sets the progression of your ripple pattern at any keyframe. In order to see your ripple pattern progress you need to apply at least two keyframes to your clip. For example, create a keyframe at the first frame of your clip with **Progression** set to 0 degrees, and another keyframe at the last frame of your clip with **Progression** set to 45 degrees. For information about creating keyframes, see your Adobe Premiere Pro documentation.
  - **Amplitude**  Sets the maximum height of the ripple.
  - **Periods**  Sets the number of visible waves in the ripple.
  - **Attenuation**  Specifies the distance from the center of the ripple (x and y positions) at which the ripple will degrade or flatten.

- **Lighting**
  - **Shadow Color**  Use this to select a color for the ripple shadow.
  - **Shadow Intensity**  Sets the darkness of the ripple shadow, as a percentage.
  - **Highlight Color**  Use this to select the highlight color.
  - **Highlight Intensity**  Sets the darkness of the highlight, as a percentage.

- **Border Settings**
  - **Round Corner Size**  Allows you to round the corners on the edges of your clip.
  - **Softness**  Lets you adjust the amount of softness on the edge of your clip by dragging the slider or entering a percentage in the text box. The higher the value, the less sharp the edge will become.
• **Crop**  Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.

*Important*  Due to the shape of the ripple effect, your effect may exceed the cropped area.

• **Ripple Softness**  Use this to add softness to the alpha channel in the ripple so that the outline of the ripple will appear smoother.

• **Transform**  Allows you to apply or change various transform settings for your ripple, such as the size, position, and rotation of the ripple. For more information, see “Transforming your clip” on page 58.
Creating a shadow effect

The Matrox shadow effect lets you project a realistic shadow from any source containing key information, such as DVEs and titles with an alpha channel. You can tint the shadow, and position, scale, and rotate it to match the angle of the surface on which it is cast. Applying blur to the shadow can simulate the realistic look of diffused light being projected on the source.

**Note** If you are working in HD, the Matrox shadow effect may require rendering when combined with other effects.

To set up a Matrox shadow effect:

Click the triangle beside Matrox Shadow to expand the property list.

**Important** Either your source clip or an effect applied to your source clip must contain alpha key information in order to create a shadow effect. For example, if you apply a shadow effect to a clip with no alpha key information and scale it down using Adobe’s Motion effect, you won’t see any shadow because the Motion effect is the last effect applied, and there is no alpha key information to create the shadow effect. Whereas, if you apply a Matrox 3D DVE to the same clip and then apply the shadow effect, you will be able to see the shadow because the Matrox 3D DVE effect contains alpha information.

- **Lock Colors** Select this option to lock the colors and opacity values for the top and bottom corners of your shadow. For example, the color and opacity value you select for the top right corner will be used for all four corners of the shadow.
- **Top Right Corner Color** Use this to set the top right corner color.
Creating a shadow effect

- **Top Right Corner Opacity**  Sets the opacity of the top right corner. Levels range from completely transparent (0) to opaque (100).
- **Top Left Corner Color**  Use this to set the top left corner color.
- **Top Left Corner Opacity**  Sets the opacity of the top left corner. Levels range from completely transparent (0) to opaque (100).
- **Bottom Left Corner Color**  Use this to set the bottom left corner color.
- **Bottom Left Corner Opacity**  Sets the opacity of the bottom left corner. Levels range from completely transparent (0) to opaque (100).
- **Bottom Right Corner Color**  Use this to set the bottom right corner color.
- **Bottom Right Corner Opacity**  Sets the opacity of the bottom right corner. Levels range from completely transparent (0) to opaque (100).

| Note The shadow corner colors are applied based on the size of the full screen. Therefore, corner colors of your shadow may vary depending on the size and position of your DVE. For example, if you choose red for your shadow’s top right corner color and scale down and position your DVE to take up only the top right quarter of the screen, the shadow will reflect red for each corner of the shadow even though you may have selected different colors for all four corners. |

- **Shadow Softness**  Use this to set the softness of your shadow. The higher the value, the softer your shadow becomes.

| Note Shadow Softness is applied starting from the borders of the full screen, therefore the Shadow Softness may be less apparent based on the size and position of your DVE. |

- **Blur**  Use this to apply blurring to your shadow.
- **Camera Field of Vision**  Specifies the field of vision of the camera in reference to the shadow.
- **X Camera Position**  Moves the camera around the x axis.
- **Y Camera Position**  Moves the camera around the y axis.
- **Z Camera Position**  Moves the camera inward or outward from the shadow.
- **Transform**  Allows you to apply or change various transform settings for your shadow, such as the size, position, and rotation of the shadow. For more information, see “Transforming your clip” on page 58.
Creating a shine effect

The Matrox shine effect allows you to create rays that shine through text, or add shimmer to an object in your clip. You can also use the shine effect to make two-dimensional text appear as three-dimensional text.

To set up a Matrox shine effect:
Click the triangle beside Matrox Shine to expand the property list:

- **Light Source**
  - **X Position** Sets the position of the light source along the horizontal axis.
  - **Y Position** Sets the position of the light source along the vertical axis.
  - **Z Position** Sets the depth of the light source.
  - **Rotation** Rotates the light source. Positive values rotate the light source counterclockwise, and negative values rotate the light source clockwise.

- **Volume**
  - **Length** Specifies how far the light rays shine outward from the light source. Positive values make the rays shine outward, while negative values make the rays shine inward.
  - **Mode** Allows you to select the mode you want (Additive or Blend). Click the triangle on the right to expand the list.
    - **Additive** Adds the shine layers on top of one another repeatedly so the effect becomes brighter.
    - **Blend** Blends the shine layers together. This mode is useful if you want to make two-dimensional text appear to be three-dimensional.
  - **Precision** Sets the amount of shine layers applied in the effect. Higher values result in a cleaner, more precise effect.

**Note** The higher the precision value, the longer the shine effect will take to render.

  - **Start Opacity** Sets the opacity of the rays closest to the light source. Levels range from completely transparent (0) to opaque (100).
- **End Opacity**  Sets the opacity of the rays furthest from the light source. Levels range from completely transparent (0) to opaque (100).

- **Preprocessing**  These controls allow you to isolate a channel as the input for the shine. For example, if you wanted to apply the shine to the alpha channel only, you would select **Alpha Only** as your mode.
  - **Enable Preprocessing**  Select this option to enable preprocessing.
  - **Mode**  Lets you select the channel you want to use for your effect. Click the triangle on the right to expand the list.
    - **Red Only**  Uses the red channel.
    - **Green Only**  Uses the green channel.
    - **Blue Only**  Uses the blue channel.
    - **Alpha Only**  Uses the alpha channel.
    - **Luma**  Uses the luminance values.
    - **Oversaturated Luma**  Uses the oversaturated luminance values only.
  - **Threshold**  Use this to proportionally increase or decrease the region outside your **Mode** range. For example, if you chose **Red Only** as your mode, raising the **Threshold** will cause only the really bright red areas of your image to be affected by the shine.

- **Color Remapping**  These controls allow you to apply a color gradient to your effect. For example, you may want to simulate the look of a crackling fire by using a gradient that contains orange, red, and white.
  - **Enable Color Remapping**  Select this option to enable color remapping.
  - **Gradient**  Allows you to select a gradient. Click the button on the right to see the list of available gradients. You can use the **Gradient Lower Boundary** and **Gradient Upper Boundary** controls to specify a range of colors from the gradient you choose.
  - **Use Gradient Built-in Alpha**  Select this option when using a gradient that contains an alpha channel.
  - **Gradient Lower Boundary**  Sets the starting color from the gradient you chose, which will create a gradual progression between this color and the **Gradient Upper Boundary** color. Drag the slider to progress through the various colors in the gradient. For example, if you selected a gradient that progresses from black to white and you want your gradient to start at medium gray, drag the slider to 50%.
  - **Gradient Upper Boundary**  Sets the end color from the gradient you chose, which will create a gradual progression between this color and the **Gradient Lower Boundary** color. Drag the slider to progress through the various colors in the gradient. For example, if you selected a gradient that...
progresses from black to white and you want your gradient to end at dark gray, drag the slider to 10%.

- **Noise** Use these controls to apply noise patterns to your shine effect.
  - **Noise Pattern** Allows you to select a noise pattern. Click the button on the right to see the list of available patterns.

- **Amount** Sets the amount of noise that will be applied to your effect. The higher the value, the more apparent the noise pattern becomes.
- **Size** Sets the size of the artifacts in the noise pattern. Drag the slider to the right to increase the size of the artifacts, or to the left to shrink them.
- **X Progression** Sets the progression of the noise pattern along the horizontal axis.
- **Y Progression** Sets the progression of the noise pattern along the vertical axis.

- **Postprocessing** Use these controls to define how your shine colors blend with your source image’s colors. Each mode involves a calculation that uses the pixel values from your shine effect and the source image.
  - **Mode** Use this to select the mode you want to use for blending. Click the triangle on the right to expand the list.
    - **None** There is no blending, only the shine pixels are displayed.
    - **Add** Adds the source image pixel values to the shine pixel values. This lightens the effect.
    - **Modulate** Multiplies the shine pixel values with the source image pixel values. This darkens the effect.
    - **Subtract** Subtracts the source image pixel values from the shine pixel values to create a new color.
    - **Add Smooth** Blending of the shine pixel values is performed only on the low saturated (pale) colors from the source image. This will result in a more subtle effect.
    - **Add Signed** Adds the shine pixel values to the brightest pixel values of the source image.
    - **Blend** Blends the shine pixel values with the alpha pixel values of the source image.
    - **Blend Signed** Blends the shine pixel values with the brightest pixel values of the source image.
    - **Original Opacity** Sets the opacity of the source image.
Creating a shine effect

- **Mask Settings**  Let you select a mask pattern and adjust the transparency settings to define the area where you want to apply your shine effect.
  - **Enable Mask**  Select this option to enable the mask.
  - **Mask Pattern**  Allows you to select a mask pattern. Click the button on the right to see the list of masks.

  ![Click here to select a mask pattern]

  - **Invert Mask**  Select this option if you want to invert the opaque and transparent areas of your mask.
  - **Outside Transparency**  Sets the transparency level of the region outside your mask.

  **Note**  The Outside Transparency setting is applicable only if you’ve scaled down, moved, or rotated your mask using the transform controls so that the mask doesn’t cover the entire screen.

  - **Shape Transparency**  Sets the transparency of the shape and the area around the shape. At the default setting (0), the shape is completely opaque and the area around the shape is transparent. Dragging the slider to the left increases the transparency of the shape, which makes the shine effect less apparent. Dragging the slider to the right decreases the transparency of the area around the shape, which increases the amount of shine outside the mask area.

  - **Transform**  Use these properties to apply or change various transform settings, such as the position, scale, and rotation settings of your mask. For more information, see “Transforming your clip” on page 58.

- **Crop**  Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.
Creating a sphere effect

The Matrox sphere effect lets you wrap your clip around a true 3D sphere with shadow and highlight. The radius of the sphere, the position of the light, and the progression from a flat 2D clip to a fully formed sphere are all keyframeable.

To set up a Matrox sphere effect:
Click the triangle next to Matrox Sphere to expand the property list.

- **Sphere Settings**
  - **Progression**  Use this to set the progression for your sphere, where 0% leaves your clip as a flat 2D image, and 100% creates a fully formed sphere.
  - **Radius**  Use this to set the size of your sphere.
  - **Transparency**  Sets the transparency of your clip, from opaque (0%) to fully transparent (100%). If you’re performing a sphere transition, the transparency level is applied to your initial image. For example, you can set the transparency to 0% at the first frame and 100% at the last frame to create a crossfade between your initial and final images.
  - **Edge Softness**  Selects the amount of softness to apply to the edges of your clip.
  - **Show back face**  Select this option to show the back face of your sphere. Clear this option if you’re applying transparency to your clip and you do not want to see the back face of your clip through your sphere.
• **Light Settings**
  - **Show Light Position**  Select this option to display a diamond-shaped cursor that shows the position of the light source (highlight) on your sphere. Make sure you clear this option before exporting your final sequence.
  - **X, Y, and Z Light Position**  Use these controls to determine the position of your light source along the X, Y, and Z axes of your sphere.
  - **Shadow Intensity**  Use this to add shadow, and adjust the darkness of shadow on your sphere.
  - **Light Intensity**  Use this to add light, and adjust the brightness of the light on your sphere.
  - **Light Size**  Use this to alter the size of the highlight.
  - **Light Color**  Use the Color Picker button or eyedropper to select the color of the light.

• **Transform**  Use these controls to apply or change various transform settings for your sphere effect, such as the position, scale, and rotation of the sphere. For more information, see “Transforming your clip” on page 58.

• **Crop**  Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.

• **Enhance Sharpness**  Lets you adjust the sharpness of your clip.
Creating a surface finish effect

The Matrox surface finish effect allows you to apply various textures to your clips, such as metal, brick, wood, or granite with color spot lighting. You can also adjust the transform controls to create a rotating slab with a different look on the front and back face.

To set up a Matrox surface finish effect:
Click the triangle beside Matrox Surface Finish to expand the property list.

- **Surface Control**
  - **Apply to Opaque Areas Only** Select this option to apply the surface texture to only the opaque areas of a clip that contains an alpha channel.
  
  **Note** When this option is enabled you cannot adjust the Scale Z transform property, and therefore your clip will be two dimensional.

  - **Surface Texture** Allows you to select your surface texture. Click the button on the right to see the list of available textures.

- **Front Face Control**
  - **Blending Factor** Blends the front face of the slab with the surface texture. The higher the value, the more your clip blends in. A value of zero will display only the surface texture.
  
  - **Invert Video Orientation** Select this to invert your clip on the front face of your slab.
  
  - **Crop** Sets the crop region used on the front face of the slab. For more information, see “Cropping your clip” on page 61.
– **Back Face Control**
  - **Blending Factor**  Blends the back face of the slab with the surface texture. The higher the value, the more your clip blends in. A value of zero will display only the surface texture.
  - **Invert Video Orientation**  Select this to invert your clip on the back face of your slab.
  - **Crop**  Sets the crop region used on the back face of the slab. For more information, see “Cropping your clip” on page 61.

– **Light Control**
  – **Ambient Light Color**  Use the color picker button or eyedropper to select the ambient color of light for your entire clip.
  – **Show Light Cursors**  Select this option to see the reference point of the two light sources to help you set up your lights. Remember to clear this option when you’re finished setting up your effect.
  – **First Light**
    - **Enable**  Select this to enable the first light.
    - **Color**  Use the color picker button or the eyedropper to select the color of your first light.
    - **First Light Pattern**  Allows you to select the first light pattern. Click the button on the right to see the list of available patterns.
    - **X Position**  Sets the position of the first light along the horizontal axis.
    - **Y Position**  Sets the position of the first light along the vertical axis.
    - **Z Position**  Sets the depth of the first light.
    - **Relative Position**  Selecting this option makes the first light source position relative to the center of your clip. For example, if you move your clip, the first light will move with it. By default, the position of the first light is relative to the center of the screen.
  – **Second Light**
    - **Enable**  Select this to enable the second light.
    - **Color**  Use the color picker button or the eyedropper to select the color of your second light.
    - **Second Light Pattern**  Allows you to select the second light pattern. Click the button on the right to see the list of available patterns.
    - **X Position**  Sets the position of the second light along the horizontal axis.
    - **Y Position**  Sets the position of the second light along the vertical axis.
    - **Z Position**  Sets the depth of the second light.

Creating a surface finish effect
- **Relative Position**  Selecting this option will make the second light source relative to the center of your clip. For example, if you move your clip, the second light source will move with it. By default, the second light source is relative to the center of the screen.

- **Transform**  Allows you to apply or change various transform settings, such as to change your clip’s size, position, and rotation to create a rotating slab.

  **Note**  The transform properties for the surface finish effect include a **Scale** property that allows you to adjust the thickness of your slab. For more information about using the other transform properties, see “Transforming your clip” on page 58.

- **Enhance Sharpness**  Lets you adjust the sharpness of your clip.

  **Important**  If you are working in HD, the surface finish effect may require rendering based on certain setting combinations.
Creating a track matte effect

The Matrox track matte effect lets you superimpose one clip onto another using an animated matte, sometimes called a traveling matte, to determine how the two clips are composited (keyed). You can use any of the following types of clips as your matte:

- A grayscale video or graphics clip.
- A graphics clip or graphics sequence with an alpha channel.
- Any clip to which you’ve applied an effect that provides an alpha channel, such as a Matrox chroma key or 3D DVE.

When using a grayscale clip as your matte, areas of black in the matte create transparent areas in your foreground clip, areas of white create opaque areas that prevent the underlying clip from showing through, and gray areas create semi-transparent areas in your foreground clip.

To set up a Matrox track matte effect:

1. Place your background clip (underlying image) on the appropriate lower track in your sequence, such as on the Video 1 track.
2. Place your matte clip directly above your background clip, such as on the Video 2 track, and apply the Matrox Source Identifier effect to this clip.

   Note   This effect is used only to identify which clip you’re using as the matte for your track matte effect. If you set up another effect in the same segment that also uses the Matrox Source Identifier effect, such as for another track matte effect or an additional source for a Matrox cube effect, you must assign a unique ID number to each source clip.

3. In the Effect Controls panel, click the triangle beside Matrox Source Identifier to expand the property list, then select a unique ID number for your matte clip from the Identify As list, as shown below:

   Select a unique ID number for your matte source

   Important   Any effect applied to your matte after applying the Matrox Source Identifier effect will be ignored. Therefore, if you want to apply an effect such as a Matrox chroma key or apply motion to your matte using a Matrox 3D DVE or Adobe Premiere Pro Motion effect, you must apply this effect before applying the Matrox Source Identifier effect.
4 Place your foreground clip (the clip you want to superimpose onto your background clip) directly above your matte clip, and apply the Matrox Track Matte effect to this clip. Your sequence should be similar to the following example:

5 Click the triangle beside Matrox Track Matte to expand the property list:

6 Click the triangle beside Select Matte Source, and select the unique ID number that you assigned to your matte clip.

7 Click the triangle beside Composite Type, and select any of the following composite types:
   - **Alpha** Uses the alpha channel of your matte to key your foreground image. This is applicable only if your matte is a graphics clip that has an alpha channel, or a clip to which you’ve applied an effect that provides an alpha channel, such as a Matrox chroma key.
   - **Luma 0-255** Uses the full range of luminance levels in your matte to key your foreground image. This is applicable only if your matte contains super black and super white luminance levels.
   - **Luma 16-235** Uses the standard range of luminance levels in your matte to key your foreground image.

8 To reverse the result of your track matte effect, select Reverse. This inverts the key to give you the opposite result (transparent areas of your foreground image become opaque and opaque areas become transparent).
Creating a twirl effect

The Matrox twirl effect lets you create twirl patterns that twist and rotate your video and graphics clips into spirals, coils, or whirlpools.

- **X & Y Position**  Sets the position of the twirl along the horizontal and vertical axes.
- **Inner Radius**  Determines the circumference of the center of your twirl. The higher the radius, the larger the center of the twirl becomes.
- **Outer Radius (Width, Height)**  Use this control to adjust the width and height of your twirl simultaneously. The higher the value, the larger your twirl becomes. If you clear Fixed Aspect Ratio, you can adjust each control individually.
- **Angle**  Sets the angle of your twirl, in degrees.
- **Invert**  Lets you reverse the direction of the twirl so that it twirls outward from the inner radius.
- **Smoothness**  Sets the smoothness applied to the colors in the twirl. The higher the value, the less sharp the colors become. This is useful if you want to remove artifacts that may appear when using a high angle for your twirl.
- **Crop**  Allows you to crop the edges of your clip. For more information, see “Cropping your clip” on page 61.
Creating a wipe transition

The Matrox wipe transitions support standard dissolves, SMPTE wipes, and organic wipes with soft edges and color borders.

To set up a Matrox wipe transition:

Click the transition’s icon in your sequence, then click the Custom button in the Effect Controls panel. This opens the Customize Matrox Wipes dialog box:

1. Under Wipe Pattern, click the Select Pattern button and choose a pattern for your wipe.
2. If you would like to add a border to your wipe, select Enable under Border.
   - Width: Lets you adjust the width of your border by dragging the slider or entering a percentage in the text box.
   - Color: Click this button to select a color for your border.
Creating a wipe transition

- **Balance**  Lets you adjust the prominence of the border between image A and image B. For example, positive values make the border more prominent in image B, while negative values make the border more prominent in image A.

- **Reset**  Click this button to restore the default **Border** values.

3 Use the controls under **Softness** to create a soft edge on the border of your wipe.

- **Nonlinear softness**  This option is selected by default. You may find it useful to clear this option when using certain wipe patterns. For example, nonlinear softness often provides better results when creating SMPTE wipes, while linear softness is usually preferable when creating organic wipes.

- **Amount**  Lets you adjust the amount of softness by dragging the slider or entering a percentage in the text box. The higher the value, the less sharp the edge of your border or wipe will become.

- **Reset**  Click this button at any time to restore the default **Softness** values.

4 Use the controls under **Preview** to preview your wipe transition:

- Drag the slider beside the **Play** button to scrub through your transition.

- Click the **Play** button or press the **SPACEBAR** to play back your transition. Select **Loop** if you’d like the wipe to play back continuously until you click **Stop**.

You can adjust the wipe settings as your transition is playing to immediately see the result of your changes.

5 Use the controls under **Presets** to save and load your wipe transition settings. You can also create default settings for your wipe transitions.

- **Save**  Allows you to save your organic wipe settings to a file for future use. When you click the **Save** button, the **Save As** dialog box opens and allows you to name your effect and save it as a Matrox wipe transition (.mwt) file.

- **Load**  Click this button to load a previously created .mwt file.

- **Set as Default**  Sets your current wipe settings as the default settings for Matrox wipe transitions.

- **Restore Default**  Click this button to restore the default settings you specified using the **Set as Default** button.

For more information about setting up transitions, see your Adobe Premiere Pro documentation.
Using the Matrox chroma clamper effect

You can use the Matrox chroma clamper effect to ensure that when you’ve applied effects that perform color space conversion on part of a clip, the clip’s colors remain constant throughout. Some effects, such as Matrox hardware-accelerated effects and Adobe Premiere Pro native effects, perform color space conversions (YUV to RGB) that will clip RGB values to the acceptable range of 0-255 per color component. The clipping, however, is usually only required on clips that have very bright or highly saturated colors.

For example, if you split a clip that contains very bright or highly saturated colors and apply a Matrox 3D DVE to one portion of the clip, you may notice minor color differences between the two halves on your video monitor. Applying the Matrox chroma clamper effect to the portion of the clip that does not have the 3D DVE effect ensures that colors remain constant throughout the clip.

Selecting your speed control method

You can choose the type of speed control that’s best suited for individual clips in your Premiere Pro projects. By default, the speed control method of each clip in the Timeline panel is set to Frame Blend, which interpolates between the video fields or frames, and typically works well on standard or slow-paced video and camera pans. For fast action video you may get better results by clearing this option.

To change the speed control method for a clip in the Timeline panel, right-click the clip and select Frame Blend to use the speed control method that’s recommended for standard or slow-paced video and camera pans, or clear this option for fast-action video.

Remarks

- The Frame Blend option is not supported for speed changes over 200%.
- If you are working in HD, you will need to render if you clear the Frame Blend option.

About Adobe Premiere Pro’s fixed effects

In Adobe Premiere Pro, every clip in the Timeline panel has pre-applied fixed effects. When you select a clip in a sequence, the fixed effects appear in the Effect Controls panel. All fixed effects can be adjusted in the Effect Controls panel. Adobe Premiere Pro’s fixed effects include the Motion, Opacity, and Volume effects. Matrox RT.X2 provides realtime support for all of Premiere Pro’s fixed effects.
Matrox RT.X2 realtime guidelines

In your Adobe Premiere Pro projects, you can use various combinations of realtime Matrox CPU-based effects (Flex CPU effects), hardware-accelerated effects (Flex GPU effects), and Adobe Premiere Pro fixed effects, all with transparency.

Realtime means that the clips don’t require rendering and will play back in real time without dropping frames (that is, there is no red indicator bar above the segment).

The Matrox CPU-based effects are wipes, color corrections, chroma keys, luma keys, move & scale, the chroma clamper, and Adobe Premiere Pro’s crop and speed change. The Matrox hardware-accelerated effects are all the other Matrox effects (such as page curls, 3D DVEs, surface finish effects, Premiere Pro fixed effects and fades, etc.).

Remarks

• To optimize realtime performance, you should always apply Matrox CPU-based effects to a clip before applying hardware-accelerated effects. For example, if you want to apply both a color correction and a 3D DVE to a clip, apply the color correction first and then apply the 3D DVE.

• The hardware-accelerated effects will be available only if you have a display card that supports the Matrox hardware-accelerated effects in Adobe Premiere Pro. For more information, see “Enabling and disabling the Matrox hardware-accelerated effects in Adobe Premiere Pro” on page 177.

Matrox RT.X2 constantly analyzes your sequence as you work, and will identify which segments require rendering (with a red indicator bar above the segment). For example, once playback of the sequence has stopped, a red bar will appear over segments of the sequence that have dropped frames. Even when your system is idle, Matrox RT.X2 will analyze segments to determine if they require rendering. Certain complex effects or combinations of effects can cause dropped frames when previewing. Matrox RT.X2 will always provide a preview of your output at the best frame rate possible by analyzing the segments and dropping frames systematically.

If you find that you have dropped frames when you export your sequence to tape and those segments were not identified with a red bar, you can lower the Realtime Indicator Threshold. For more information, see “Defining your sequence settings” on page 27.

The maximum number of layers that can be played back in real time depends on the capabilities of your system, your sequence’s video format, the compression format of your clips, and the number and complexity of the effects you’ve applied to your clips.
Supported graphics formats
All full-screen single-frame graphics supported by Adobe Premiere Pro are supported in real time on Matrox RT.X2. This includes all titling formats that Premiere Pro supports, such as Adobe Titler .prtl files. For details on the supported formats, see your Adobe Premiere Pro documentation.

Note Graphics rolls, crawls, and animations are not supported in real time.

Limitations
You will need to render your effects if you do any of the following:

- Apply any Field Options to a clip, such as Always Deinterlace or Flicker Removal.
- Apply a freeze-frame effect to a clip using the Frame Hold command.
- Use Interpret Footage to do any of the following:
  - Change a clip’s frame rate, pixel aspect ratio, or field order.
  - Select Ignore Alpha Channel or Invert Alpha Channel.
Using Matrox RT.X2 with Video for Windows Programs

This chapter provides information you need to know when using Video for Windows programs to render material on your Matrox RT.X2 system.
Overview

When using Video for Windows (VFW) programs to render material to an .avi file, such as in the case of a completed video production or an animation, you can use a Matrox VFW codec to create a Matrox .avi file. For example, you may want to render an animation to Matrox DV/DVCAM format so that you can record it onto DV tape. You could also use your VFW program to render video to a Matrox .avi file so that you can import the file as a realtime clip into your Adobe Premiere Pro projects on Matrox RT.X2.

When rendering compositions or animations that have an alpha channel, you can select a “+ Alpha” Matrox VFW codec to render to a Matrox MPEG-2 .avi file that includes the alpha-key information. This .avi file will play back in real time on your RT.X2 system, and will be automatically keyed when you place the clip in your Adobe Premiere Pro sequence.

The following sections explain the various settings you need to make to render material to a Matrox .avi file using a VFW program. For details on exporting a Matrox sequence in Adobe Premiere Pro to a non-VFW Matrox .avi file, see “Exporting to a Matrox .avi file” on page 43. Using Adobe Premiere Pro to export video on your RT.X2 system lets you overcome the 2-GB .avi file limit of VFW programs.

Remarks

- When you select the Desktop editing mode for an Adobe Premiere Pro sequence, Adobe Premiere Pro works like a VFW program as explained in this chapter.
- Speed changes are not supported on Matrox VFW .avi files with alpha.
- Although Matrox has tested many VFW programs, there may be certain operational limitations when using Matrox RT.X2 with some of these programs (as well as with untested programs).

Using VFW programs without the RT.X2 hardware

If you installed the Matrox VFW software codecs (see “Installing the Matrox VFW software codecs on a system without the RT.X2 hardware” in your Matrox RT.X2 Installation Manual), you can render and play back RT.X2-compatible .avi files using your VFW program without having the RT.X2 hardware in your computer.

Note You must have the Matrox RT.X2 hardware for full support of the Matrox MPEG-2 I-frame HD codec. The “+ Alpha” Matrox MPEG-2 I-frame codecs are available only on a system that has RT.X2 hardware.
Before you start rendering

Before you start rendering material to a Matrox .avi file, make the following settings in your VFW program:

- Set the frame size (width and height) of your rendered material to full-screen:
  - 720×480 if you are rendering to NTSC or 486p format using the DV/DVCAM, DVCPRO, or MPEG-2 I-frame codec.
  - 720×576 if you are rendering to PAL or 576p format using the DV/DVCAM, DVCPRO, or MPEG-2 I-frame codec.
  - 1440×1080 or 1280×720 if you are rendering to 1440×1080i/p or 720p format using the MPEG-2 I-frame HD codec.

- Set the appropriate frame rate for the video format to which you are rendering. For example, if you are rendering to PAL format, set the frame rate to 25 fps.

- If available, select the “Recompress” option. This allows you to render video using the same compression format, frame size, and frame rate as your source video but using a different video quality (data rate) or scanning mode (interlaced or progressive).

- If you’ll be rendering audio, set the audio sample rate to 48 kHz and the sample size to 16-bit (mono or stereo).

- For best results, make sure that there is no data rate limit set in your program for rendered material. This ensures that your .avi files will be rendered at the particular video quality you select.

- If you’re using Adobe Premiere Pro, set the Field Type for rendering to Lower First for NTSC video, Upper First for PAL and interlaced HD video, or Progressive for progressive video.

Note Before rendering a lot of material, check that your rendered animations and transitions such as wipes and slides play back smoothly. If they appear jumpy, try adjusting the field dominance or field order for your rendered material.
Selecting color space conversion options

When you render material to an .avi file using a Matrox VFW codec, you can determine how you want the luminance levels and chroma information to be processed during the color space conversion that’s performed during the render.

**Note** The default settings for color space conversion provide good results for most applications. We recommend that you change these settings only when needed for special purposes.

To select the color space conversion options you want:

1. Choose **Start > All Programs > Matrox VFW Codec Configuration**.
2. From the list of codecs, select the Matrox VFW codec that you want to configure, then click **Settings**.

**Note** You can select **Matrox VFW Software Codecs** to configure all the Matrox DV, MPEG-2 I-frame SD, and legacy M-JPEG codecs.

3. In the provided dialog box under **Color Space Conversion**, select the options you want:

   ![Color Space Conversion Options](image)

   **Note** If an option isn’t supported by the particular codec(s) you are configuring, that option will not be available. Most options, however, are common to all the Matrox VFW codecs. When these options are set for a particular codec, they are also set for the other codecs that support those options.

   - **Standard** Renders video using standard broadcast luminance levels. Super black and super white luminance levels are clipped.
   - **DV-compliant** Renders video using luminance levels appropriate for DV material. This ensures that the super white luminance levels of your video are retained.
   - **Expanded** Renders video using the full range of luminance levels. Super black and super white luminance levels are retained. You may want to use this setting, for example, to render material on which you’ll be applying luminance key effects.

Chapter 6, Using Matrox RT.X2 with Video for Windows Programs
**Important** When rendering RGB graphics, selecting **Expanded** or **DV-compliant** will create super black and/or white in your rendered images. For example, if you select **Expanded**, all black in your RGB graphics will become super black, and white will become super white. To render your RGB graphics with standard black and white levels, set your luminance range to **Standard**.

- **Chroma filtering** and **Chroma interpolation** Select these options to adjust the chroma bandwidth of RGB graphics. This improves images that have abrupt changes between different colors, such as a blue box on a black or white background. You should select these options for most animation and compositing work (computer-generated material). For most video editing programs, however, it’s best that you **not** select these options. If you find that your rendered images appear to be blurred, try clearing one or both of these options.

- **Chroma sampling for fast-motion video** Select this option to help eliminate artifacts such as jagged edges and unwanted lines at the edges of fast-motion video (for PAL video only).

**Important** When rendering graphics and titles, make sure that **Chroma sampling for fast-motion video** is **not** selected, as this option can cause jagged edges to appear in your rendered images.

4 Click **OK** to save your settings. Any change you make to your selected luminance range setting (such as switching from **Standard** to **Expanded**) will only take effect the next time you start your VFW program.
Rendering material to a Matrox VFW .avi file

When you render material to a .avi file, such as when you render a finished video production or an animation, you must select the compressor (codec) you want to create the file. The compressor determines the quality of your rendered video. Refer to your program’s documentation for instructions on how to select a compressor for your .avi file.

For information about exporting using Adobe Premiere Pro, see “Exporting to a Matrox VFW .avi file using Adobe Premiere Pro” on page 165.

To create a Matrox VFW .avi file:

1. Select one of the following codecs from your program’s list of available compressors:
   - **Matrox DV/DVCAM** Renders video to DV or DVCAM format.
   - **Matrox DVCPRO** Renders video to DVCPRO format.
   - **Matrox MPEG-2 I-frame** Renders video to MPEG-2 intra-frame format using the 4:2:2 Profile @ Main Level at a selected data rate (SD resolution only).
   - **Matrox MPEG-2 I-frame + Alpha** Renders video to MPEG-2 intra-frame format with alpha using the 4:2:2 Profile @ Main Level at a selected data rate (SD resolution only). This codec is available only on a system that has the Matrox RT.X2 hardware.
   - **Matrox MPEG-2 I-frame HD** Renders video to MPEG-2 intra-frame format using the 4:2:2 Profile @ High Level at a selected data rate.
   - **Matrox MPEG-2 I-frame HD + Alpha** Renders video to MPEG-2 intra-frame format with alpha using the 4:2:2 Profile @ High Level at a selected data rate. This codec is available only on a system that has the Matrox RT.X2 hardware.

2. If you selected a Matrox MPEG-2 I-frame codec, click the button provided by your program that allows you to configure your codec settings. For details, see the following section.

Note Additional Matrox codecs will be available, such as the Matrox M-JPEG, DVCPRO HD, and uncompressed HD codecs. You can use these codecs to create clips for use on other Matrox systems, such as Matrox DigiSuite or Matrox Axio. For information about creating VFW clips for other Matrox systems, see the documentation for those systems.
Rendering material to a Matrox VFW .avi file

Configuring the Matrox MPEG-2 I-frame codecs

When you choose to configure a Matrox MPEG-2 I-frame codec (SD or HD resolution, with or without alpha), a dialog box similar to the following appears:

![Matrox MPEG-2 I-frame HD Settings dialog box](image)

**Important** Unless you have the Matrox RT.X2 hardware, you can use the Matrox MPEG-2 I-frame HD codec to render to a 1440×1080i/p file only. The “+ Alpha” Matrox MPEG-2 I-frame codecs are available only on a system that has RT.X2 hardware.

1. Drag the Data Rate slider until your desired data rate is displayed. The higher the data rate you select, the better the video quality will be. Depending on the capabilities of your system, however, you may not be able to smoothly play back video at a high quality using your VFW program.

2. Beside Frame Rate, select a frame rate from the list. Make sure the frame rate you select is appropriate for the format to which you are rendering.

   **Note** The Frame Rate setting is not available if you’re rendering to MPEG-2 I-frame SD format without alpha.

3. To apply advanced settings to your MPEG-2 I-frame file, click the Advanced button.

   **Note** The Advanced button will be available only on a system that has the Matrox RT.X2 hardware, and is not available if you’re rendering to MPEG-2 I-frame SD format without alpha. The default advanced settings should provide good results for most applications. We recommend that you change these settings only when needed for special purposes.

4. Beside DC Precision, select the bit-depth precision of the DC intra block. The higher the DC precision value that’s used to render your video, the more likely that the DC content will be increased at the expense of the AC content in the encoded stream. This may result in lowering the overall quality of the compressed stream at a specified data rate.

5. Under Zig Zag Order, select one of the following:

   Rendering material to a Matrox VFW .avi file
Chapter 6, Using Matrox RT.X2 with Video for Windows Programs

- **Regular**  Sets the regular (default) zig zag scanning pattern of the AC coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure 7-2) specification documentation.

- **Alternate**  Sets an alternate zig zag scanning pattern of the AC coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure 7-3) specification documentation. Use this setting when capturing or rendering video at a high data rate (for example, at a data rate of 100 Mb/sec or higher).

6 Under **Rounding Type**, select one of the following:

- **MPEG-2**  Rounds the AC coefficients up to the nearest whole number when calculating the quantization coefficient.

- **Matrox Custom**  Truncates the AC coefficients to the lowest whole number when calculating the quantization coefficient. In some cases, this setting may yield less artifacts in graphics.

7 Select the **Force Frame-based DCT** setting to render macroblocks as frames rather than as fields. In some cases, graphics will yield less artifacts if this option is selected.

8 Click **OK** to save your settings. The settings you selected will be used each time you render material with your program, until you change the settings again.
Exporting to a Matrox VFW .avi file using Adobe Premiere Pro

To export an Adobe Premiere Pro sequence to a Matrox VFW .avi file, choose File > Export > Media. In the Export Settings dialog box, set the Format to Microsoft AVI, then select the Matrox codec you want to use. To see the list of available codecs, click the Video tab. For additional rendering settings, see “Before you start rendering” on page 159. Once you’ve specified your settings for the export, your export request is sent to Adobe Media Encoder.

When exporting an Adobe Premiere Pro sequence to an .avi file using a Matrox VFW codec, keep the following points in mind:

- To export NTSC clips to a Matrox NTSC .avi file using a Matrox VFW DV or MPEG-2 I-frame codec, you must apply cropping on the Source page of the Export Settings dialog box as follows:
  - To export DV clips, set Left = 0, Top = 4, Right = 0, and Bottom = 2.
  - To export MPEG-2 I-frame clips, set Left = 0, Top = 6, Right = 0, and Bottom = 0.

- When exporting clips to which you’ve applied Matrox hardware-accelerated (Flex GPU) effects, be aware of the following:
  - The video format of the material you’re exporting must match the video format of the currently active sequence in Adobe Premiere Pro.
  - During the export, do not switch sequences, switch to another program, or quit Adobe Premiere Pro.
  - You must always export from Adobe Premiere Pro instead of running Adobe Media Encoder independently.

- If you want to use a “+ Alpha” Matrox VFW codec to export a Matrox sequence to a Matrox .avi file that includes alpha, you must disable accelerated rendering in Adobe Media Encoder by selecting Disable accelerated export on the General page of the Matrox Playback Settings dialog box (choose Sequence > Sequence Settings, and click the Playback Settings button).
Using the Matrox WYSIWYG Plug-ins

This chapter explains how to use the Matrox WYSIWYG Control Panel and plug-ins available with Matrox RT.X2 so that you can display the contents of your composition or animation on your video monitor.
Overview

Together with your Matrox RT.X2 hardware, the Matrox WYSIWYG Control Panel and Matrox WYSIWYG plug-ins let you display the contents of your composition or animation on your video monitor. This lets you see the exact color temperature, safe-title area, and any interlaced artifacts as you work.

You can preview video played back using the following applications that are supported by the Matrox WYSIWYG plug-ins:

- Adobe After Effects (version 5.0 or later).
- Adobe Photoshop (version 7.0 or later).
- Autodesk 3ds Max (version 7.0 or later).
- Autodesk Combustion (version 4 or later).
- eyeon Fusion (version 4 or later).
- NewTek LightWave 3D (version 7.0 or later).

On a Windows XP system, WYSIWYG output to your video monitor is also available for any Matrox .avi file and video played back using supported DirectShow applications, such as Windows Media Player.

Note The Matrox WYSIWYG plug-ins support 32-bit applications only (64-bit applications are not supported.)

Configuring the Matrox WYSIWYG Control Panel

The Matrox WYSIWYG Control Panel lets you specify the settings you want for previewing video on your video monitor. To use the Matrox WYSIWYG Control Panel, right-click the icon on your Windows taskbar. If you don’t see the icon, choose Start > All Programs > Matrox Mx.tools > Matrox WYSIWYG Control Panel.

The Matrox RT.X2 DVI Monitor Calibration program uses the Matrox WYSIWYG Control Panel to display color bars for calibrating your DVI monitor for video (not applicable to RT.X2 LE or RT.X2 SD). For details on calibrating your DVI monitor, see “Calibrating your DVI monitor” on page 8.

Note By default, the Matrox WYSIWYG output to your video monitor is enabled. To disable it, clear the Enable WYSIWYG Output option in the Control Panel. When you do this, you’ll have to quit and restart any DirectShow application, such as Windows Media Player, in order for the change to take effect.

1. From the Project Format menu, select the format that matches your composition or animation, such as NTSC 4:3.
2. From the Output Format menu, select the format you want for your preview output. Depending on the project format you chose, the output...
format may be automatically set for you. For example, if you chose an NTSC project format, your output format is set to NTSC. If you chose a 1440×1080i @ 29.97 fps project format, you can select a 1080i @ 29.97 fps output format, or you can select an NTSC output format to downconvert the HD video to NTSC (not applicable to RT.X2 SD).

3 If you selected an output format that has a frame rate of 25 or 50 fps, and your DVI video monitor is unable to properly display your preview output, select **Force DVI Output to 60 Hz (Bypass Autodetect)**. Otherwise, make sure this option isn’t selected to allow Matrox RT.X2 to automatically detect the frequency rates supported by your DVI video monitor and set the DVI output frequency accordingly.

4 From the **Preview Type** menu, select one of the following options for the preview:
   - **Video** Select this to view your composition or animation.
   - **Alpha Channel** Select this to view only your composition’s or animation’s grayscale alpha-key (matte) information.

5 From the **Scaling** menu, select one of the following options for your preview output:
   - **Scale to fit** Select this to scale your output to fit your video monitor. The aspect ratio of your project format will be preserved.
   - **Original Size** Select this to output your video without any scaling. If you are playing back HD clips in an SD project, your output will be centered on your video monitor.
Required steps to use the WYSIWYG plug-ins

The following sections list the steps required to use the Matrox WYSIWYG plug-in for each application in order to preview video on your video monitor.

Note The following procedures may change with a subsequent release of the program.

Adobe After Effects
1 Start Adobe After Effects and import the footage you want to preview.
2 Drag the footage from the Project window to the Composition window.

Adobe Photoshop
1 Start Adobe Photoshop and open the file you want to preview.
2 Choose File > Export > Matrox WYSIWYG Preview.

Note If you switch any of the Matrox WYSIWYG settings during a preview, your video may not update automatically on your video monitor. In order to preview your video with your new settings, you need to repeat step two above.

Autodesk 3ds Max
1 Start Autodesk 3ds Max and open the file you want to preview.
2 Open the Render Scene dialog box by choosing Rendering > Render Setup.
3 Click the Common tab.
4 Under Render Output, click Devices.
5 In the Select Image Output Device dialog box, select Matrox WYSIWYG Preview, and click OK.
6 Click Render.

Autodesk Combustion
1 Start Autodesk Combustion and open the file you want to preview.
2 Choose File > Preferences > Framebuffer.
3 In the menu beside Framebuffer Type, select Matrox WYSIWYG Preview, and click OK.

eyeon Fusion
1 Start eyeon Fusion and open the file you want to preview.
2 Right-click on the file, and choose View On > Matrox WYSIWYG Preview.
NewTek LightWave 3D

1 Start NewTek LightWave 3D and load the file you want to preview by choosing File > Load > Load Scene.

2 Click the Render tab.

3 Under Options on the left hand side of the screen, click Render Globals.

4 From the Render Display menu, select Matrox WYSIWYG Preview.

5 Under Render on the left hand side of the screen, click Render Frame.
Chapter 7, Using the Matrox WYSIWYG Plug-ins

Your notes
Monitoring Your Matrox RT.X2 System

This chapter explains how to use the Matrox X.info program to display important details about your Matrox RT.X2 system and installed hardware.
Using X.info to display RT.X2 information

The Matrox X.info program lets you display information about your Matrox RT.X2 system and installed hardware, and provides warnings when certain problems arise, such as when the temperature of your RT.X2 card exceeds the maximum operating temperature. You can also use the X.info program to enable and disable the Matrox hardware-accelerated (Flex GPU) effects in Adobe Premiere Pro if you have a display card that supports these effects (see “Enabling and disabling the Matrox hardware-accelerated effects in Adobe Premiere Pro” on page 177).

Matrox X.info runs continuously to monitor your system, whenever your computer is turned on. You can open Matrox X.info to display system and hardware details by double-clicking the icon on your Windows taskbar.

**Note** If you do not see the icon, right-click the notification area of the taskbar and choose Properties, clear the Hide inactive icons option, and click OK.

Displaying system information

To display information about your Matrox RT.X2 system, select System from the Display Information About list. On this page, you can see Install Information, such as the install path and version of Matrox Mx.tools.

You can also create an HTML log file of your system information, which can be useful for troubleshooting. To create this log, use the Browse button under System Information Log to select the path and name of the log, then click...
Create. If Open file after scan is selected, the HTML system log opens after it is created.
Displaying hardware information

To display information about your Matrox RT.X2 hardware, select **Hardware** from the **Display Information About** list. Your RT.X card and display card are each represented by a tab.

Click a card’s tab to display a page with hardware information (for example, serial number and production date). You can also monitor the current and maximum operating temperatures for your RT.X2 card.

**Important** Whether or not you have opened Matrox X.info, if your RT.X2 card exceeds the maximum operating temperature, you’ll receive a warning message with further instructions as explained in the section “Error notification” on page 177.
Monitoring your RT.X2 card’s operating temperatures

As shown in the X.info Hardware section, the RT.X2 Card page displays the current and maximum operating temperatures for your Matrox RT.X2 card. To avoid damage to your Matrox RT.X2 system, make sure that you don’t operate your RT.X2 card at or near the maximum temperature for a prolonged period of time. You should target your RT.X2 card to operate at least 10°C below the maximum operating temperature.

You should monitor the temperature of your RT.X2 card periodically and take measures as needed to lower the room temperature and/or improve the ventilation in your Matrox RT.X2 system. For details on how to ensure your system is properly ventilated, see your Matrox RT.X2 Installation Manual.

Enabling and disabling the Matrox hardware-accelerated effects in Adobe Premiere Pro

The X.info program provides a page to display hardware information about your display card. On this page, you can also choose to enable or disable the Matrox hardware-accelerated effects in Adobe Premiere Pro. If your display card supports the Matrox hardware-accelerated effects, Enable Matrox hardware-accelerated effects in Adobe Premiere Pro will be selected by default. If you’re having problems with these effects, however, you may want to clear this option to disable the effects.

To enable the Matrox hardware-accelerated effects in Adobe Premiere Pro you must be using Matrox RT.X2 with a display card that has at least 256 MB of onboard memory and supports Microsoft DirectX 9. You can’t enable the Matrox-hardware accelerated effects if Matrox has tested your display card and determined that it doesn’t support these effects. You can check the Matrox Video Support site for up-to-date information about the display cards tested by Matrox at www.matrox.com/video/support.

Error notification

X.info provides temperature warnings and warnings for other possible RT.X2 hardware problems. Once X.info has detected a hardware problem, the Matrox X.info Notification dialog box will be displayed to give you details of the problem and further instructions. You will not be able to close this dialog box until the problem has been resolved.
Your notes
Understanding Standard and Advanced Pulldown

This appendix describes the most common pulldown methods, and explains how and when these pulldown methods are employed by Matrox RT.X2.
Overview

Part of your project’s workflow may involve the application of a pulldown technique to convert your input video to the video format of your sequence. Pulldown can also be applied to your output video to meet certain requirements. When a pulldown is required, Matrox RT.X2 performs either a standard 2:3 pulldown or an advanced 2:3:3:2 pulldown.

Standard 2:3 pulldown

Standard 2:3 pulldown is often used as part of the telecine process to transfer 24 fps film footage to 29.97 fps interlaced video. This pulldown method is also used to convert any 23.98 fps progressive video to 29.97 fps interlaced video, such as for converting 486p @ 23.98 fps video to NTSC.

In order to convert 24 fps film or 23.98 progressive video to 29.97 fps interlaced video, additional video frames, and more specifically video fields, must be created and added to the video sequence. For example, to convert a sequence of four film or progressive frames, five frames of video are needed for a total of 10 video fields. Therefore, one additional video frame or two video fields must be created. To accomplish this, the first and third frames of a four-frame film or progressive video sequence are each converted to two video fields. The second and fourth frames of the sequence are converted to three video fields to make up a total of five interlaced video frames.

The following diagram demonstrates the process:

![Diagram showing 2:3 pulldown process]

Standard 2:3 pulldown is accomplished by representing the first frame of film or progressive video (frame A) as two fields of video (fields a1 and a2), the second frame (frame B) as three fields of video (fields b1, b2, and b3), the third frame (frame C) as two fields (fields c1 and c2), and the fourth frame (frame D) as three fields (fields d1, d2, and d3). This sequence repeats six times each second.

Appendix A, Understanding Standard and Advanced Pulldown
Performing a standard reverse pulldown (2:3 cadence) reverses the process by converting 29.97 fps interlaced video to 23.98 fps progressive video. This is achieved by discarding a video frame (two video fields) from the sequence. From the diagram above, a typical standard reverse pulldown would discard fields b3 and d1. This means that video frames C and D must be read by the application to remove the additional fields. For standard reverse pulldown that is performed on compressed video, the application must decompress frames in order to remove the additional fields, and then it must recompress frames to complete the conversion.

**Matrox RT.X2 implementation of standard reverse pulldown**

In order for Matrox RT.X2 to properly perform a standard reverse pulldown, the material that is to be converted from 29.97 fps interlaced video to 23.98 fps progressive video must have been originally acquired at 23.98 fps. When Matrox RT.X2 performs a standard reverse 2:3 pulldown, the process identifies the A frames of a sequence as those frames that have time code ending in 0 or 5. For example, a frame with the time code 00:00:20:20 or 00:00:20:25 would be considered an A frame, and therefore would be used as the first frame in a pulldown sequence.

In the case of batch captures, when the first frame of a clip that is to be captured might not always be an A frame, Matrox RT.X2 advances to the next instance of an A frame in the clip to start the pulldown sequence (if it’s required). In order for Matrox RT.X2 to perform standard reverse 2:3 pulldown accurately, the clips must have A frames appearing at time codes 0 and 5. The clips must also be recorded to a tape that has continuous, non-drop frame time code.

**Advanced 2:3:3:2 pulldown**

Advanced 2:3:3:2 pulldown was developed as an alternative to the standard pulldown method for making frame rate conversions in DV video only. It is used to convert 486p @ 23.98 fps video to NTSC (486i @ 29.97 fps) video. This conversion is used when video footage is acquired by a DV camera at 23.98 fps and recorded to DV tape with the recorder set for advanced pulldown (called 24PA or 24P Advanced mode on some devices). Advanced 2:3:3:2 pulldown differs from standard 2:3 pulldown in that the two middle frames of the video sequence are each converted to three video fields.
The following diagram demonstrates the process:

Advanced 2:3:3:2 pulldown is accomplished by representing the first frame of progressive video (frame A) as two fields of video (fields $a_1$ and $a_2$), the second frame (frame B) as three fields of video (fields $b_1$, $b_2$, and $b_3$), the third frame (frame C) as three fields (fields $c_1$, $c_2$, and $c_3$), and the fourth frame (frame D) as two fields (fields $d_1$ and $d_2$).

Performing an advanced reverse pulldown (2:3:3:2 cadence) reverses the process by converting 29.97 fps interlaced video to 23.98 fps progressive video. This is achieved by discarding a video frame (two video fields) from the sequence. From the diagram above, a typical advanced reverse pulldown would discard video fields $b_3$ and $c_1$. This means that the application can remove video frame C from the sequence without reading the other frames.

When compared to standard reverse pulldown, advanced reverse pulldown results in less degradation in the converted video because removing an entire frame from the sequence leaves the remaining frames in the sequence intact, and therefore preserves the native generation of the video.

**Matrox RT.X2 implementation of advanced reverse pulldown**

The advanced reverse pulldown process is simpler than a standard reverse 2:3 pulldown because the additional frame, video frame C in the diagram above, is tagged when the 23.98 fps progressive footage is recorded to tape. This information is present in the DV stream and when Matrox RT.X2 performs an advanced reverse pulldown, it reads this information to identify the additional frame that is then removed from the sequence. Matrox RT.X2 can perform advanced reverse pulldown on clips that have been recorded to a DV tape that has continuous drop-frame or non-drop frame time code.

Appendix A, Understanding Standard and Advanced Pulldown
Matrox RT.X2 Workflows

This appendix provides information about working with different types of sequences in Adobe Premiere Pro on Matrox RT.X2.
Overview

This appendix provides general information about using various Matrox RT.X2 sequence presets and codecs for working with different types of sequences in Adobe Premiere Pro. Workflow diagrams and descriptions are used to help explain the specific workflow details.

Working with SD “24P” material

Matrox RT.X2 allows you to choose a Premiere Pro preset to work with SD material originally acquired at 23.98 fps. When you select the Matrox 486p @ 23.98 fps sequence preset, you can edit SD material as 23.98 fps progressive video as long as the source video was originally acquired at 23.98 fps. This includes video that was captured to tape by a DV camera capable of shooting 486p @ 23.98 fps video, and Panasonic P2 video shot as 486p @ 23.98 fps and recorded directly to disk as .mxf files. You cannot use the 486p @ 23.98 fps preset to capture or edit video that was originally acquired as NTSC or PAL.

Regardless of its origin, SD material that is acquired at 23.98 fps must undergo a format conversion to NTSC (486i @ 29.97 fps) when it is recorded to tape, or recorded to disk in the case of .mxf files. This means that the output from your source device and input to Matrox RT.X2 is always NTSC. Your source device outputs the 23.98 fps material as NTSC by applying a pulldown method when it records the material to tape or disk.

Some DV cameras that are capable of shooting 23.98 fps progressive video have the option of performing either a standard or advanced pulldown for recording material to tape or disk. In order to use the video with Matrox RT.X2, we recommend that you set your DV-1394 device to use advanced pulldown (called 24PA or 24P Advanced mode on some devices) to convert the footage to 29.97 fps interlaced video. Matrox RT.X2 will then apply an advanced reverse pulldown method to convert the source video to 486p @ 23.98 fps for editing clips in Adobe Premiere Pro.

**Important** When using a Panasonic P2 camera to shoot 486p @ 23.98 fps material for use with Matrox RT.X2, you must set the camera to Advanced mode (486/24pA).

The output from your 486p @ 23.98 fps sequence on Matrox RT.X2 is always NTSC. Matrox RT.X2 provides the option to apply either an advanced pulldown or standard pulldown. In most cases, you would want to perform an advanced 2:3:3:2 pulldown only if your DV video requires further processing or if it is to be archived. Otherwise, a standard 2:3 pulldown should be used when you export your 486p @ 23.98 fps sequence to tape. For more information about standard 2:3 pulldown and advanced 2:3:3:2 pulldown, see Appendix A, “Understanding Standard and Advanced Pulldown.”

Appendix B, Matrox RT.X2 Workflows
486p @ 23.98 fps workflow example

The following diagram illustrates a typical 486p @ 23.98 fps workflow using Matrox RT.X2:

DV-1394 input/output, and P2 .mxf source files on disk

SD video footage acquired at 23.98 fps progressive scan

DV camera performs either standard or advanced pulldown (depending on mode selection) when the acquired footage is recorded to tape or disk.

NTSC video on tape or P2 .mxf files on disk

Matrox RT.X2 detects original pulldown method, then performs either an advanced or standard reverse pulldown during capture (or playback for .mxf files).

Matrox RT.X2 486p @ 23.98 fps sequence

Depending on the user’s selection of pulldown method, Matrox RT.X2 performs either advanced 2:3:3:2 pulldown or standard 2:3 pulldown.

Exported to disk as MPEG-2 IBP for DVD authoring or exported to disk to streaming video format for web

Exported to DV tape as NTSC video

Note  For all Matrox RT.X2 sequences, you can choose to export to an MPEG-2 file for DVD authoring or export to a web format using Adobe Media Encoder. For details on exporting to a Matrox format, see “Exporting to a Matrox .avi file” on page 43. When working with an SD sequence on RT.X2, you can also capture video directly to an .m2v file for DVD authoring using Adobe Encore (see “Specifying your video capture settings” on page 35).

Working with SD “24P” material
Working with HD sequences

Note Although Matrox RT.X2 SD does not support working with HD sequences, you can capture and import HDV 1080i/p clips to an SD sequence on RT.X2 SD as explained in “Capturing HDV and SD material on Matrox RT.X2 SD” on page 190.

Matrox RT.X2 lets you capture native HDV material over the 1394 interface and capture HD analog component input to MPEG-2 I-frame HD format. Native HDV and MPEG-2 I-frame HD clips can be mixed in real time in the same HD sequence. You can also import SD clips to your HD sequence and Matrox RT.X2 will upscale the clips in real time as explained in “Mixing SD and HD clips in a sequence” on page 26.

Note When working with a 720p or 1440×1080p sequence, you can capture native HDV material over the 1394 interface, but analog component capture is not supported.

When working with a 1440×1080i/p sequence, you can import Sony XDCAM EX 1080i/p HQ-mode (1920×1080) and 1080i/p SP-mode (1440×1080) .mp4 files for realtime playback. You can also choose to import Panasonic P2 .mxf files and Sony XDCAM EX 720p .mp4 files to your 720p sequence for realtime playback. When needed, Matrox RT.X2 will convert the clips to your sequence’s video format by removing the redundant frames when the clips are played back on the timeline.

When your edits are complete you can export your sequence to an HDV device over the 1394 interface, or export to tape using your Matrox RT.X2’s HD analog component output. You can also choose to downconvert the video to NTSC or PAL to record to SD tape. The format in which you can export depends on your sequence’s video format as explained in “Supported master output formats” on page 196.
1440×1080i/p workflow example
The following diagram illustrates a typical workflow for working with a 1440×1080i/p sequence on Matrox RT.X2:

Remarks
- To output a 1440×1080p @ 23.98 fps sequence as 1080i @ 29.97 fps or NTSC, Matrox RT.X2 will perform a standard 2:3 pulldown.
- When using a Sony HVR-V1 camera to shoot HDV 1080p @ 23.98 fps material that you’ll be capturing on Matrox RT.X2, you must set the camera to Advanced mode (24A).
720p workflow example
The following diagram illustrates a typical workflow for working with a 720p sequence on Matrox RT.X2:

Native HDV 720p video footage on tape

When needed, Matrox RT.X2 will remove redundant frames when the .mxf files are played back on the timeline

HDV clips captured natively over the 1394 interface

Panasonic P2 .mxf and Sony XDCAM EX 720p .mp4 files imported to sequence

Matrox 720p sequence

Exported to HDV over the 1394 interface

Exported to tape as 720p @ 50 fps or 59.94 fps analog component video for broadcast

Exported to tape as SD video (NTSC or PAL) for broadcast

Exported to disk, such as to an MPEG-2 file for DVD authoring, or a Matrox .avi file
Capturing HDV and SD material to edit in SD on Matrox RT.X2

If you want to deliver in SD but take advantage of the superior image quality offered by your HDV camera, you can capture HDV material over the 1394 interface and edit the clips in SD on Matrox RT.X2. To do this, you create a project using a Matrox 1440x1080i/p sequence preset and capture the HDV clips natively over the 1394 interface. You then create a new sequence in the same project using a Matrox SD sequence preset, and edit the HDV clips in your SD sequence.

When working in your SD sequence you can capture native DV clips over the 1394 interface, and capture SD clips using Matrox RT.X2’s analog component, S-Video, and composite inputs. The SD and HDV clips can be mixed in real time in your SD sequence. The HDV clips will be downscaled to SD when you scale the clips to your sequence’s frame size for realtime playback as explained in “Mixing SD and HD clips in a sequence” on page 26.

When your edits are complete, you can export your sequence to tape as SD video for broadcast. If you want to deliver in HD format, use your 1440x1080i/p sequence to export to HD format without having to recapture your SD clips (the SD clips can be upscaled to 1440x1080i/p format for realtime playback).

This workflow scenario is represented in the following diagram:
Capturing HDV and SD material on Matrox RT.X2 SD

On Matrox RT.X2 SD you can take advantage of the superior image quality offered by your HDV camera by capturing native HDV 1080i/p material over the 1394 interface in an SD sequence. To do this, you use Adobe Premiere Pro’s HDV capture feature as explained in “Capturing HDV material on Matrox RT.X2 SD” on page 42.

When working in your SD sequence you can also capture native DV clips over the 1394 interface, and capture SD clips using Matrox RT.X2 SD’s analog component, S-Video, and composite inputs. The SD and HDV clips can be mixed in real time in the same SD sequence. Your HDV clips will be downscaled to SD when you scale the clips to your sequence’s frame size for realtime playback as explained in “Mixing SD and HD clips in a sequence” on page 26. When your edits are complete, you can export your sequence to tape as SD video for broadcast.

This workflow scenario is represented in the following diagram:
Using the Matrox MPEG-2 I-frame HD codec

**Note**  The Matrox MPEG-2 I-frame HD codec is not supported for capture or export on Matrox RT.X2 SD.

The Matrox MPEG-2 I-frame HD codec allows you to control the data rate of the video that you are capturing or exporting. At low data rates (about 50 Mb/sec) the codec can be used to capture and export video for offline editing. At high data rates (about 90 Mb/sec), the codec can be used to capture and export high-quality video for online editing. The VFW MPEG-2 I-frame HD codec allows you to render and play back MPEG-2 I-frame HD clips in VFW applications, such as Adobe After Effects. On a system without the Matrox RT.X2 hardware, the VFW MPEG-2 I-frame HD codec can be used to render and play back 1440×1080i/p clips only.

**MPEG-2 I-frame HD codec workflow example for offline editing**

In this workflow example, the Matrox MPEG-2 I-frame HD codec is used to capture video clips for offline editing. The clips are captured with Matrox RT.X2 at a data rate of 50 Mb/sec and then used to complete an offline editing sequence. When the offline edit is complete, the project is trimmed, and the offline clips are unlinked and then recaptured using the Matrox MPEG-2 I-frame HD codec at a data rate of 90 Mb/sec or higher. The online editing sequence is then exported to tape for broadcast.
This workflow scenario is represented in the following diagram:

1. Analog component video footage shot as 1080i @ 29.97 fps or 25 fps
2. Matrox MPEG-2 I-frame HD codec set at 50 Mb/sec used to capture clips
3. Matrox 1440x1080i offline editing sequence
4. Project is trimmed, offline clips are unlinked and recaptured using the Matrox MPEG-2 I-frame HD codec at 90 Mb/sec or higher
5. Exported to tape as finishing-quality HD video for broadcast
**MPEG-2 I-frame HD codec workflow example for online editing**

In this workflow example, the Matrox MPEG-2 I-frame HD codec is used to capture video clips for online editing. The clips are captured with Matrox RT.X2 at a data rate of 90 Mb/sec or higher and then used to complete an online editing sequence. A VFW application, such as Adobe After Effects, is used to create a composition that is rendered using the VFW MPEG-2 I-frame HD codec and imported into the online editing sequence. When the edit is complete, it is exported to tape for broadcast.

This workflow scenario is represented in the following diagram:
Using Matrox RT.X2 to edit Matrox Axio offline HD projects

**Note**  Matrox RT.X2 SD does not support Matrox Axio offline HD clips. Matrox RT.X2 supports realtime playback of Matrox Axio offline HD clips so that you can use your Matrox RT.X2 system as an offline editing station for Matrox Axio offline HD projects. To do this, all you need to do is copy the Axio offline HD projects and all associated media clips to your RT.X2 system. Make sure that you use the same folder structure for all the media clips so that Adobe Premiere Pro can easily locate the clips when you open the Axio offline HD projects on RT.X2.

**Important**  In order to edit an Axio offline HD project on your RT.X2 system, the Matrox editing mode (video format) of the sequences in the project must also be supported on RT.X2.
## Supported video compression formats

The following table lists the supported video compression formats for performing various operations on Matrox RT.X2 depending on your sequence’s video format.

<table>
<thead>
<tr>
<th>Operation</th>
<th>SD sequence</th>
<th>HD sequence (not supported on RT.X2 SD)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Capture</strong>¹</td>
<td>DV/DVCAM</td>
<td>DV-1394 input only: HDV Analog component input only: MPEG-2 I-frame HD (for 1440×1080i sequences only)</td>
</tr>
<tr>
<td></td>
<td>DVCPRO</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MPEG-2 I-frame</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MPEG-2 IBP (for capture to .m2v files only)</td>
<td></td>
</tr>
<tr>
<td><strong>Playback</strong>²</td>
<td>DV/DVCAM</td>
<td>HDV MPEG-2 I-frame HD Offline HD (for playback of Matrox Axio offline HD projects)</td>
</tr>
<tr>
<td></td>
<td>DVCPRO</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MPEG-2 I-frame</td>
<td></td>
</tr>
<tr>
<td><strong>Export to disk</strong></td>
<td>DV/DVCAM</td>
<td>MPEG-2 I-frame HD</td>
</tr>
<tr>
<td></td>
<td>DVCPRO</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MPEG-2 I-frame</td>
<td></td>
</tr>
<tr>
<td><strong>Render previews</strong></td>
<td>DV/DVCAM</td>
<td>MPEG-2 I-frame HD</td>
</tr>
<tr>
<td></td>
<td>DVCPRO</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MPEG-2 I-frame</td>
<td></td>
</tr>
<tr>
<td><strong>DV-1394 export to tape</strong></td>
<td>DV/DVCAM</td>
<td>HDV (for 1440×1080i/p, and 720p @ 25 fps and 29.97 fps sequences only)</td>
</tr>
<tr>
<td></td>
<td>DVCPRO</td>
<td></td>
</tr>
</tbody>
</table>

¹ On Matrox RT.X2 SD you can capture native HDV 1080i/p (1440×1080i/p) material over the 1394 interface in an SD sequence using Adobe Premiere Pro’s HDV capture feature as explained in “Capturing HDV material on Matrox RT.X2 SD” on page 42.

² Realtime playback is also supported for Panasonic P2 .mxf files in SD and 720p formats, Sony XDCAM EX .mp4 files in 720p and 1080i/p (HQ and SP) formats, and when mixing SD and HD clips in the same sequence as explained in “Mixing SD and HD clips in a sequence” on page 26. (RT.X2 SD does not support .mxf or .mp4 files.)
Supported master output formats

The following table lists the supported master output formats for Matrox RT.X2 depending on your sequence’s video format.

**Note** Matrox RT.X2 SD supports SD sequences only.

<table>
<thead>
<tr>
<th>Sequence video format</th>
<th>Supported master output formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>NTSC</td>
</tr>
<tr>
<td>PAL</td>
<td>PAL</td>
</tr>
<tr>
<td>486p @ 23.98 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>486p @ 29.97 fps</td>
<td>NTSC</td>
</tr>
<tr>
<td>576p @ 25 fps</td>
<td>PAL</td>
</tr>
<tr>
<td>720p @ 23.98 fps</td>
<td>720p @ 59.94 fps or NTSC</td>
</tr>
<tr>
<td>720p @ 25 fps</td>
<td>720p @ 50 fps or PAL</td>
</tr>
<tr>
<td>720p @ 29.97 fps</td>
<td>720p @ 59.94 fps or NTSC</td>
</tr>
<tr>
<td>720p @ 50 fps</td>
<td>720p @ 50 fps or PAL</td>
</tr>
<tr>
<td>720p @ 59.94 fps</td>
<td>720p @ 59.94 fps or NTSC</td>
</tr>
<tr>
<td>1440×1080i @ 25 fps</td>
<td>1080i @ 25 fps or PAL</td>
</tr>
<tr>
<td>1440×1080i @ 29.97 fps</td>
<td>1080i @ 29.97 fps or NTSC</td>
</tr>
<tr>
<td>1440×1080p @ 23.98 fps</td>
<td>1080p @ 23.98 fps, 1080i @ 29.97 fps, or NTSC</td>
</tr>
<tr>
<td>1440×1080p @ 25 fps</td>
<td>1080p @ 25 fps or PAL</td>
</tr>
<tr>
<td>1440×1080p @ 29.97 fps</td>
<td>1080p @ 29.97 fps or NTSC</td>
</tr>
</tbody>
</table>

**Note** Analog component output for a 1440×1080i/p sequence is always full-size 1080i/p (1920×1080).
This appendix explains how you can register your Matrox RT.X2 and obtain customer support.
Getting the most support

If you have a problem that you’re unable to solve by referring to your Matrox RT.X2 documentation, please contact your Matrox RT.X2 representative. He or she should be able to help you quickly correct any installation or system configuration problem.

If your representative is unable to solve your problem, contact Matrox for further information and assistance.

Registration

You can register your Matrox RT.X2 in the Matrox RT.X2 Support section of our website at www.matrox.com/video/support. To go directly to the registration page, choose Start > All Programs > Matrox Mx.tools > Register Your Matrox RT.X Product.

Important Only registered users are entitled to customer support, software updates, access to our user forums, and special promotional offers.

Keep up to date with our website

In addition to registering your Matrox RT.X2, our website offers you up-to-the-minute information about Matrox products and software updates. Be sure to place our site in your favorites or bookmarks: www.matrox.com/video/support.

Contacting us

Matrox is proud to offer worldwide customer support. Please use the Matrox RT.X2 contact information for your area as provided on our website at www.matrox.com/video/support.
Matrox RT.X2 Glossary

This glossary defines many of the terms used in this manual and related documentation.
Glossary of terms

Use this glossary as a reference for many of the basic terms used in this manual and related documentation.

**Numerics**

**1394**  See IEEE-1394.

**2:3 pulldown**  A method used to create additional video frames when 24 fps film footage or 23.98 fps progressive video is converted to 29.97 fps interlaced video, such as NTSC. To convert a four-frame sequence of film or progressive video, five frames of video are required. The 2:3 pulldown sequence accomplishes this by representing the first frame of film or progressive video as two fields (1 frame), the second frame as three fields (1.5 frames), the third frame as two fields (1 frame), and the fourth frame as three fields (1.5 frames). See also **advanced 2:3:3:2 pulldown**.

**2D**  Short for two-dimensional. An image that has height and width only.

**3D**  Short for three-dimensional. An object in three dimensions has height, width, and depth. Various techniques are used to show 3D images on 2D surfaces like your computer screen.

**4:2:2P@ML**  4:2:2 Profile@Main Level. An international standard video compression profile introduced by MPEG-2. It supports 4:2:2 luminance/chrominance sampling at up to 720×608 pixel resolution, and data transfer rates up to 50 Mb/sec (5.96 MB/sec). This profile is used for high-quality distribution and for archiving. See also **MP@ML**.

**4-corner pin**  A Matrox effect that lets you anchor each corner of a video or graphics clip onto points in an underlying clip, even if the underlying clip is angled or skewed.

**A**

**A/B roll**  Typically, A/B roll is an editing technique where scenes or sounds on two source reels (called roll A and roll B) are played simultaneously to create dissolves, wipes, and other effects. On nonlinear editing systems, A/B roll refers to using two source streams (.avi, .wav, .tga, and so on) to create an effect.

**advanced 2:3:3:2 pulldown**  A method that is often used to convert 23.98 fps progressive video to NTSC when the video is acquired by a camera shooting at 23.98 fps and recorded to DV tape. Advanced 2:3:3:2 pulldown differs from standard 2:3 pulldown in that the two middle frames of a four-frame sequence are each converted to three video fields. This results in less image degradation when a reverse pulldown is performed to convert the video back to 23.98 fps progressive video.

**AGP slot**  Connection slot to a type of expansion bus found in many computers. The AGP slot is used to house the AGP display card.

**alpha key**  An effect that makes parts of a foreground image fully or partially transparent based on alpha (transparency) values stored within the image’s file, so that an underlying image can show through. See also **chroma key and luma key**.

**analog component video**  See **component video**.

**analog signal**  A video or audio signal that varies continuously, as opposed to a digital signal which varies only by fixed steps.

**anti-aliasing**  A technique that smooths jagged edges in computer-generated text or graphics.
**aspect ratio**  A width-to-height ratio. For example, a 12-by-9-inch image has an aspect ratio of 4:3 (four-to-three). Most TV screens have a 4:3 aspect ratio. HDTV screens have a 16:9 aspect ratio.

**assemble editing**  Recording new video and audio material sequentially onto tape. Because all the signals are recorded (video, audio, and control track), the new material completely replaces any previously recorded material on the tape. See also insert editing.

**AVI**  Audio Video Interleaved. A video file format designed for the Microsoft Windows environment. See also codec.

**A/V drive**  A hard drive capable of storing high-bandwidth audio/video data.

**B**

**B-frame (Bi-directional frame)**  A frame created during the MPEG or MPEG-2 IBP compression process. A B-frame is generated by forwards and backwards referencing of the P-frames and I-frames respectively, which allows it to have the highest compression ratio of the three frame types. B-frames contain only predictive data (that is, not enough data to make up an entire picture), and therefore cannot be edited independently.

**BIOS**  Basic Input/Output System settings for system components, peripherals, etc. This information is stored in a special battery-powered memory and is usually accessible for changes at computer start-up.

**bitmap**  A graphics image in which a set of values defines each pixel’s relative brightness and color.

**black level**  The level of brightness at which no light is emitted from the screen (reference black). The standard black level is 7.5 IRE for NTSC video, or 0 IRE for NTSC-EIAJ (Japan) and PAL video. Also called setup (NTSC video only). See also white level, super black, and super white.

**Blue Book standard**  See DV.

**blur/soft focus effect**  A Matrox effect that uses various levels of intensity to blur an image or simulate camera defocus.

**bus**  A shared set of hardware lines that lets different parts of your computer transfer information between one another. A card inserted into an expansion slot of your computer makes an electrical connection to the bus and effectively becomes part of your computer system.

**capture**  The process of digitizing video or audio material, usually from a VTR or camera, and storing it in a file on a hard disk.

**chroma key**  An effect that makes portions of a foreground image fully or partially transparent based on the color of that image, so that an underlying image can show through. See also alpha key and luma key.

**chrominance**  The color portion of a video signal that carries the hue and saturation information. See also luminance.

**codec**  Compressor/decompressor. A processor that compresses video to reduce its file size by eliminating redundancies in information. It also decompresses files to play them back.

**color bars**  A standard test signal that appears as a series of vertical rows of color by which the chrominance and video levels of a camera’s output or a recorded signal can be checked.

**color correction effect**  A Matrox effect that allows various color properties of an image to be adjusted. There are controls for adjusting the intensity level for hue, saturation, contrast, and brightness. The color correction effect can correct improper color levels of an image that are due to varying...
lighting conditions or incorrect camera settings. See also white balancing.

**compile**  See render.

**component video** A video signal having separate channels for the video information, as opposed to a combined (composite) signal. Y, R-Y, B-Y video is a component video signal.

**composite video** A video signal containing luminance and chrominance information that has been combined using a video standard such as NTSC or PAL. Composite video often uses a single RCA or BNC cable connection. See also component video.

**contrast** The difference in brightness between the lightest and darkest areas of an image on the screen.

**CPU** Central processing unit. The central processor of a computer that performs calculations and interprets and executes commands.

**CPU-based effect** An effect that takes advantage of your computer’s CPU to play back in real time. Matrox Flex CPU effects, such as the Matrox color correction effects, are CPU-based effects. Compare with hardware-accelerated effect.

**crawl** Sideways movement of text across a screen. See also roll (1).

**crossfade** See dissolve.

**crystallize effect** A Matrox effect that lets you choose from many different patterns to make your image or text appear as if it is made of crystals.

**cube effect** A Matrox effect that lets you map video or graphics to the faces of 3D cubes. These cubes can then be rotated in 3D space to create transition effects such as those seen during sports broadcasts.

**cut** A direct switch from one video and/or audio source to another.

**D**

**D-9** Originally known as Digital-S. A variant of the DV format developed by JVC that uses a data rate of 50 Mb/sec (5.96 MB/sec), which is double the data rate of most other DV formats. Video is sampled at 4:2:2 for both NTSC and PAL sources to give enhanced chroma resolution. It uses a 1/2” metal particle tape.

**Digital8** A camcorder video format developed by Sony. Digital8 camcorders use the DV format to record digital video and audio onto 8mm and Hi-8 tapes via any device that has an IEEE-1394 interface.

**Digital-S** See D-9.

**digital signal** A signal representing video or audio information as binary digits that can be easily regenerated with no noise or distortion. See also analog signal.

**Digital Video** See DV.

**digitize** To convert analog information, such as a video signal from a VTR or camera, into digital information that can be processed and stored by a computer.

**Direct memory access (DMA)** A technique used to rapidly transfer data between an attached device, such as a disk drive, and the computer’s main memory without needing to pass the data through the CPU.

**DirectX** A Microsoft-developed program that enables interfaces to support advanced hardware features without being written specifically for each hardware model. DirectShow (formerly called ActiveMovie) is part of DirectX.

**display card** A card that has its own memory and processor to handle graphics and
enhance display capabilities. Also called graphics card. See also GPU.

**dissolve** A transition in which one image smoothly fades to another image. It is characterized by the gradual ending of one image occurring simultaneously with the gradual beginning of another. Also called crossfade.

**driver** Software that controls a device, such as a display card, and enables it to work with other software.

**drop-frame time code** For NTSC video, time code is normally produced by a generator that counts at 30 frames per second. NTSC color signals, however, actually have a display frequency rate close to 29.97 frames per second. Drop-frame time code compensates for this time difference by dropping two frames from the count every minute except for every tenth minute so that the time code matches clock time.

**DV** Digital Video. A standard digital bit stream and compression format (known as the Blue Book standard) used to record video and audio onto a digital tape. DV is intra-frame based, saving each frame separately, and uses a fixed 5:1 compression ratio to reduce the size of video files. DV’s data rate is fixed at 25 Mb/sec (2.98 MB/sec). Video is sampled at 4:1:1 for NTSC sources or 4:2:0 for PAL sources. See also DVCAM, DVCPRO, DVCPRO50, and D-9.

**DVCAM** A variant of the DV format developed by Sony that records a 15 micron track on a metal evaporated (ME) tape at a data rate of 25 Mb/sec (2.98 MB/sec). Video is sampled at 4:1:1 for NTSC sources or 4:2:0 for PAL sources.

**DVCPRO** A variant of the DV format developed by Panasonic that records an 18 micron track on metal particle tape at a data rate of 25 Mb/sec (2.98 MB/sec). Video is sampled at 4:1:1 for both NTSC and PAL sources. See also DVCPRO HD.

**DVCPRO HD** A high-definition variant of the DVCPRO format developed by Panasonic that uses a data rate of 100 Mb/sec.

**DVCPRO50** A variant of the DV format developed by Panasonic that uses a data rate of 50 Mb/sec (5.96 MB/sec), which is double the data rate of most other DV formats. Video is sampled at 4:2:2 for both NTSC and PAL sources to give enhanced chroma resolution. It uses the same type of tape as DVCPRO.

**DVD** Digital Versatile Disc or Digital Video Disc. A type of compact disc that can hold from 4.7 gigabytes (GB) to 17 GB of information. The greatest advantage that DVD has over CD is that it can store video as well as audio and computer data. For video storage, DVD uses MPEG-2 compression, to provide better quality than standard VHS.

**DVE** Digital Video Effect. Generally, an effect that resizes and repositions a picture on the screen. See also move & scale effect.

**DVI** Digital Video Interface. A video interface technology that maximizes the quality of flat-panel LCD monitors and modern display cards.

**E**

**Edit Decision List (EDL)** A file containing a list of edit decision statements used to create a video production.

**edit master** The first generation (original) of a final edited tape.

**expansion slot** Electrical connection slot mounted on a computer's motherboard (main circuit board). It allows several peripheral devices to be connected inside a computer. See also AGP slot, PCI slot, PCI Express slot, and PCI-X slot.
F

fade to black  A transition commonly used to signify the end of a scene, in which an image or sound smoothly fades to a black screen or silence (also called a fade-out transition). Similarly, you could start a new scene with a fade up from black (or fade-in) transition.

field  One-half of the horizontal lines needed to make a complete scan of an interlaced video frame. In the NTSC system, two consecutive fields of 262.5 lines each create a frame of 525 scan lines. In the PAL system, two consecutive fields of 312.5 lines each create a frame of 625 scan lines.

FireWire  Apple Computer’s original implementation of the technology that would be standardized as IEEE-1394 in 1995.

Flex CPU effect  See CPU-based effect.

Flex GPU effect  See hardware-accelerated effect.

frame  A single video image. An interlaced video frame is comprised of two consecutive fields (the odd and even fields).

G

garbage matte effect  An effect often used to crop unwanted objects from a foreground image in a chroma or luminance key effect. You define the shape of the garbage matte, and only the underlying image is shown outside the matte.

GOP  Group of Pictures. The sequence of I, B and/or P-frames produced during MPEG or MPEG-2 compression. This sequence of frames contains all of the information required to reproduce a complete video segment. The longer the GOP, the less editable it is.

GPU  Graphics processing unit. A processor that is used primarily for computing 3D functions, such as processing 3D DVEs and lighting effects. Because the calculations required to process these effects are CPU-intensive, the GPU lifts this burden from the CPU to allow it to perform more efficiently. A high-performance display card is sometimes referred to as a GPU.

graphics card  See display card.

graphics overlay  Text or a graphics image that’s superimposed on video. Also called super.

H

hardware-accelerated effect  An effect that requires the assistance of dedicated hardware to play back in real time. Matrox Flex GPU effects, such as 3D DVEs and page curls, are hardware-accelerated effects. Compare with CPU-based effect.

HD  Short for HDTV.

HDTV  High Definition Television. A digital television format with image resolutions up to 1080 vertical scan lines. HDTV has a 16:9 aspect ratio. Also called HD. See also SDTV.

HDV  A high-definition video format that uses MPEG-2 video compression at a data rate of about 19 Mb/sec for HDV-1 or 25 Mb/sec for HDV-2, and records to standard DV format digital video cassettes.

hue  The tint or tone of a color. For example, the difference between the color green and red is its hue.

I

IBP compression  See MPEG-2 IBP.

IEEE-1394  An international standard data transfer protocol created by Apple Computer under the FireWire trademark and standardized by the Institute of Electrical and Electronics Engineers (IEEE). It enables simple, low-cost, realtime data transfer between computers and consumer and prosumer electronics products, such as DV.
camcorders and DV decks. Commonly referred to as 1394.

**I-frame compression**  See MPEG-2 I-frame.

**I-frame (Intra-frame)**  A frame created during the MPEG or MPEG-2 compression process that contains all the information required to reproduce a complete image. It allows random access points within a video stream, and acts as a reference point for B-frames and P-frames to be built. I-frames are editable because they contain enough data to construct an entire video frame, unlike B-frames or P-frames.

**impressionist effect**  A Matrox effect that lets you choose from many different patterns to make your image appear similar to an impressionist painting.

**insert editing**  Recording new video and/or audio material onto a prerecorded (or striped) tape. Insert edits can be made in any order, unlike assemble edits, which must be made sequentially.

**inter-frame compression**  A video compression method that compares a series of frames in a video sequence and removes the redundant data. Inter-frame compression treats all the frames in the sequence as an interdependent group. As a result, most of the frames can’t be edited independently. Also called temporal redundancy reduction. **Contrast with intra-frame compression. See also** I-frame (Intra-frame).

**interleave**  A technique used to incorporate the video and audio portions of a video clip into one file. **See also AVI.**

**intra-frame compression**  A video compression method that removes redundant information from within a frame. Intra-frame compression treats each frame of a video segment independently. Several video compression formats use the intra-frame method. These include Motion-JPEG, DV, and MPEG-2 I-frame. Also called spatial redundancy reduction. **Contrast with inter-frame compression. See also I-frame (Intra-frame).**

**IRE unit**  An arbitrary unit designated by the Institute of Radio Engineers to define the amplitude of a video signal. 1 IRE is equal to approximately 7 mV.

**JPEG (pronounced “jay-peg”)**  Joint Photographic Experts Group. A compression and storage standard used for still, digital images. **See also** Motion-JPEG.

**key effect**  See alpha key, chroma key, and luma key.

**keyframe**  A particular frame at which one or more effect settings have been defined. Settings applied at a keyframe remain active on the clip until a later keyframe is defined to turn off or change the settings.

**lens flare effect**  A Matrox effect that lets you choose from many different patterns to simulate the light refractions caused by shining a bright light into the lens of a camera when taking a photo.

**LTC**  Longitudinal Time Code. Time code that is generally encoded as an audio signal onto a linear audio track of a tape. This type

---

Glossary of terms
of time code can be read only while the tape is moving. See also VITC.

**luma key**  An effect that makes portions of a foreground image fully or partially transparent based on the luminance of that image, so that an underlying image can show through. See also alpha key and chroma key.

**luminance**  The brightness portion of a video signal. The luminance of a pixel determines its brightness on a scale from black to white. See also chrominance.

**luminance key**  See luma key.

**M-mark in**  To select the first frame of a clip.

**M-mark out**  To select the last frame of a clip.

**mask effect**  A Matrox effect that lets you apply a mask (cutout shape) to a clip to superimpose it onto another clip.

**mask blur effect**  A Matrox effect that lets you create a “region of interest” by adding a mask to your clip and applying blurring to it.

**mask mosaic effect**  A Matrox effect that lets you create a “region of interest” by adding a mask to your clip and applying a mosaic effect to it.

**MIP mapping**  In 3D graphics, a rendering technique where a texture is stored at multiple resolutions. See also texture mapping.

**M-JPEG**  See Motion-JPEG.

**mosaic effect**  An effect that “blurs” an image by copying pixels into adjacent pixels both horizontally and vertically. This gives the image a blocky appearance, often used to hide people’s identities on television.

**move & scale effect**  A Matrox effect that lets you position and scale your clips anywhere in 2D space while adding soft edges. See also DVE.

**Motion-JPEG**  A compression and storage standard used for motion video. The JPEG compression process is applied to each video field, in succession. Also called M-JPEG.

**MP@ML**  Main Profile@Main Level. An MPEG-2 video compression profile that supports 4:2:0 luminance/chrominance sampling at up to 720×576 pixel resolution, and data transfer rates up to 15 Mb/sec (1.79 MB/sec). This profile is used for broadcast transmission and distribution on DVD. See also 4:2:2P@ML.

**MPEG**  A video compression standard that specifies a series of compression profiles and image resolution levels, introduced in 1990 by the Motion Picture Experts Group. MPEG takes advantage of the redundancy inherent in video data through a combination of inter-frame and intra-frame redundancy reduction. The MPEG standard supports data transfer rates of up to 1.5 Mb/sec (0.2 MB/sec). Also called MPEG-1. See also MPEG-2, inter-frame (IBP) compression, and intra-frame (I-frame) compression.

**MPEG-1**  See MPEG.

**MPEG-2**  A video compression standard that improves upon the MPEG standard by supporting data rates of up to 100 Mb/sec (12 MB/sec), scalable modes, field or frame searching, and much larger screen sizes. See also intra-frame (I-frame) compression, inter-frame (IBP) compression, 4:2:2P@ML, and MP@ML.

**MPEG-2 IBP**  An MPEG-2 compression type that uses inter-frame compression to create a group of I, B, and P-frames. Used for broadcast transmissions and distribution on DVD. See also GOP.

**MPEG-2 I-frame**  An MPEG-2 compression type that uses only intra-frame compression (that is, only I-frames are
created). Used for high-quality distribution and for archiving.

**mV**  Abbreviation for millivolt (one-thousandth of a volt). Unit of measurement sometimes used to define the amplitude of a video signal. See also IRE unit.

**MXF**  Material eXchange Format. A file exchange format standardized by SMPTE that assures interoperability among devices and systems. Panasonic P2 (Professional Plug-in) as well as Sony XDCAM and XDCAM HD use .mxf files rather than .mov, .avi, or .mpg files, for example. MXF is designed for today’s file-based workflows and provides a common way of packaging video and audio along with metadata so that information about the content is maintained as it flows through the production process.

**N**  **nonlinear editing**  Random access editing that generally uses video and audio clips stored on disks. Nonlinear editing programs let you rearrange and edit clips without having to redo the entire production, and provide instant cueing to any frame in a clip without waiting for tapes to rewind.

**NTSC**  National Television Systems Committee. The NTSC RS-170A standard defines a method of broadcasting a color signal that can be received by both monochrome and color TVs. It uses a composite interlaced display comprised of 525 scan lines per frame, refreshed at a rate of approximately 30 frames per second. Broadcast systems in North America and Japan use the NTSC standard.

**O**  **old movie effect**  A Matrox effect that lets you simulate the look of old film by adding noise, dust, streaks, jitter, and flickers to your clip.

**organic wipe**  A wipe effect that uses a grayscale gradient pattern to switch from one image to another by gradually revealing the second image according to the pattern

**P**  **page curl**  A Matrox effect that lets you peel or roll an image off the screen to reveal another image.

**PAL**  Phase Alternate Line. A video standard that uses a composite interlaced display comprised of 625 scan lines per frame, refreshed at a rate of 25 frames per second. This is the broadcast video standard for most of Europe.

**pan & scan effect**  A Matrox effect that lets you convert clips from one aspect ratio to another, such as from 16:9 to 4:3.

**PCI slot**  Connection slot to a type of expansion bus found in many computers. It is smaller in size than older ISA slots and provides connections to the PCI host bus at speeds up to 66 MHz.

**PCle slot**  See PCI Express slot.

**PCI Express slot**  A type of PCI slot that uses a different and much faster communications protocol than a 32-bit PCI slot. PCI Express can accommodate the higher speeds required for high-performance peripherals such as display cards and network controllers. PCI Express slots are available in different sizes (x1, x4, x8, and x16). The Matrox RT.X2 card is installed in a PCI Express slot. Also called PCIe slot.

**PCI-X slot**  A type of PCI slot that increases the speed at which data can move within the computer from 66 MHz to up to 133 MHz.

**P-frame (Predicted frame)**  A frame created during the MPEG or MPEG-2 IBP compression process. A P-frame is created by using motion vectors to predict the

Glossary of terms
differences between it and the closest previous I-frame or P-frame. This forward prediction allows for higher compression than with I-frames, but not as high as with B-frames. P-frames, like B-frames, contain only predictive data and therefore cannot be edited independently.

**Pixel** Picture element. The smallest portion of an image that can be written to a display. Each pixel in an image represents a single dot on the computer screen. A picture’s resolution depends on the number of pixels on the screen.

**Plug and Play** A hardware standard for auto-configuration. It refers to the ability of computer hardware to detect and configure expansion devices such as your Matrox hardware. Windows supports Plug and Play.

**Plug-in** Software that adds functionality and/or features to an application. For example, the Matrox realtime plug-in for Adobe Premiere Pro adds realtime Matrox effects and transitions to Adobe Premiere Pro.

**Proc Amp** An electronic device that adjusts the different aspects of a video signal, such as its hue, saturation, and contrast.

**Progressive Scanning** A method of creating a video image by drawing all the lines of a screen sequentially so that the complete image is displayed in one pass. VGA displays and some HDTV formats use progressive scanning. Progressive scanning produces smoother pictures than interlaced scanning, but uses more bandwidth.

**Pulldown Detection** A method of identifying the extra video frames that are added when 24 fps film footage or 23.98 fps progressive video is converted to 29.97 fps interlaced video. See also 2:3 pulldown and advanced 2:3:3:2 pulldown.

**R**

**Realtime Effect** An effect that is played back instantly, without having to be rendered by an editing program.

**Render** To compute an image or effect using a nonlinear editing, compositing, or animation program. The result is generally saved in a file on the computer. *Also called* compile.

**RGB Parade** A specialized scope that displays the red, green, and blue components of a video signal.

**RGB Video** A component video signal that uses three signals to carry the separate Red, Green, and Blue channels of colored images.

**Ripple Effect** A Matrox effect that lets you create 3D ripple patterns that simulate a flag waving, ripples in a pond, or a dream sequence.

**Roll** 1. Vertical movement of text across the screen. *Also called* scroll. See also crawl. 2. Unwanted vertical roll of a video image, indicating unstable sync.

**RS-232** A non-differential serial data transmission standard used for computer connections. See also serial control.

**RS-422** A differential serial data transmission standard that is often used for linking video production equipment (VTRs, mixers, etc.). Because this standard is differential, RS-422 connections are less subject to interference and noise than RS-232 connections. See also serial control.

**S**

**Saturation** A measure of the depth of a color. Fully saturated colors are vivid, while colors that lack saturation look washed out or faded.

**Scroll** See roll (1).

**SD** Short for SDTV.
SDTV  Standard Definition Television. A television format with image resolutions up to 525 vertical scan lines for NTSC video and 625 vertical scan lines for PAL video. SDTV can have a 4:3 or 16:9 aspect ratio. See also HDTV.

SECAM  Séquentiel Couleur Avec Mémoire (sequential color with memory). A color television system developed in France and the former USSR. It uses a composite interlaced display comprised of 625 scan lines per frame, refreshed at a rate of 25 frames per second. The color difference signals are transmitted sequentially on alternate lines.

serial control  A method of remotely controlling a device via a data line. The control data is transmitted in serial form (that is, one bit after another), such as for RS-232 and RS-422 connections.

setup  See black level.

shadow effect  A Matrox effect that lets you project a realistic shadow from any source that provides alpha key information, such as Matrox DVEs and titles with an alpha channel.

shine effect  A Matrox effect that lets you create rays that shine through text, or add shimmer to an object in your clip. You can also use the shine effect to make 2D text appear as 3D text.

SMPTE  Society of Motion Picture and Television Engineers. A professional society of motion picture and television engineers that prepares standards and documentation for television production.

spatial redundancy reduction  See intra-frame compression.

sphere effect  A Matrox effect that lets you wrap your clip around a true 3D sphere with shadow and highlight.

striping a tape  Preparing a tape for editing by recording continuous control track, time code, and a video signal (such as black or color bars).

super  See graphics overlay.

super black  Video that is darker than the standard black level. See also super white.

super white  Video that is brighter than the standard white level. See also super black.

surface finish  A Matrox effect that lets you apply various surface textures to your clips, such as metal, brick, wood, or granite with color spot lighting.

SVCD  Super Video CD. A standard for storing video and audio on a CD that provides better video quality than VCD and standard VHS. Video is compressed using MPEG-2 at 2500 Kbps, and audio is compressed as MPEG-1, layer II, at 224 Kbps. An SVCD can hold about 30 minutes of material. Super Video CDs will play back on some DVD set-top players.

S-Video  A component video signal in which the luminance (Y) and chrominance (C) information are separate. S-VHS videocassette recorders use the S-Video format. Also called Y/C video.

sync  A circuit or signal that directs the electron gun in a camera or TV picture tube to hold a picture steady on the screen. It also synchronizes the electronics of other video equipment.

sync generator  An electrical device that generates sync (timing) signals used to synchronize video equipment and keep pictures stable on the screen.

T  See time base corrector.

telecine process  A process that transfers film (negative or positive) to SD or HD video tape. The telecine process shines a light

Glossary of terms
source through each frame, converting the optical images to an electronic signal that is then recorded to video tape.

**temporal redundancy reduction**  See inter-frame compression.

**texture mapping**  A display technique where bitmaps (textures) are placed (mapped) onto 3D surfaces to make objects look more realistic.

**time base corrector (TBC)**  An electronic device that, when connected to the output of a VTR, corrects the stability and timing of the VTR’s playback video. This is achieved by stripping the unstable horizontal and vertical sync pulses from the video signal, and replacing them with new, clean sync pulses.

**time code**  A sequential code number assigned to successive video frames on tape. Each frame has its own time code, which is electronically encoded on the tape in the form hours:minutes:seconds:frames. See also drop-frame time code, LTC, and VITC.

**timeline**  The graphical representation (normally a horizontal line) of a video sequence. It is usually divided into hours:minutes:seconds:frames, and is used to position video, audio, graphics, and video effects that make up the sequence.

**tonal range**  The range of light and dark areas in an image. Tonal range can be divided into three different areas: shadows, midtones, and highlights. Shadows are the darkest areas of an image, highlights are the lightest areas, and midtones are the areas with tones between the lightest and darkest areas.

**track matte effect**  A Matrox effect that lets you superimpose one clip onto another using an animated matte, sometimes called a traveling matte, to determine how the two clips are composited (keyed).

**transform settings**  Settings that let you change the position, size, and rotation of a clip in the Matrox realtime plug-in. Transform settings can be applied on the x, y, and z axes of a clip.

**traveling matte effect**  See track matte effect.

**twirl effect**  A Matrox effect that lets you create twirl patterns that twist and rotate your video and graphics clips into spirals, coils, or whirlpools.

**V**

**VCD**  Video CD. A standard for storing video and audio on a CD that provides slightly better video quality than standard VHS. Video is compressed using MPEG-1 at 1100 Kbps, and audio is compressed as MPEG-1, layer II, at 224 Kbps. A VCD can hold about 60 minutes of material. Video CDs can play back on most DVD set-top players. See also SVCD.

**vectorscope**  A device that measures the phase and amplitude of the color components of a video signal.

**VITC**  Vertical Interval Time Code. Time code that is encoded onto the vertical blanking interval of a video signal. VITC can be read by a VTR whenever an image is displayed, but not usually during high-speed operation. See also LTC.

**voice-over**  Narration added to a video segment and mixed in louder than the original background sounds.

**W**

**WAV**  An audio data file format developed by Microsoft and IBM. This format is the standard for Windows and can be played by most applications that can support sound.

**white balancing**  A color correction technique that adjusts the color levels of an image using white or gray as a color reference.
point. White balancing assumes that when a white object can be made to look white, the other color levels will also be accurate. White balancing is used to correct improper color levels of an image that are due to varying lighting conditions or incorrect camera settings. White balancing can be performed using the Matrox color correction effect, and is also available as a setting on most cameras.

**white level** The brightest “legal” level of a video signal (reference white), which is at 100 IRE. *See also* black level, super black, and super white.

**wipe** A transition in which one image is gradually replaced by another image that is revealed in a given pattern. For example, the second image could be revealed from the top of the screen downwards until it fills the entire screen. *See also* organic wipe.

**x-y-z coordinate system** A 3D positioning system that includes a third (z) axis running perpendicular to the horizontal (x) and vertical (y) axes. The x-y-z coordinate system is used in computer graphics for creating models with height, width, and depth, and for moving models in 3D space.

**Y**

**Y waveform** A specialized scope that displays the luminance (Y) values of a video signal.

**Y/C video** *See* S-Video.

**YC waveform** A specialized scope that displays the combined luminance (Y) and chrominance (C) of a video signal.

**Y, Pb, Pr video** *See* Y, R-Y, B-Y video.

**Y, R-Y, B-Y video** An analog component video signal comprised of three channels: Y (luminance), R-Y (red minus luminance), and B-Y (blue minus luminance). *Also called* Y, Pb, Pr video.
Your notes
Numerics
1440x1080i/p sequences
   working with 186, 187, 189
3D DVE
   creating 91
   mapping Motion effect to 31
3ds Max WYSIWYG plug-in
   See Autodesk 3ds Max WYSIWYG plug-in
486p @ 23.98 fps sequence
   working with 184
4-corner pin
   creating 94
720p sequences
   working with 186, 188
A
A/V synchronization
   adjusting for playback of clips in a sequence 29
Adobe After Effects WYSIWYG plug-in
   about 168
   required steps 170
   See also Matrox WYSIWYG plug-ins
Adobe Encore
   capturing material for 35
Adobe Media Encoder
   disabling accelerated export 30
   for export to Matrox VFW AVI files 165
Adobe Photoshop WYSIWYG plug-in
   about 168
   required steps 170
   See also Matrox WYSIWYG plug-ins
Adobe Premiere Pro
   capture settings 35
   creating new Matrox project 24
   disabling Matrox splash screen 30
   displaying warnings in Events panel 25
   DV-1394 output settings 33
   exporting sequence to Matrox AVI file 43
   exporting sequence to tape 52
   exporting sequence using Matrox VFW codec 165
fixed effects 154
   general settings 27
   hardware-accelerated effects 177
   HDV capture on RT.X2 SD 42
   loading Matrox sequence presets 24
   optimizing memory usage 29
   sequence settings 27
   setting up Matrox DV-1394 device control 51
   setting up scratch disks 24
   video preview settings 34
   See also Realtime plug-in for Adobe Premiere Pro
Advanced pulldown
   description of 181
   See also Standard pulldown
After Effects WYSIWYG plug-in
   See Adobe After Effects WYSIWYG plug-in
Allow super black 32
Allow super white 32
Analog output type
   selecting 32
Anamorphic
   selecting for exported video 46
   selecting for video output 32
Aspect ratio
   creating SD project in 16:9 format 54
   selecting conversion setting for output video 32
   selecting for source video 36
Audio capture settings 37
   monitoring audio levels 40
   selecting channels 39
Audio conform files
   suppressing creation of 29
Audio levels
   monitoring for capture 40
   recording and playback volume controls 22
Audio waveform files
   suppressing creation of 29
Auto balance
   performing using color correction 75
Auto key
   performing using the chroma key graph 101
performing using the selective key graph 88
Autodesk 3ds Max WYSIWYG plug-in about 168
required steps 170
See also Matrox WYSIWYG plug-ins
Autodesk Combustion WYSIWYG plug-in about 168
required steps 170
See also Matrox WYSIWYG plug-ins
Automatic Gain Control selecting 37
AVI files
capturing using Adobe Premiere Pro 35
creating from a 32-bit TGA sequence 18
creating from MXF files using Matrox EZ-MXF 15
creating reference files for large HDV clips 17
displaying information in Windows Explorer 14
exporting using Adobe Premiere Pro 43
rendering using VFW programs 158, 162
Axio offline HD projects editing on RT.X2 194

B
Blur/soft focus effect creating 96

C
Calibration, monitor
See DVI monitor calibration
Capture format
selecting for video capture 36
Capturing using Adobe Premiere Pro
HDV material on RT.X2 SD 42, 190
HDV material to edit in SD on RT.X2 189
monitoring audio levels for 40
specifying Matrox settings for 35
Chroma clamper effect
using 154
Chroma filtering and chroma interpolation
for rendering to VFW files 161
Chroma key effect
creating 98
overview 97
using the chroma key graph 101
Chroma key graph
using 101
Chroma key shadow effect
creating 98
overview 97
Chroma sampling for fast-motion video
for rendering to VFW files 161
Codec
Matrox DV/DVCA M36, 45
Matrox DVC PRO 36, 45
Matrox DVC PRO50 45
Matrox MPEG-2 IBP 49
Matrox MPEG-2 I-frame 37, 45, 47
Matrox MPEG-2 I-frame HD 37, 45, 47
Matrox Offline HD 45
Matrox VFW codecs 162
Color balance graph
using 72
Color correction
adjusting tonal range 71
color matching clips 76
performing an auto balance 75
primary 65
secondary 80
using the selective key graph 85
using RGB curves 69
using Split View in the Program Monitor 67
using the color balance graph 72
using the luma mapping graph 78
using the Split View option 67
Color matching clips
using color balance graph 76
Color pass effect
creating with secondary color correction 90
Color space conversion options
for rendering to VFW files 160

Index
Combustion WYSIWYG plug-in
See Autodesk Combustion WYSIWYG plug-in

Compression formats supported 195

Compressor
selecting for VFW render 162

CPU-based effects 155

Cropping your clip 61
using Select Crop 62

Crystallize effect
creating 107

Cube effect
creating 104

Customer support 198

Device control in Adobe Premiere Pro
setting for DV-1394 devices 51

Display card
checking for Matrox-validated 177

Dropped frames in realtime effects reporting 28

DV material
capturing native 36

DV/DVCAM codec
See Matrox DV/DVCAM codec

DV/HDV device control
setting 51

DV-1394 device
as source in Adobe Premiere Pro 36
settings in Adobe Premiere Pro 33

DV-1394 device control
exporting to tape with 53
setting 51

DV-1394 output settings 33

DVCPro codec
See Matrox DVCPro codec

DVI monitor calibration 8
about 6
loading and displaying color bars 6

DVI output
forcing to 60 Hz for WYSIWYG preview 169

Effect presets 57

Error notification
in Events panel 25
with X.info 177

Events panel
displaying warnings in 25

Exporting
enabling DV-1394 output for 33
Matrox AVI files in Adobe Premiere Pro 43
to tape using Adobe Premiere Pro 52
See also Rendering using VFW programs

eyeon Fusion WYSIWYG plug-in
about 168
required steps 170
See also Matrox WYSIWYG plug-ins

EZ-HDV AVI
See Matrox EZ-HDV AVI

EZ-MXF
See Matrox EZ-MXF

Fixed effects
applying in Adobe Premiere Pro 154

Flex CPU effects
See Matrox CPU-based effects

Flex GPU effects
See Matrox hardware-accelerated effects

Garbage matte effects
creating 109

General settings
in Adobe Premiere Pro 27

Glossary 200

GPU-based effects
See Matrox hardware-accelerated effects
Index

Graphics clips
  supported formats  156

H  Hardware information
  displaying with X.info  176
  Hardware-accelerated effects  155
  enabling/disabling  177
HD clips
  scaling for use in an SD sequence  26
HD sequences
  scaling SD clips in  26
  supported compression formats  195
HDV material
  capturing native on RT.X2  36
  capturing native on RT.X2 SD  42
  editing in SD on RT.X2  189
  editing in SD on RT.X2 SD  190
  exporting native  53

I  Impressionist effect
  creating  111
Input aspect ratio
  selecting  36
Input device
  selecting  35
Input source
  selecting for audio capture  38
  selecting for video capture  36
Interlaced clips
  mixing with progressive clips  25, 26
Internet
  Matrox WWW site  198
Isolating colors in a clip
  using secondary color correction  90

K  Key colors
  modifying using the chroma key graph  101

L  Lens flare effect
  creating  114
Letterbox
  selecting for exported video  45
  selecting for video output  32
LightWave 3D WYSIWYG plug-in
  See NewTek LightWave 3D WYSIWYG plug-in
Luma key effect
  creating  117
  overview  116
  using the luma key graph  118
Luma key graph
  using  118
Luma mapping graph
  using  78
Luminance range settings
  for rendering to VFW files  160

M  M2V files
  capturing using Adobe Premiere Pro  35, 41
Mask
  applying to effect  63
  applying using Select Mask  64
Mask blur effect
  creating  122
Mask effect
  creating  120
Mask mosaic effect
  creating  124
Master output format
  selecting  32
  supported formats based on sequence format  196
Matrox
  contacting us  198
  WWW site  198
Matrox Axio offline HD projects
  editing on RT.X2  194
Matrox CPU-based effects 155
using with Adobe After Effects 56
Matrox DV/DVCAM codec
  selecting for capture 36
  selecting for export to disk 45
  selecting for VFW render 162
Matrox DV/HDV device control
  exporting to tape with 53
  setting 51
Matrox DVCPRO codec
  selecting for capture 36
  selecting for export to disk 45
  selecting for VFW render 162
Matrox DVCPRO50 codec
  selecting for export to disk 45
Matrox EZ-HDV AVI
  creating reference files for large HDV clips 17
Matrox EZ-MXF
  creating reference AVI files 15
Matrox hardware-accelerated effects 155
  enabling/disabling 177
Matrox MPEG-2 IBP codec
  configuring in Adobe Premiere Pro 49
Matrox MPEG-2 I-frame + Alpha codec
  configuring for VFW render 163
  selecting for capture 37
  selecting for export to disk 45
  selecting for VFW render 162
Matrox MPEG-2 I-frame codec
  configuring for VFW render 163
  configuring in Adobe Premiere Pro 47
  selecting for capture 37
  selecting for export to disk 45
  selecting for VFW render 162
Matrox MPEG-2 I-frame HD + Alpha codec
  configuring for VFW render 163
  selecting for VFW render 162
Matrox MPEG-2 I-frame HD codec
  configuring for VFW render 163
  configuring in Adobe Premiere Pro 47
  selecting for capture 37
  selecting for export to disk 45
  selecting for VFW render 162
using 191
workflow example for offline editing 191
workflow example for online editing 193
Matrox Offline HD codec
  selecting for export to disk 45
Matrox Player
  using as the default 25
Matrox project
  creating a new 24
Matrox RT.X2
  checking for Matrox-validated display card 177
  customer support 198
  documentation 3
  enabling/disabling hardware-accelerated effects 177
  glossary 200
  monitoring using X.info 174
  realtime guidelines 155
  registration 198
  supported compression formats 195
  supported master output formats 196
  using to edit Axio offline HD projects 194
  workflows 184
Matrox RT.X2 LE
  See Matrox RT.X2
Matrox RT.X2 SD
  capturing HDV material in an SD project 42
  See also Matrox RT.X2
Matrox WYSIWYG Control Panel
  using 168
Matrox WYSIWYG plug-ins
  about 168
  required steps 170
Matrox X.info
  using 174
Memory usage
  optimizing in Adobe Premiere Pro 29
Monitor calibration
  See DVI monitor calibration
  Monitoring your system
  with X.info 174
Motion effects
  selecting options for 31
Move & scale effect
  creating 126
  mapping Motion effect to 31
MP4 files
  using in sequences 13, 186
MPEG-2 IBP codec
  See Matrox MPEG-2 IBP codec
MPEG-2 1-frame codec
  See Matrox MPEG-2 1-frame codec
MPEG-2 1-frame HD codec
  See Matrox MPEG-2 1-frame HD codec
MPEG-2 1-frame HD settings
  selecting in Adobe Premiere Pro 47
  selecting in VFW programs 163
MPEG-2 1-frame settings
  selecting in Adobe Premiere Pro 47
  selecting in VFW programs 163
MXF files
  creating reference AVI files using Matrox EZ-MXF 15
  displaying information in Windows Explorer 14
  using in projects 12
  using in sequences 184, 186
N
NewTek LightWave 3D WYSIWYG plug-in
  about 168
  required steps 171
  See also Matrox WYSIWYG plug-ins
NTSC setup level
  selecting for analog video 32
O
Old movie effect
  creating 128
P
P2 files
  See Panasonic P2 files
Page curl
  creating 132
Pan & scan effect
  creating 134
Panasonic P2 files
  using in projects 12
  using in sequences 186
  See also MXF files
PEK files
  suppressing creation of 29
Photoshop WYSIWYG plug-in
  See Adobe Photoshop WYSIWYG plug-in
Pixel aspect ratio
  selecting for render in Adobe Premiere Pro 45
Player settings
  defining 25
Preconfigured Matrox effects
  applying 57
Proc amps
  adjusting using Matrox color correction 81
Progressive clips
  mixing with interlaced clips 25, 26
Pulldown
  description of advanced 181
  description of standard 180
  used in 1440x1080p @ 23.98 fps sequence 187
  used in 486p @ 23.98 fps sequence 184
Pulldown method
  selecting for video output 32
R
Realtime plug-in for Adobe Premiere Pro
  3D DVE
    creating 91
    4-corner pin
      creating 94
      applying a Matrox transition 57
      applying a Matrox video effect 57
      available effects 56
      blur/soft focus effect

Index
Index

creating 96
chroma key effect
creating 98
overview 97
chroma key shadow effect
creating 98
overview 97
color correction
primary 65
secondary 80
cropping your clip 61
crystallize effect
creating 107
cube effect
creating 104
garbage matte effects
creating 109
impressionist effect
creating 111
d lens flare effect
creating 114
luma key effect
creating 117
overview 116
mask blur effect
creating 122
mask effect
creating 120
mask mosaic effect
creating 124
move & scale effect
creating 126
old movie effect
creating 128
page curl
creating 132
pan & scan effect
creating 134
realtime guidelines 155
ripple effect
creating 136
selecting speed control method 154
shadow effect
creating 138
shine effect
creating 140
sphere effect
creating 144
surface finish effect
creating 146
track matte effect
creating 149
transforming a clip
using the Program Monitor 60
using the transform controls 58
twirl effect
creating 151
wipe transitions
creating 152
Realtime threshold
adjusting 28
Registering your Matrox RT.X2 198
Rendering using Adobe Premiere Pro
limitations to realtime effects 156
Rendering using VFW programs 158
before you start 159
selecting color space conversion options 160
selecting compressor 162
selecting video quality 163
Reporting dropped frames
during video playback 28
RGB curves
using 69
Ripple effect
creating 136

S
Scale to Frame Size
applying in real time 26
disabling realtime 30
Scratch disks
specifying 24
Scrubbing mode
selecting 28
Index

SD clips
scaling for use in an HD sequence 26

SD sequences
scaling HD clips in 26
supported compression formats 195
using HDV clips in 189, 190

Secondary color correction
creating a color pass effect 90

Select Crop
using 62

Select Mask
using 64

Selective key graph
using 85

Sequence presets
for HD material 186
for SD "24P" material 184
loading for Matrox RT.X2 24
See also Matrox RT.X2 workflows

Sequence settings
in Adobe Premiere Pro 27

Setup level
selecting for NTSC analog video 32

Shadow effect
creating 138

Shine effect
creating 140

Sony XDCAM EX files
using in sequences 13, 186

Sound card
recording and playback volume controls 22

Source Identifier
used in cube effect 104
used in track matte effect 149

Speed changes
selecting speed control method 154

Speed control method
selecting 154

Sphere effect
creating 144

Splash screen
disabling for Matrox project in Premiere Pro 30

Split View
using 67
working with in the Program Monitor 67

Standard pulldown
description of 180
See also Advanced pulldown

Style conventions
of this manual 2

Super black
allowing for output video 32

Super white
allowing for output video 32

Surface finish effect
creating 146

System information
displaying with X.info 174

Tapes
preparing for export to tape 52

Technical support
See Customer support

Temperatures
monitoring 177

TGA sequence
converting to an AVI file with alpha 18

Thumbnails preview 14

Titles
supported formats 156

Track matte effect
creating 149

Transforming a clip 58
using the Program Monitor 60
using the transform controls 58

Transitions
applying realtime 57
disabling accelerated/realtime 30

Twirl effect
creating 151
V
Video capture settings 35
Video effects
applying realtime 57
Video for Windows programs 158
rendering Matrox AVI file 162
Video formats
expressed in RT.X2 documentation 3
Video luma level 28
Video output settings 31
Video preview settings
in Adobe Premiere Pro 34
Volume controls
recording and playback settings 22
VU meters 40

W
Warnings
displaying in Adobe Premiere Pro’s Events panel 25
displaying with X.info 177
WAV files
capturing using Adobe Premiere Pro 37
exporting using Adobe Premiere Pro 44
Widescreen format
editing SD material on Matrox RT.X2 54
Windows Explorer
displaying details for clips 14
Wipe transitions
creating 152
Workflows
for Matrox RT.X2 184
WWW site 198
WYSIWYG Control Panel
See Matrox WYSIWYG Control Panel
WYSIWYG plug-ins
See Matrox WYSIWYG plug-ins

X
X.info
error notification 177
hardware information 176
www.matrox.com/video